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Notice

1
2.
3.

4.

This manual is subject to revision.

All rights reserved.

Right of modification reserved.

This manual is supplied without liability for errors or omissions.

No part of this manua may be reproduced or used except as authorised by
contract or other written permission.

This equipment is conditioned by the requirement that no modifications are made
to the equipment unless the changes or modifications are expressly approved by
the Airspan Networks Inc

Prerequisite skills: Personne installing, commissioning, and maintaining the
Airspan products must have a basic knowledge of telephony and radio
communications, and have experience in installing, commissioning and
maintaining telecommunications products. Airspan provides a range of
comprehensive training courses specifically aimed at providing operators/users of
Airspan products with the prerequisite skillsto install, commission and or
maintain the product. The courses are tailored to provide the level of training
required by the operator/user.

ASA000 and ASB100 are brands of Airspan Networks Inc

For additional information on Airspan Systems, please call your Airspan
Representative, or contact Airspan at:

Cambridge House
Oxford Road
Uxbridge
Middlesex

UB8 1UN

Call (44) 895 4677100
Fax (44) 895 4677101
email sales@ airspan.com
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Safety I nstructions - Warnings and Cautions

SAFETY
1. Read and follow all warning notices and instructions marked on the product or
included in this manual

2. Do not allow anything to rest on the power cord and do not locate the product
where persons could step or walk on the power cord.

3. When ingtalled in the final configuration, the product must comply with the
applicable Safety Standards and regulatory requirements of the country in which it is
installed. If necessary, consult with the appropriate regulatory agencies and inspection
authorities to ensure compliance.

4. No hazardous RF radiation is emitted from the equipment. Measured at the
surface of the CRU radome, when transmitting, the maximum total power radiated
from the CRU is 0.01% of the UK National Radiological Protection Board basic
restriction per kg. of body part.

WARNING - HAZARDOUSVOLTAGES

On AC installations, hazardous voltages exist. Use caution when verifying or
working with AC power. Remove metal jewellery that could come into contact with
AC power.

On DC sections, short circuiting the low voltage, low impedance circuits can cause
severe arcing that may result in burns or eye damage. Remove rings, watches etc. to
avoid shorting DC circuits.

Electr o-Static Discharge ESD
Electro-Static Discharge. Many circuits contain devices that are susceptible to

damage from high impedance voltage sources. To avoid such risks always follow
anti-static procedures where marked.
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NOTE

To the best of ACL’ s knowledge, Airspan products do not contain hazardous
substances (as defined in UK ‘Control of Substances Hazardous to Health
Regulations 1989’, and the ‘ Dangerous Substances Regulations 1990’). At the end of
any Airspan product’slife cycle, the customer should consult with ACL to ensure that
the product is disposed of in conformance with the relevant regulatory requirements

q

The C € Symbol on the Airspan Products signifies that they have been certified
according to the EMC directive 89/336/EEC. The products fulfil the requirements
according to the following standards:

EN50082-1 Immunity.

EN55022 Group 1 Class A for the Central Terminal Emissions.

EN55022 Group 1 Class B for the Subscriber Terminal Emissions.

WARNING
The Subscriber Terminal equipment has been tested and found to comply with the
limitsfor a Class B digital device, pursuant to part 15 of the FCC Rules.
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INTRODUCTION

General

This document describes the installation and operation of Sitespan as part of an AS4000
Release 2, Fixed Assignment, and Demand Assignment installations.

The user should be familiar with the AS4000 product. It is recommended that they have
attended the Airspan AS4000 training course prior to performing the proceduresin this
practice.

Related Documentation
Table1l Related Documentation

General
605-0000-435 Material Return and Repair

605-0000-477 Access Concentrator and Central Terminal - Equipment Rack
Installation & Commissioning

605-0000-433 Central Terminal - Antenna/Feeder Installation & Commissioning
605-0000-454 Subscriber Terminal Installation & Commissioning

Fixed Assignment Specific

605-0000-430 System Overview

605-0000-431 System Operations and Maintenance Manual

605-0000-437 D128 Terminal Converter

Demand Assignment Specific

605-0000-450 System Overview

605-0000-453 - Equipment Rack Installation & Commissioning
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AS8100 SS TESPAN SYSTEM OVERVIEW

ASB8100 Sitespan is a distributed control system for managing the AS4000 Fixed
Assignment and Demand Assignment products.
AS8100 Sitespan allows equipment at several sitesto be configured and monitored from
asingle remote station and allows several stations to connect to asingle site
simultaneoudly.
AS38100 Sltespan has the following features:
An intuitive graphical user interface (GUI) to access all products and services.
Real time display, propagation and logging of equipment alarms throughout
the managed site network.
Easy site to site network navigation.
logging of all operations performed on managed equipment as well as
equipment states.
support for multiple users to s multaneously monitor sites.
support for multiple sites to be monitored simultaneously.
access to sites from either dialup modem links or network connections.
multi-level Undo of all operationsin each user session.
A88100 Sitespan has two distinct components:
a) A Server that isdirectly connected and associated with the equipment racks.
b) An Equipment View that supplies the user interface,
These two components can run ether on the same machine or on separate
machines
The AS8100 Sitespan Server isthe AS8100 Sitespan component responsible for
monitoring and controlling the telecommunications equipment connected to it.
The Server communicates with the equipment shelvesin their respective native control
languages to issue commands or collect status. The Server isinstructed to carry out these
management duties by commands from connected Equipment Views.
The Server'sjob isto trandate Sitespan commands received from users at Equipment
View terminals into command sequences in the native languages of the connected
equipment. These sequences are issued to the equipment shelves and responses from the
shelves are trandated into Sitespan status messages before being sent to all connected
Equipment Views.
Once a Server has been instructed to configure its connected equipment, it will manage
the equipment regardless of whether any Equipment Views continue to be connected. All
operations and alarms are written to a transaction log file located on the Server machine
maintaining a complete record of status.
The Equipment View application is the user interface through which equipment at all
sites on an AS8100 Sitespan network can be controlled or monitored. Several Equipment
Views can be connected to a single Server, allowing geographically disparate groups of
users to manage equipment at a particular site. Also, each Equipment View can connect
to several Servers, allowing individual users to manage equipment at a number of
different sites.
If two or more Equipment Views are connected to the same site Server then the
consequences of changes made by one user can be seen by all others. For example, if a
user creates a set of subscribers for a shelf, the new subscriber records will appear in the
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Subscriber Views on all Equipment Views. Sitespan is able to do this because al
persistent site equipment information is held only at the Server, with the Equipment View
simply viewing it. Thus when the Server database is altered by a change in site equipment
status, this change is propagated across all of the Equipment Views.

The Equipment View can be run on the same machine as the Server, or on aremote
machine connected to the Server by a modem or network link. Although several
Equipment Views can be connected to a Server, no more than one instance of a Server or
an Equipment View can execute on a single machine,
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HARDWARE OVERVIEW

System Overview

AS8100 Sitespan is a PC-based management and control system via which the
administrator can test, configure and control the AS4000 system. AS8100 Sitespan uses a
PC hardware platform running the Windows NT Operating System.
Typical management functions include:
Configuration, capacity provisioning and assignment of equipment or circuits
Monitoring alarm events and radio performance.

ASB100 Sitespan for Fixed Assignment Systems

The Server isa PC is connected to each AS4000 modem shelf via multiple serial ports.
The server software passes information between it and the AS4000 Shelf Controller
Cards and continuously monitors the system.

A fully configured server system requires 4 serial ports for equipment connection and at
least one other for Remote access connection if Remote Accessis to be used.

Airspan R
|y ( X25 Packet E
Switched
— CK\Ne‘gwork /q>

—

Dialup Modem Link

U
é
\
E

1 SiteSpan
' or Equipment
_ L] View PC
| s [JICC0 p———{ ]
"""""""""""" Fixed Link

SiteSpan Server PC
Equipment View Optional

Figure 1. AS8100 Sitespan connectionsto Fixed Assignment

AS8100 Sitespan for Demand Assignment Systems

The Server isa PC is connected to the Access Concentrator via multiple serial ports. The
DA modem shelves are managed over the link between Access Concentrator and the
Demand Assignment CT modem shelf The server software passes information between it
and the ASA000 Shelf Controller Cards and continuously monitors the system.
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The server can also be connected direct to the modem shelf if required.
The system requires 1 serial ports AC shelf equipment connection (shelves are daisy
chained together) and at least one other for remote access connection if remote accessis

to be used.

AC

=

Sitespan
: Client PC

o e L

-------

uuuuuuu

The Management :
Site '

To other Sitespan Server PC'’s

Subscriber
Site(s)

© CRU
* (External)

PSU

iAntenna

CRU (Internal)

Figure 2. AS8100 Sitespan Connections Demand Assignment.

AS8100 Sitespan Computer Requirements

AS8100 Sitespan Equipment View can run in the same PC as the Sitespan Server.

Alternatively and simultaneoudly it can be operating in aremote PC and accessing the

server PC over a network or modem link.

Sitespan Equipment View can be used to access a number of Sitespan Servers

smultaneoudly.

Refer to the Procurement Specification for the personal computer recommendations.

If the Sitespan Equipment View and Server are being run on separate machines then the

machines should be equipped as follows.

1. Server Machine needs the addition of a modem for use with RAS to contact to client
machine. If the server isto be connected to more than one client simultaneoudly then
an extra modem/serial port will be needed for each simultaneous connection.

2. Equipment View Machine needs the addition of a modem for use with RAS to contact
to server machine. If the Equipment View Machineis to be connected to more than
one server simultaneoudy then an extra modem/serial port will be needed for each
Simultaneous connection.

Page 16 of 305




/ AS8100 Sitespan User Guide Version 3.7
605-0000-426 GSl 004
1 ﬁrspan

\\\' Draft Issue 6.0. Date 4/4/00

NI

SERVICE STATESAND STATUS

Service States

This section provides a descriptive listing of the service states and statuses that may appear
in adisplay. There are anumber of possible service statesin Sitespan (Table 1):
In Service (1S)
The equipment was assigned a service state of in service. in the case of common
equipment and channd units, this service state indicates the equipment will carry
traffic when installed.
Faulty (FLTY)
The equipment isin afault state displaying an alarm or receive attention state.
In Service Faulty (ISFLTY)
The equipment is faulty but is still placed in service.
Equipment Not Present (ENP)
The equipment is physically not present. Thisindicates a card has been remove or
not yet provided.
In Service Equipment Not Present (ISENP)
The equipment is placed in service and will function when the card is replaced or
provided.
Locked (LK)
The service state is locked in the out of service state.
Under Test (UT)
The FRU is being tested.
Secure (SEC)
This applies to the Subscriber Terminal only. In the secure state a serial number
validation is done every 5 seconds.
Table1l. Service States

Name Abbreviation ASA000

In Service 1S v
Faulty FLTY v
In Service Faulty ISFLTY v
Equipment Not Present ENP v
In Service Equipment Not Present ISENP v
Locked LK v
Under Test uT v

Secure SEC v ST only

Common equipment, modem cards, channe units, can all have service states. A service
state of either IS or ENP is assigned when a software record for the equipment is created or
edited using a Sitespan command. In the case of common equipment, modem and channel
units that have not been physically installed, the service state indicates whether the
equipment will carry service when the unit isinstalled. IS and IS ENP service states exist
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only on the software record created for the equipment and do not indicate whether the
equipment is actually carrying service or is actually installed. To obtain further
information, it is necessary to look at the status that accompanies the service state. Statuses
are discussed in Section 3 of this GSI.

Statuses

The status field that appears in some displays provides further details about the state of the
specified piece of equipment. Use the Retrieve pull-down menu.
Many statuses involve the concept of underlying entity. Because the AS4000 systems
consists of a hierarchy of equipment or facilities, an event that affects one piece of
equipment or one facility may affect other equipment or facilities higher in the hierarchy.
The equipment and facility hierarchy, from highest to lowest leve, is:

Alarm

Subscriber

Numbered Element

FRU

Shelf

Rack

Site

Server
If a piece of common equipment fails, the modems being supported by that common
equipment will not be able to carry service.
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GETTING STARTED

Hardware I nstallation

a)

b)

c)

d)

f)

9)

The Sitespan Equipment View and the Server need to be installed and
commissioned in order to configure the Central Terminal, set up the system, and to
connect subscribers.

Check that the necessary items are to hand to install the Sitespan See GSI-006
Hardware Preparation.

Install the Sitespan Server PC. The Sitespan Server is responsible for managing all
equipment racks at a given Site. In particular, it records any alarms flagged by the
equipment and maintains a database and log file of the changes in the equipment
state over time. On its own the Sitespan Server application ssimply managesits
connected equipment and has no way of accepting user commands and of
displaying equipment status in a graphical form. Instead, these functions are
provided by the Sitespan Equipment View. See GSI-007 Install Sitespan Server.
Install the Central Terminal Interfaces. These interfaces allow the server to
communicate to the AS4000 equipment racks using the native languages of the
connected equipment. Commands are Draft |ssued and the responses received are
trandated by the server into Sitespan status messages. See GSI-008/9 Installing
ASHAO000 Central Terminal Interfaces

Install a Modem on the Server PC if it isto be interrogated from a remote
Equipment View Machine. Additional modems will need to be installed for each
anticipated simultaneous connection to the server. The modem allows data from the
server to pass over the network and should beinstalled as per the manufacturers
instructions.

Install the Equipment View PC if different from the Server PC. The Equipment
View and the Server need not necessarily be located in the same machine and a
separate machine may be designated to run the Equipment View either over afixed
network connection or viaadial-up link.

If the Equipment View isto be located at a remote site, and the sites are not
connected by a fixed network, dial-up links need to be provided.. A Modem is
installed on the Equipment View PC for each simultaneous connection to a Server.
The Modem should be installed using the manufactures installation instructions.
For some installations both the Server and the Equipment View PC swill require a
Hardware Key to be attached to a paralldl port to authorise the use of the software.

Softwar e Installation

a)

b)

c)

Ensure that the Remote Access (RAS) Softwareisinstalled. on the Server and the
Equipment View machines. The Sitespan Software is dependent upon the RAS to
allow Windows NT to make connections between machines. See GSI-010.

Install Sitespan Software at Server and Equipment View Machines. Both are
installed on a machine performing both functions. See GSI-011 Software
Installation.

To ensure system security and each remote Equipment View Machine will need to
be registered with the Server. Thisis done at the server PC, set up User Accounts
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and Remote Access dial up accessrights. For details on setting up access rights see
the Widows NT installation manual, Windows NT help screens and DLP-002
Setting Up User Accounts and Access Rights.

d) At Equipment View set up Dial-Up networking (if remote from server). Thisis
done within the Remote Access programme in Widows NT and allows the PC to
dial and connect to the remote Server. For details on setting up Dial-Up networking
see the Widows NT installation manual or Windows NT help screens and DLP-003
Creating Dial-Up networking for the Equipment View.

e) Before connecting to the system new users should refer to refer to GSI-013 Basic
Operations and GSI-014 Sitespan Equipment View Menu System. GSI-015 Server
Menu System and GSI-016 Selecting Views.

IMPORTANT

Please note that in order to run Sitespan (Client & Server), the Remote Access Server
(RAS) must be running. In order to check if the RASisrunning, click on the Start menu
and select Settings->Control Panel, to bring up the control panel window. Then double
click on the "Network™ icon.

From the resulting dialogue, select the "Services' tab and select "Remote Access Service'.
Then select the "Properties..." option to seeif a COM port has been allocated for the RAS.
If the RASisnot running, it will need to be started by selecting the "Add..." option. (Place
the Windows NT4 installation disk in the relevant drive).

Select "Remote Access Service' from the dialogue resulting from the "Add..." option.
Then select OK and follow the presented instructions. Allocate the COM port to be used
for the client/server communication.

Note that a COM port needsto be allocated for RAS, even if the client and the server are
running on the same machine.

Connect to System

a) Run the Server Software. See DLPOO05. The Server Software runs continuoudy at
the CT diteto record any alarms flagged by the equipment and maintains a database
and log file of the changes in the equipment state over time.

b) Run the Equipment View Software. See DLP005. The Equipment View Software
must be continuoudly connected to asiteif it isto monitor alarms.

C) Create the Server record in the Equipment View database. See DLP009. The
Equipment View Software needs details of any Server that it isto connect to.
Creating a Server from within the Equipment View allows connection details to be
input. Each Server on a network must have a unique name.

d) Connect the Equipment View to aremote Server. See DLP012. This procedure will
locate the server name in the phone book and make a connection.

e) Create a Site. See DLP-010. A siteis amanaged collection of AS4000 racks
managed by a single Sitespan Server.

f) Add Racks. See DLP-014 (AS4000) The Racks at the Site are recreated in the
Equipment View and can only be added after the site has been created.

s)] Add Shelves. See DLP-051 (AS4000 FA), DLP-101 (AS4000 DA). When a shelf is
being connected to and managed by the Sitespan system an element must be
created in the Sitespan Server Database for the shelf by using the Equipment View.

h) The Shelf Element must be configured with the Equipment View to tell the
Sitespan Server the necessary operating information to allow it to communicate

Page 20 of 305



AS8100 Sitespan User Guide Version 3.7

Draft Issue 6.0. Date 4/4/00

605-0000-426 GSI 005

with the shelf. Thisinformation usually includes the COM port on the Server
Machine that the cable from the shelf has been connected to for fuller details. See
DLP-053(FA) & 102(DA).

i) Add subscribers to the ASA000 if subscribers are to connect to AS4000 FA. See
DLP-058 to DLP-066.

) Add subscribers to the AS4000 if subscribers are to connect to AS4000 DA. See
DLP-111.

Managing AS8100 Sitespan
The AS8100 Sitespan operator can input, amend and view the site management resource
data using views with graphical icons as follows:
Server
Site
Rack AS4000 FA
AS4000 DA
Shelf ASA000 FA
AS4000 DA
Card AS4000 FA
AS4000 DA
Subscriber Terminal FA
DA
Subscriber  AS4000 FA
ASA4000 DA

Managing Larger Networks

The AS8100 Sitespan Equipment View also allows the operator to use an Object List View
to view any object in the Sitespan Server database, This information isviewed in text
format only and allows more information to be displayed on the screen. See GSI-017
Managing a Network of Server Sites.
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HARDWARE INSTALLATION: PREPARATION

Preparatory Tasks

When the following conditions have been met AS8100 Sitespan can be installed and
commissioned.
The CT (Central Terminal) equipment racks have been installed and commissioned (see
605-0000-432). And in Demand Assignment installations the Access Concentrator racks
have been installed (605-0000-433)
The CT antenna/feeder has been installed and commissioned (see 605-0000-433).
Required Tools:
Before the ST (Subscriber Terminal) can communicate with the Central Terminal/Shelf
controller it is configured by the installer using a programming code generated by
Sitespan. This codeisloaded by the ST installer usng STMON. The following four
parameters are used to generate the CRU (Customer Radio Unit) program code:
a) RF (Radio Frequency) channel pair
b) Timedot pair assignment
C) PN sequence
d) CRU ID
Thefollowing isalist of tools and equipment you may require depending on the
ingtallation:
Medium Flat Blade Screwdriver
Small Flat Blade Screwdriver
Medium Pozi-drive Screwdriver
Medium Side Cutters
Required Equipment:
Digital Multimeter Fluke 77
List of parts. The following items are required:
A Central Terminal Server PC with Equipment View in the same machine
- Personal Compuiter.
Software disks for Sitespan software.
RS-232 Interface cables (1 per Modem Shelf) (ACC Part No 454-0000-058)
Sitespan Manual.
-1 Paralld Port Hardware Key for each Sitespan Machine,
A PC for Server Only
- Personal Computer.
1 Serial Port and Modem for access from client.
RS-232 Interface cables (1 per Modem Shelf) (ACC Part No 454-0000-058)
AS8100 Sitespan Software.
- 1 Paralld Port Hardware Key.
A PC for Equipment View only
- Personal Computer.
1 Serial Port and Modem for access to Server.
AS8100 Sitespan Software.
Some systemsrequire 1 Parallel Port Hardware Key.
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Site Readiness. Task 1 involves verifying that your site is ready for the installation of the
Sitespan. This preparation is covered by an ACC Site Survey or survey form completed by
the customer. The survey includes a site plan of the facility with floor plan, all power
outlets, power boxes, and cabling locations marked.
Inspect the site, particularly the equipment room, before unloading or unpacking
the equipment to ensure:
Adeguate earthing is provided.
Access to the equipment will be adequate for installation normal handling and
movement.
The heating, ventilation and air conditioning Systems are operating correctly.
Sufficient lighting is available for proper installation and operation installation
and operation.
Flooring. In raised floor installations, cut-outs may be made in the floor for cable access
to the Sitespan server PC and the AS4000 Racks. Use the site survey floor plan to verify
the location and size of the cut-out.
Cable Trays. Cabletraysare normally provided by the customer. Use the site survey to
verify that they arein place, provide routing to the proper destinations, and that they have
adeguate strength to support the cables.
Power Availability. Mains power suppliesfor the Server PC and any associ ated
communications equipment should be highly available. If the power is subject to disruption
then an Uninteruptable Power Supply (UPS) should be considered.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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INSTALLING THE AS8100 SITESPAN SERVER PC

The Sitespan Server isresponsible for managing all equipment racks at a given site. In
particular, it records any alarms flagged by the equipment and maintains a database and 1og
file of the changesin the equipment state over time. On its own the Sitespan Server
application simply manages its connected equipment and has no way of accepting user
commands and of displaying equipment status in a graphical form. Instead, these functions
are provided by the Sitespan Equipment View.

STEP PROCEDURE

Installing the AS8100 Sitespan Server PC
Unpacking Procedure:
- Take ddivery of the equipment and verify against the packing list. Inspect the
items and report any damage or shortage to the carrier immediately.
If not to be used immediately, repack the items and store in a safe area.
Dispose of all packaging.
Note: It isrecommended that you keep one packing carton for each type of item
should you need to return items for repair.

L ocating the AS8100 Sitespan PC

The Sitespan Server PC should be placed in a reasonably secure room, which must
conform to the environmental specification of the PC manufacturer. The PC does not have
to be located with the AS4000 Racks but must be within an RS-232 cable run of 25m.

The PC is powered from the AC mains.

Locate the power outlet and RS-232 cable run with the aid of the site survey.

Installing the Serial Cards

Remove the cover to the PC, locate the available card dots, and install the serial cards
following the manufacturers instructions.

Installing the PC Operating System Softwar e

If not pre-installed, follow the manufacturersinstructions for the installation of "Windows
NT.

Install the M odem(s)

The Modem should be connected to a Serial/Com Port. and installed as per the
manufacturers instructions and connected to the telephone socket. Each modem provided
will need a separate Serial Port and a separate telephone line.

Configuring the server for remote access

The Sitespan Software will not execute until the Remote Access Service (RAS) utilitiesare
installed. Windows NT installation disks are needed for this procedure which can be found
in the Windows NT Workstation Installation Guide and on the Remote Access Help
menu'’s.
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Use the Remote Access Admin program found in the Administrative Tools section menus
to configure the RAS port for incoming calls. This procedure can be found in the Windows
NT Workstation Installation Guide and on the Remote Access Help menu'’s.

_7=| Programs
& Documents
i;;fg Settingz
3] Find

&3 Help

71 Run...

B Shut Down,..

-

=, Administrative Toals [Cammo) F‘ Backup

| FE?'] Diizk. &drninistrator

(3] Eventiewer

ﬁ’ Perfarmarnce Maonitar

_% Remote Access Admin
ﬁ_f Izer b anager

;:Jg' Windows MT Diagnostics

STOP. THISPROCEDURE HASBEEN COMPLETED.
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PHY SICAL CONNECTION TO RELEASE 2 AX4000

Use this procedure to provide interfaces to AS4000 release 2 racks.

When plugged into the modem shelf backplane, Sitespan becomes
the master controller and the shelf controller the dave. The
configuration file of Sitespan will automatically overwrite any

WARNING:

existing shelf controller configuration.

STEP

PROCEDURE

I nter face Connections

1. Connect each ACT (AS4000 Central Terminal) modem shelf (see Figure 3) to the
Sitespan PC viaa single RS-232 cable. A single 9 way or 25 way D-Type connects to
the PC and a 25 way D-Type connects to the modem shelf. The cable connections are
shown in Table 2 below.
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Figure 3. AS8100 Sitespan: Connectionsto AS4000 Release 2
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25 Way Male Connector

Pin to Pin | 25/ 9way Female Connector af

at Modem Shelf Signal PC Signal
Earth (PE) 1tol Earth
Transmit TxD 2t03 Receive
Receive 3to2 Transmit
Return (0v) 7t07 Return

Table 2 RS232 Connections

1. The RS232 connector can be found on the modem backplane, labelled 'PL15 and
'Element Manager'. The RS-232 cable(s) enter the ACT from the top and aretied-in
down the right-hand side cable duct.
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RLT Modem Shelf
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Low
Noise

| Tributary Modem 1['{ [Analogue
] unit Card Card

| JAmplifier

|
| Shelf Controller I . |Monitor_|

[Sherr ] |

LED/Alarm Panel

TATarm 1| |Power Supply 1
[ Unit § Unit
Equipment Power
Interface Shelf

RS 232 links

Alarm -24V to -70V

- Extensions
SiteSpan

-------- Modem / Communications Link to
other PCs

Figure5. AS4000 System Architecture

3. Each card or FRU (Field Replaceable Unit) that electronically holds its serial number
automatically reportsit to the Sitespan Server on power up. This serial number isa
unique identifier of the resource in question and cannot be changed after manufacture,
Whenever an FRU isreplaced, the controller of the FRU identifies the event and reports
the serial number of the new FRU to the Sitespan Server.
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Note: Safety Precautions

1. Personnd installing the ACC AS8100 Sitespan product should follow adequate safety
procedures as laid out in the Installation Workmanship Requirements Manual .

WARNING: On AC ingtallations, hazardous voltages exist. Use caution when
verifying or working with AC power. Remove metal jewellery that
could come into contact with AC power. On DC sections, short
circuiting the low voltage, low impedance circuits can cause severe
arcing that may result in burns or eye damage. Remove rings,
watches etc. to avoid shorting DC cir cuits.

ELECTRO STATIC DISCHARGE:
Many circuits contain devices which ar e susceptible to damage from

high impedance voltage sour ces. To avoid such risks, always follow
anti-static precautions.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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PHYSICAL CONNECTION TO FIXED ASSIGNMENT

ASA000

Use this procedure to provide interfaces to AS4000 Fixed Assignment shelves.

WARNING: When plugged into the modem shelf backplane, Sitespan becomes
the master controller and the shelf controller the dave. The
configuration file of Sitespan will automatically overwrite any
existing shelf controller configuration.

STEP

PROCEDURE

I nter face Connections

1. Connect each CT (Central Terminal) modem shelf to the Sitespan PC viaasingle RS-
232 cable (See Figure 6). A single 9 way or 25 Way D-Type connects to the PC and a
25 way D-Type connects to the modem shelf. The pinouts for an RS232 cross-over

cableareshown in Table 2

[— —— - —

o [:gl

Shelf

RF Combiner

PN
°

Modem Shelf 1 &

RS232 Links

Modem Shelf 2 &

Modem Shelf3 2

Sitespan
Server

Modem Shelf4 £

° °
Level Control Unit

W N W 1

Figure 6. AS8100 Sitespan: Connectionsto AS4000
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25 Way Male Connector | Pin to Pin 25/ 9way Female
at Modem Shelf Signal Connector at PC Signal
Earth (PE) ltol Earth
Transmit TxD 2103 Receive
Receive 3t02 Transmit
Return (Ov) 7107 (25way) Return
7t05 (9way)

Table 3 RS232 pin Connections

2. The RS232 connector can be found on the modem backplane, labelled 'PL5S'. The RS-
232 cableg(s) enter the ACT from the top and are tied-in down the right-hand side cable
duct. On Release 4 ingtallations the Sitespan RS232 connector islocated on the right
hand side of the shelf (see Figure 7). On release 3 shelves the Sitespan connects directly

to the modem shelf backplane (see Figure 8)

d

=

Modem Shelf

/

Figure 7. Sitespan Connection to a Release 4 M odem Shelf.
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Figure8. CT Modem Shelf Backplane Fixed Assignment.
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- Unit : Unit
\
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to other PC’s

Figure 9. ASA000 System Ar chitectur e (Fixed Assignment)

Each card or FRU (Field Replaceable Unit) that eectronically holdsits serial number

automatically reportsit to the Sitespan Server on power up. This serial number isa
unique identifier of the resource in question and cannot be changed after manufacture,
Whenever an FRU isreplaced, the controller of the FRU identifies the event and reports
the serial number of the new FRU to the Sitespan Server.
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Note: Safety Precautions

1. Personnd installing the ACC AS8100 Sitespan product should follow adequate safety
procedures as laid out in the Installation Workmanship Requirements Manual .

WARNING: On AC installations, hazardous voltages exist. Use caution when
verifying or working with AC power. Remove metal jewelry that
could come into contact with AC power. On DC sections, short
circuiting the low voltage, low impedance circuits can cause severe
arcing that may result in burns or eye damage. Remove rings,
watches etc. to avoid shorting DC cir cuits.

ELECTRO STATIC DISCHARGE:
Many circuits contain devices which ar e susceptible to damage from

high impedance voltage sour ces. To avoid such risks, always follow
anti-static precautions.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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PHYSICAL CONNECTION TO DEMAND ASSIGNMENT

AA4000

Access Concentrator racks.)

Use this procedure to provide interfaces to AS4000 (Demand Assignment CT racks or

WARNING:

When plugged into the modem shelf backplane, Sitespan becomes

the master controller and the shelf controller the dave. The

configuration file of Sitespan will automatically overwrite any
existing shelf controller configuration.

STEP

PROCEDURE

I nter face Connections
a) Access Concentrator Shelf

of the Access Concentrator Shelf.

The Sitespan is connected to the Sitespan 1 D-type connector on the connector panel

SITESPAN 1
(o]

1

o

SITESPAN 2

I

Figure 10. Demand Assignment Access Concentrator Shelf Backplane
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b) Demand Assignment CT Modem Shelf
Sitespan is connected to the Sitespan 1 D-type connector on the connector panel of

the first Modem Shdlf.

SITESPAN SITESPAN

Figure 11. Demand Assignment M odem Shelf Backplane

)
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OPERATING SITESPAN FOR FIXED ASSIGNMENT OVER
DEMAND ASSIGNMENT BACKHAUL

Use this procedure to provide a Sitespan connection to an Access Concentrator Site for a
Fixed Assignment Modem Shelf installed on the same site as a Demand Assignment CT
Rack

WARNING: When plugged into the modem shelf backplane, Sitespan becomes
the master controller and the shelf controller the dave. The
configuration file of Sitespan will automatically overwrite any
existing shelf controller configuration.

STEP PROCEDURE

DA Modem Shelf to FA Modem Shelf I nter face Connections

The Sitespan 2 and SC AUX connectors are used to backhaul FA Modem Shelves.
To connect a FA Modem Shelf for backhaul to the AC Site provide alink cable
between the Sitespan 2 (9 way D-type) connector and the Sitespan 25 way D-type
connector on the FA Modem Shelf.

To connect a second FA Modem Shelf for backhaul to the AC Site provide a link
cable between the Sitespan Aux (9 way D-type) connector on the DA Modem Shelf
and the Sitespan 25 way D-type connector on the FA Modem Shelf.

SITESPAN SITESPAN

Figure 12. Demand Assignment M odem Shelf Backplane
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Connection to a Fixed Assignment Modem shelf is shown below

Modem Shelf

a

T

2 Mbit/s
Cables

=

)

D
5

s

—

Figure 13. Fixed Assignment Release 4 Sitespan Connection

Connecting cables should be routed through the rack side channels and tie wrapped if
necessary. Details of the connecting cables are shown below. The connecting cable
reguires a 25 way male D-type at the Fixed Assignment Modem Shelf and a 9 way female
D-type at the Demand Assignment Modem shelf.

~ = ~~. =
__Qﬂ S e o ° e o ° l-<_
o @ o “ @ o
—- [k el >—
K I <ol e s
9 Female - : : oM ==
o co
DA Shelf . o °|| FA Shelf
Sitespan 2 S oo
or SCAUX . ® ° .
= =
25 Male
Set the Sitespan FA Modem Shelf Propertiesto enable the link to the shelf. See DLP-053

Editing Modem Shelf Properties.
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INSTALLING THE SITESPAN EQUIPMENT VIEW PC

The Sitespan Equipment View allows the user to access the Sitespan Servers from a
remote location. The system is not dependent upon the Sitespan Equipment View being
connected to the Server continuoudly but the Sitespan Equipment View needs to access the
Server when it wants to get status updates receive alarms and pass new information to the
Server.

STEP PROCEDURE

Installing the AS8100 Sitespan Server PC

Unpacking Procedure
Take delivery of the equipment and verify against the packing list. Inspect the
items and report any damage or shortage to the carrier immediately.
If not to be used immediately, repack the items and store in a safe area.
Dispose of all packaging.
Note: It isrecommended that you keep one packing carton for each type of item
should you need to return items for repair.

L ocating the AS8100 Sitespan PC

The Sitespan Server PC should be placed in a reasonably secure room, which must
conform to the environmental specification of the PC manufacturer.

The PC is powered from the AC mains.

Locate the power outlet and the telephone socket for the modem with the aid of the site
survey.

Installing the PC Software

If not pre-installed, follow the manufacturersinstructions for the installation of "Windows
NT.

Install the M odem(s)

The Modem should be connected to a Serial/Com Port. and installed as per the
manufacturers instructions and connected to the telephone socket. Each modem provided
will need a separate Serial Port and a separate telephone line.

Configuring the server for remote access

The Sitespan Software will not execute and be fully functional until the Remote Access
Service (RAYS) utilities areinstalled and the Equipment View is set up afor remote access.
Windows NT installation disks are needed for this procedure which can be found in the
Windows NT Workstation Installation Guide and on the Remote Access Help menu’s.

Page 39 of 305 © 2000 Airgpan Communications Ltd



_7=| Programs
& Documents
i;;fg Settingz
3] Find

&) Help

71 Run...

B Shut Down,..

-

AS8100 Sitespan User Guide Version 3.7
605-0000-426
Draft Issue 6.0. Date 4/4/00

GSl 012

=, Administrative Toals [Cammo) F‘ Backup

| FE?'] Diizk. &drninistrator

(3] Eventiewer

ﬁ’ Perfarmarnce Maonitar

_% Remote Access Admin
€5} User Manager

;:Jg' Windows MT Diagnostics

The RAS need to be configured with connection details to allow the Sitespan Equipment
View to connect to the Server. See DLP-003 Creating a Dial-Up networking entry for the

Equipment View.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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AS8100 SITESPAN SOFTWARE INSTALLATION

Use this procedure to install Sitespan Software. If both the Server and Equipment
View are co-existing in the same machine install both the Server and Equipment View
software. This procedure should be preceded by the installation of Windows NT.

STEP PROCEDURE

1. Place CDROM containing Sitespan Software into CDROM Drive.

2. From the Start menu on the Windows NT Program Manager screen select Run.

Programs L
=% Documents J
Settings r
2 Find *
& Help
g Bun...

@ Shut Down...

3. Typed:\Setup.exe (where d represents the drive in which the CDROM islocated) in
the Command Line box that appears in the Run window and then click the OK button
or pressthereturn(¢,) key.

Hun [ 2
pe== Type the name of a program, folder, or document, and
% Windawes will open it for pau.
Open: |"D:'xSetup.e>:e'1 j
[
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Welcome

Wielcome to the 458700 Sitezpan.’y'37 Setup
programm. T hiz program will install 458700
= Sitegpany3¥ an your computer.

[t iz gtrongly recommended that you exit all Windows programs
befare running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs youl
have mnning. Click Mest o continue with the S etup program.

WARMIMG: Thiz program iz protected by copuright law and
international treaties.

Unauthonzed reproduction or diztibution of this program, or any
portion of it, may result in zevere civil and criminal penaltiez, and
will be prozecuted to the masimum extent possible under law.

b

Hewt > Cancel

5. After reading the license agreement click Yesto proceed.

Software Licenze Agreement E |

6.

Pleaze read the fallowing Licenze Agreement. Press the PAGE DOWH ke to zee
the rest af the agreement.

Copyright 1333 Airzpan Communications Corporation. ﬂ
ALL RIGHTS RESERWED.

" arning:
Thiz computer program iz owned by Airspan Communications Corporation.
[t iz Protected by Copyright Law and International Treaties.

Ilnauthorized reproduction or distibution of thiz program, or any portion of it
may result in zevere civil and criminal penaltiez, and will be prozecuted
to the maximum extent poszible under the lav.

=
Do you accept all the terms of the preceding License Agreement? If you choose Mo, Setup
will cloge, Toinztall A58100 Sitezpan 37, vou must accept this agreement,

¢ Back Tes Mo |

Insert registration information as required
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Type vour name below. *'ou muzt alzo type the name of the
compaty you wark far and the product zenal number.

M arne: I

Compar: I.ﬁ.irspan Communications PLC

Senial: |21 144206113

¢ Back I MHewt > I Cancel |

7. From the Choose Destination Location window Setup will install Sitespan in the
C:\Sitespan directory. To install Sitespan in another directory click the browse button
and choose an alternative directory. Continue by clicking the mouse on OK.

Choose Destination Location E

Setup will install 58100 Sitespan.y¥37 in the following folder.
Toingtall to thiz folder, click Mest.

Toinztall to a different folder, click Browse and zelect another
folder.

Y'ou can chooge not to install 4587100 Sitespan 37 by clicking
Cancel to exit Setup.

" Destination Faolder

C:%Program Files' 458100 Sitespan /37 Browse... |

¢ Back

Cancel |

8. Review ingtall detailsin summary screen. Click Next to continue with the

installation..
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Setup haz enough infarmation ta start copring the proaran files.
[f you want bo review ar change any zettingz, click Back. [fF pou
are zatisfied with the zettingz, click Mest to begin copying files.

Current Settings:

Selection |nformation: ;I
Izer Mame:T Dept
Company:&irspan Communications PLC
Serial Humber: 21144205113
T arget Directony: C:\Program Files'A581 00 Sitespan 37

¢ Back

9. Click Finish on the Set-up screen to complete installation.

Information

Feadme file;

LIJ
Cancel |
E

Sitezspan Readme File
B

Fleaze note that in order to run Sitespan [client & Server),
the Femate Accezs Server [FAS] muzt be running.

In arder ta check if the BAS iz running, click on the

Start menu and zelect Settingz->Caontral Panel,

to bringup the control panel window,

Then double click on the “Metwork" icon. | -
Fram the resulting dialogue, select the "Services" tab

and zelect "Hemote Access Service",

Then Select the "'FProperties..." option to zee if a COM part

has been allozated for the RAS.

[f the BAS iz not rinning, it will need to be started

-
4] I B

¢ Back
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10. The information screen gives details on the setting up of RAS in windows NT4.0

Setup Complete |

Setup haz finizhed copying files ko yaur computer.

Before pou can use the program, pou must restart 'Windows or
Wour conmputer.

& Ses | want bo restart my computer o

™ Mo, | will restart my computer later.

Femaowve any disks from their drives, and then click Finizh to
complete setup.

¢ Hack I Finizh I

11. At the end of the setup the installed items will appear asiconsin the Sitespan V37

folder along with asignaling file editor.

f5 AS81005itespan. v37 =]

File Edit “iew Help

Signalling File Tranz
Editor

4 object(s) 230KE

12. The programs will aso appear in the windows start menus
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= i

2§ Documents y | LB Ewecutive Software ¥ @t Server

Settings , L8 ForeHelp and ForeHTHL Pro 4 Dema  # I Signaling File Editor
2] Find " .= lomega Tocls for Windows NT ¥ Trans

& Help &3 Microzoft FrontPage

E ;un_ % Microzoft Outlook,

% Microsoft Qutlook, Newsreader
Microzoft PowerPoint
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BASIC OPERATIONS

This section gives a brief outline of the operation of the windows environment used by
the Sitespan software. The user should refer to the Microsoft Windows User's Guide for
more detailed information.

Basic Operations
Figure 14 shows Sitespan in atypical windows environment.

" AS8100 Sitespan Equipment Yiew [ [O] =]
File  Edit Tools Window Help
= n ¢ v Toolbar
v Statuz Bar
m Element Yigw " Metwork:-AIR001703:Site0
Mame tion
: Subzcrbers
History =
4 | | Alarms
—
Marne QpclatﬁT Server Files Fiption
Tree View —
Sublogs. .. _lj
| MapView >
Metwork[Object List, Rack] o [=] B
Hame Description

Hetwork AIRD01 703:Sited:Rackl AS4000 (D& AC Rack, Mumber 1 ﬂ
Metworkc AIRD01703:Site0:Rack? AS4000 (D& CT Rack, Mumber 2

Metwork AIRDD1 703 Sited:Racks AS4000 Rel 3 (FA) Rack, Numbilll
»

= wa Metwork:AIRD01 703:Site0:Rack2:Shelfl =]

< Metwork[Object List All]:1 _ (O] x|

P Subscriber Eontainer 2| | ame
; 2 Subscriber Container - _I
i Zh Subsoriber Container MHetwark AIRDDT 703

f;p Metwork, Fixed
B D Global Object Containe—

- & Sitel _l;l _l;l
KN T KX 2 MetworklOb. [S1[=] 3 wn Network-Al - [EI[m] 3
Create an active alam view of the site v

Figure 14. AS8100 Sitespan in Windows environment.

In the windows environment, most actions are triggered by using a mouse pointing
device. Moving the mouse on aflat surface produces an equivalent two dimensional
movement of the mouse pointer on the screen. The following terms are associated with
the use of a mouse:
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Term M eaning
Click Press and rel ease quickly a mouse button

Double-click | Click the mouse button twice in rapid succession

Drag Hold down the mouse button while moving the mouse
Paoint Move the mouse until the mouse pointer on the screen rests on the required item
Select Paint to the required item on the screen and click the mouse button.

Table4 M ouse Commands

Both the left and right buttons of a mouse are used in this point and select mode. The |eft
mouse button is used to select menus radio buttons and insertion points. The right mouse
button invokes a menu related to the object being pointed

Use of Windows

Figure 15 is an example of atypical view seen when Sitespan running under Windows.

Close Window

Control Button Drop Down Menu  Active Window Maximise Window
Tool Bar Title Bar (Title Bar Highlighted) Menu Bar Minimise Window
" ASB100 Sitespan Equipment View
File  Edit Tool: Window Help
=l e ivloolbar
v Statusz Bar
0 s
m Element Yisw =101} 0 0170 1 - O] =
Mame XTI ETIRETIRPR -
: Subscribers
Hiztory =
<| | Alarms >
— _I
BT obect st (O] %]
HEmE Update Server Files Hption
Sublogs... -
] apView ’
Network[Object List.Rack] O] x|
Marme Descriptian I
- Rack? ack? Rack3 -
Metwork AIRDOT 703 5ite0:Rack] AS4000 (DAY AC Rack, Mumber 1 ﬂ q _I 5
MNetwork AIRODTT03:5ite0:Rack? AS4000 (DAY CT Rack, Mumber 2 7
Metwork AIRDO0T 703 Sitel:Rack3 AS4000 Rel 3 (FA) Rack, Mumber 'I . 00170 0 _io
iI I 3
7+ Network[Dbject List All];1 = g
Vw2 Subscriber Container | | Mame o
|- Subscriber Container — - |
f:p Subzcriber Container Metwork AIRTNM 703
H-25 Metwork Fived
H-Z5 DA Global Object Containe—
H- % Sited _I;I _I;I
|«] | FIL Y K ’ etwork[Ob.... |51 [=] |E3 0 [l 3
Create ar) active alam view of the zite N v
Non- Active Window Minimised Window Selected Shelf Scroll Box Scroll Arrow
Status Bar

Figure 15. Typical Windows Sitespan View
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stration, the main application, complete with title bar, menu bar and tool bar,

has been maximised to full screen, and child windows have been opened within the main

applicatio

n.

TitleBar Thetitle bar shows the name of the application. If more than one
window is open, thetitle bar for the active window is highlighted. In Figure 15,
the main application, the Sitespan Equipment View is active and the title bar is
highlighted. In addition, within the main application, a number of child
windows have been opened, and of these, oneis highlighted as active.

Menu Bar The menu bar lists the available menus which are provided as drop-
down menus.

Scroll Bars Refer to windows user guide.

Window Adjustment Refer to windows user guide.

Control Button Refer to windows user guide.

Status Bar The status bar, along the bottom of the screen, displays context-
related help messages.

Tool Bar Thetool bar isused to provide a quick access to commonly used
commands, see Figure 16. The command isinvoked by clicking on the
associated button. A context sensitive help message is presented on the status
bar for each tool bar button. This message can be viewed by placing the mouse
pointer on the tool bar button and holding down the mouse button.

Note: The command will be invoked if the mouse button is released while still
pointing to the tool bar button: drag the pointer away from the tool bar button
before rel easing the mouse button if the command is not required. A description

of

the Sitespan Tool Bar Buttonsis given at the end of GSI-014.

Tool Tipsand Special Cursors
The windows Tool Tips are short help messages that appear on a yellow background.
They are automatically activated the mouse on an object or toolbar button for a few

seconds.

" AS8100 Sitespan Equipmen___ [Eix] E3

File Edt “iew Tool: “Window Help

7| B[ =7 fom] |
E]pen]-Tuul Tip

Status Bar

Open an existing document o

Figure 16. Toolbar Buttons

In Sitespan there are a number of special cursors and tool tips.

\

Modem Shelf
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The normal white arrow cursor changes to the subview cursor |eft to
indicate that thereis a subview of the object at this point. Leaving the
cursor on the object for a few seconds invokes a description of the sub
view available.

This cursor appears when pressing the right mouse button to atitlefield on
alist view and indicates that the field pointed to can be re-ordered by
holding down the left mouse button and dragging thefield to a new
position.
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Drop Boxes

TEK lﬁ Information is entered into Sitespan either by directly typing into
boxes for |abelling or by the use of drop windows that show all
3 | theavailable options. Click the mouse on the arrow to the right of
11137 | the box to seethe list of options available for selection.

*

Check Boxes

M Indrect  Activate check boxes by pointing the mouse into the box and
clicking the left mouse button

Radio Buttons

™ Master Radio Buttons toggl e between options. The chosen option appears
Gl with a dot. To change options point and click the left mouse button
in the aternative field

Views

In this document, child windows opened within Sitespan are referred to as ‘views'. Thus,
in Figure 15 the active child window relating to the Shelf isreferred to as a Shelf View.
Views may be minimised and appear as small icons at the bottom of the parent window.
The views provide the mechanism for displaying information to the user. Any
combination of views may be displayed, although the user can only manipulate one of
them at any one time (referred to as the active window). Windows that are open but not
active will still display changes generated by the program software; for example, a
change of status or alarm condition.

Page 50 of 305



/ AS8100 Sitespan User Guide Version 3.7
) 605-0000-426 GS| 015
ﬁrspan

|

\ \\\' Draft Issue 6.0. Date 4/4/00

SITESPAN EQUIPMENT VIEW MENU SYSTEM

Overview

The administration, maintenance and provisioning of AS4000 equipment can be
undertaken at a single Sitespan station through a Graphical User Interface (GUI). and a
series of menus to guide the user.

Menu Bar

The Menu bar, with its options and sub-menus, houses the compl ete range of functions that
can be performed through Sitespan. However because stepsons menus are context sensitive
only those options appropriate to the current task are displayed. Choosing one of these
optionswill produce a menu containing the commands and options specific to the menu
choice.

" ASE100 Sitespan Equipm... [lj[=] E3

File Edt “iew Tool: “Window Help

| =7 ] ]

FileMenu

The File Menu contains all the functions necessary for printing files. It aso allows the
operator to exit the system.

Hew Chrl+M
Open... Ctrl+0
Cloze

Save Chrl+5
Save fz

Irpart
Export

Brrirt... Ctrl+F
Print Prewisw
Print Setup...

11703 2=d
2 Template. z2d

Exit
New. Create anew, empty, sitefile.
Open. Open an existing sitefile. The File Open dial ogue box appears
requesting details of the file name, directory and type. Options are to open
config files and system files.
Close. Closesthe current file. If the file has not been saved, an invitation to do
so is offered.
Save. Savethe current site file under its current name.
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Save As. Savethe current site file under a different name. The File Save As
dialogue box opens (showing the last used or default details) and requests details
of the different file name, directory and type.

Import. Used to import information from Subscriber Terminal databases.
Export. Saves Lists as Rich Text Filesfor usein other programs

Print. Thiswill print the current view and Opens the Print dialogue box showing
current settings and requesting printer details and print ranges. The printer details
can be amended via the Set-up button which, when selected, opens the Print Set-
up dialogue box.(See below).

Print Preview. Gives screen based preview of the information to be printed. A
toolbar in Print Preview gives options to Print, show Next, Previous or Two
pages, Zoom in or out, and Close.

Print Setup. Opensthe Print Set-up dialogue box This allows changes to be
made to the printer, and paper size, orientation and source.

Exit. This option disconnects the Equipment View from any connected servers,
closes al files and returns the user to Windows NT. Closing the equipment view
does not effect any AS4000 equipment state.

Edit Menu

The Edit Menu allows users to connect to the one or more Sitespan servers and then create
and del ete subsequent items of equipment. Site, rack, shelf and card properties can be set
from this menu, however since the menu is context sensitive, not al the options are
available at one time.

Undo Chrl+Z
Bedo Chrl+&,
Cut Chrl+
Copy Chl+C
Faste Chrl+f
Farent Properties...

Child...

Create Server

Create Child Element...
Delete Element. .

Beceiving Attention
Connect Server
Dizconnect Server

Undo. Thiscommand undoes the last command executed. Subsequent clicks on
thiswill undo previously entered commands in sequence from latest to earliest (up
to 100 levels). Note that undoing a command will restore the equipment state to
that before the command was executed.

Redo. Thisoption regppliesan ‘Undone’ command Thisis only available when
the Undo command has been applied at least once.

Par ent Properties. The Sitespan equipment mode is hierarchical. This context
sensitive option allows the properties of the parent of the current equipment
element to be viewed and edited. e.g. If shelf view is currently displayed this
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option will be displayed as ‘Rack Properties'. This option will change depending
on which equipment view in the hierarchy is selected to be current with the
mouse. The Sitespan equipment hierarchy is as follows:

Network
Y \v
/ Server View Object List View
v

History View Site View

v
Rack View

Y
Shelf View

v
Card View

Child This context sensitive option allows the properties of the child of the
current equipment element to be viewed and edited. This option will vary
depending on which equipment selected in the hierarchy is selected to be current.
Create Child Element Thisallowsthe creation of a child eement, i.e. a shelf
when in therack view.

Delete Element Deletes the selected e ement from the server database.
Receiving Attention Thiscommand allows an active alarm in a object list view
or acard view to be acknowledged and effects a state change to clear the alarm.
Create Server. Allowsthe user to create an unconnected Server end point record
in the server window.

Connect Server Allowsthe user to connect to a server that has been created with
the Create Server command.

Disconnect Server Thisoption allows the user to disconnect the equipment view
from a selected server.

View Menu

The View Menu allows the user to access any of the display window types availablein

Sitespan and create new types.

v Toolbar
v Status Bar

Element Wigw

Subscrbers

Hiztory

Alarmz

Active Alarms
Object List...
Update Server Files
Tree View
Sublogs...

Map Wiew
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Toolbar Thismenu item selects and desel ects the toolbar. The toolbar provides
“shortcuts’ to some of the more frequently used Windows and Sitespan functions. If a tool
bar button is dimmed, then that button is not available to the current active window.

File (IDpen Prlint Subscrillaer View
!
ﬁ‘ﬂ‘%'ﬁﬂm‘ ‘I"'r'l
f f f

Alarm Create
View Subscriber

Save

E?‘W| Sdlecting thisicon produces the File Open dialogue box in the File
drop-down sub menu.

Clicking on thisicon will Save the active file under its current
filename and directory. Also available in the File drop-down sub menu.
See 3.61.

J@[ The Print dialogue box appears on selecting thisicon. Also available
in the File drop-down sub menu.

@ Sdlecting thisicon produces the Alarm View.

‘T;H‘ The Network Subscribers window appears on selecting thisicon. This
will show subscriber attached to the Central Terminal.

\T'_l The Edit Subscriber window appears on selecting thisicon. This
allows attachment of subscribersto Fixed Assigned systems only.

StatusBar This menu item selects and desel ects the Status Bar. The Status Bar is
displayed along the bottom of the screen and displays context sensitive help
messages. Av’ shows that the Status Bar is selected and is visible on the screen.
Element View The Element View allows the user to view detail of the selected
item. Element View will change depending on the screen that is being viewed, i.e.
in the menu above the element available to view isthe Site View, in this case
selecting this view will bring aview of all the racksin the selected site,
Subscribers This menu item sdlects the Subscriber View. This view shows
details of subscribers connected to the AS4000 racks at the current site. Details of
customer Name, Address, Phone number, Tariff, CT , Channel / Modem, Slot
number and activation state are al displayed in this view.
History The history command displays alist of all operations performed on the
selected server.
Errors The errors command displays a window displaying any error messages
posted from the Sitespan Server.
Object List The Object Lists display the system messages for the chosen objects.

Tools M enu

The Tools Menu provides tools for changing the colours of the display, selecting frequency
and tariff options and creating default subscribers for a compl ete shelf.
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Colours
Optianz

Subszcrber Creator Wizard. .

Colours This menu option is used to select the default colours for alarm
conditions and card states.

Options Selecting thisitem givesthe user the ability to modify the selections
offered when Sitespan prompts for frequencies and call tariff.

Subscriber Creator Wizard Thistool creates a full shelf of subscribers.

Windows M enu

The Windows Menu allows the user to change the presentation of windows and lists the
open files.

LCascade
Tile

' Arrange lcons

1 Mebwork[Object Lizt Site]

i v 2 Metwork[Dbject List,Server]
Cascade This places the open windows in a cascade on the screen with the active
window at the front.
Tile This palacesthewindowsin a tile formation on the screen.
Arrange lcons This placestheiconsin aneat line or array depending on the
shape of the window.
1 2 _3 OpenFiles. Thisliststhe objects that are open and a v will appear next
to the active object.

Help Menu

The Help Menu provides information on using Sitespan and the version number
information.

Index
Uzing Help

About 453100 Sitezpan. ..

Index Thisindex displayshep items.
About Sitespan Selecting this menu item shows the version of Sitespan in use.

About AS8100 Sitespan |

AS58100 Sitezpan Equipment YWigw W37 [Build 4]

‘T Ajrzpan Metworks e € 2000
hithp: A A, airspan. com

Page 55 of 305



This Page Intentionally Blank

Page 56 of 305

ASB100Sitespan User Guide Version 3.7

605-0000-426

Draft Issue 6.0. Date 4/4/00

GSl 015




/ Sitespan User Guide Version 3.7
605-0000-426
| ﬁrspan GSl 016

\\\ Draft Issue 6.0. Date 4/4/00

NS

SERVER MENU SYSTEM

The Server menu opening screen allows the user to see which Equipment Views are
connected to the server.

ASE100 Sitezpan Server M= E3
File Edit “iew Help
& 2 Tﬁ.’|
Client Mame Connect Time Gueued Operations
AIRO01703 0 days, 00:00:24 1] —l
4] | o
Ready o

The Equipment Views currently accessing the site are listed under Client Name, showing
the time that they connected to the system. and any queued operations waiting to be
executed. The operative at the Server may wish to contact these sites and give advanced
warning if the server isto be taken down and to ensure that all queued operations are
compl ete.

The File Menu contains Exit.

Exit |

The Edit M enu does not have any function in this version of Sitespan

Undo Chil+2

Cut  Chil+=
Copy  Chl+C
Pazte Chil+t

The View M enu gives options to turn the toolbar/status bar on/off

v Toolbar |
v Statuz Bar
Toolbar This menu item selects and desdlects the toolbar. The tool bar
provides “shortcuts’ to some of the more frequently used Windows and
Sitespan functions. If atool bar button is dimmed, then that button is not
available to the current active window.
StatusBar This menu item selects and desel ects the Status Bar. The Status Bar

is displayed along the bottom of the screen and displays context sensitive help
messages. Av' shows that the Status Bar is selected and is visible on the screen.
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The Help Menu provides information Sitespan Server version number information.

About Server Selecting this menu item shows the version of Sitespan in use.

About Server. .. |

About Server E |

Sitespan Server W3.7 [Build 4]

ET Airzpan Netwarks [ne. 2 2000

hittp: / Aanana, airzparn, com
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SELECTING VIEWS

1. Todisplay aview of a Server, Site, Shelf, Card or ST, select Object List from the
View menu

Wi
v Toolbar
v Statuz Bar

Elerment Yigw

Subszcribers

Hiztory

Alarms

Active Alarmz

Object List... [%
Update Server Files
Tree Yiew

Sublags...

Map View

2. Sdect therequired object from thelist. Click OK

Select View Variant Ed
Wiew Type | oK. . I
[Obiect Lis - ’I"* |

ance

W ariantz

Server -

Site Few ariant... |
Rack,

Shelt :

N B T [elete Wariant. . |
IS0 Phone List Ent

A1 one st B j [ mdifi Eriart., |

3. Theobject list isdisplayed. Place the cursor over theitem on thelist and double click
the mouse. If morethen oneview is available of the object a View Child Window is
displayed with the alternatives, select aternative and click OK. The window related
to that chosen object is displayed. The exception to thisrule isthe rack views, these
are displayed by placing the mouse cursor over the Ste in the Ste Object List and
double clicking the mouse to display the racks on the selected site.

4. Other Views are available by selection from the view menu.
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@I The Alarm View can be displayed by clicking the Alarm View button at any
time.

o
IT—IT he Subscriber View may be chosen from the toolbar by clicking the Subscriber

View button at any time. This displays the Fixed Assignment Network Subscribers.

ILICreate Subscriber By clicking this toolbar button when in Subscriber View a

subscriber may be created on a Fixed Assignment System.

Page 60 of 305




AS8100 Sitespan User Guide Version 3.7

D\

Airspan

605-0000-426

Draft Issue 6.0. Date 4/4/00

GSl 018

0

MANAGING A NETWORK OF SERVER SITES

When managing large networks it is sometimes impractical to view the whole system as
graphical elements. In order to be able to effectively manage multiple sites the Equi pment
View should as much asis practical be set up as object lists

Object lists allow more information to be displayed on the screen than would be available

in GUI views.

Figure 1-1 shows an Equipment View set up as object lists.

" Sitespan Equipment View |- (O] =]
File Edit View Tools Window Help

=Rs| || |

Network[Object List.Server] [_ (O] %]

Mame [ Deseription

Metwork UKTPC3181 Mame LUIKTPC3181, Netwark Fixed, Connected, Ready J
Metwork UK PC3562 Mame UK1PC3562, Mebwork Fixed, Unconnected, Unknown

L »
& Network[Object List. Site] - o] x|

Mame

Description

Mletwark: UKAPC3181:5itel
Metwork; UKI1PC3181.5ite1
Mletwork: UKAPC3181:Site2
[« |

& Network[Object List.Rack]

Marme Sited, 1d 0, Ob Create, Long 0.000000, Lat 0.000000
Mame Site1, 1d 1, Ob Create, Long 0.000000, Lat 0.000000
Mame Site?, Id 2, Oh Create, Long 0.000000, Lat 0.000000

"l L

_|ojx

Mame

Description

Metiwork: LK1 PC3181:Site0:Alrspan Rlse 3
Hetwork UK1PC3181:Site:Airspan Rlse 2
Metiwork: LK1 PC3181:Site0:Litespan

L

zv Metwork[0Object List 5helf]

Airspan 60 Rel.3 Rack, Mumber 1
Airspan B0 Rel.2 Rack, Number 2
Litespan 120 Rack, Mumber 3

Mame

Description

Metwark:UK1PC3181:8iteD:Airspan Rlse 3:Comhiner
Metwork:UK1PC3181:8ited:Airspan Rlse 3:DassEhelf
Metwork: UKAPC3181:Site0:Airspan Rlse 2:Comhbiner

Metwork:UK1PC3181:5ited:Arspan Rlse 2:DassShelf
A

Airspan B0 Cambiner Shelf
Airspan 60 DASE Shelf, Mumber 1, COM2 | Connected
Airspan 60 Combiner Shelf

Alrspan B0 DASS Shelf, Murnber 1, COMO Unavailable, Unconnected

Faor Help, press F1

MLI

Selecting a particular object will allow the use of the menu to edit the properties of the
object, delete the object or create a child element.

Double Click the mouse on an object listed in the Network[Object List, Server] window
will display the queued operations at the Server. Thiswill give an indication of how
current the Equipment View display is.

Double Click the mouse on an object listed in the Network[Object List, Site] window and

the GUI Site View will be displayed.
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Double Click the mouse on an object listed in the Network[Object List, Shelf] window
and the GUI Shelf View will be displayed.

Any alarmsthat arise cause the text of all the parent objects that are associated with that
event to also show an alarm state by turning red.

Any alarms on the system are always shown on the Network[Object List, Server] View. It
istherefore possible to effectively monitor many server sites at the same time by
displaying the Network[Object List, Server] View.

Other Network Object Lists may also be displayed, as space permits, to make it quicker
to locate objects and alarm events. Site, rack and shelf lists can be displayed, child views
beyond this are probably impractical to display aslists and can be displayed as GUIs
when it is necessary to view a specific shelf.

Totrace an alarm select the shelf displaying the alarm state and double click to produce
GUI view. Then select the shelf item displaying the alarm state and double click the
mouse to display the Card View.
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USING WINDOWSNT RASTO CONNECT
SITESPAN CLIENT AND SERVER
Overview

Sitespan is a client/server application capable of utilising the Remote Access
Service (RAS) and Dial-Up Networking features supported in Windows NT. For
the purposes of this document only and the potential complexity of Windows NT
the following limitations apply:

Connection between the Client and Server applicationsis assumed to
be viaa standard dial up modem.

Installation of the modem itself has already been completed.

The Sitespan applications are installed.

Both the“Client” and “Server” computers have Windows NT
Workstation V4.0 installed. Other versions may be used but these are
not detailed within this document.

NOTE: During the operations outlined in this document it will be necessary to re-
start the system more than once. Ensure that al data is backed up before
commencing any work on the system. Whilst every effort has been taken to
ensure that this document is accurate, no responsibility is accepted or implied for
any loss or damage to equipment and/or data affected either directly or indirectly
by procedures outlined herein.

About Windows NT RAS

Windows NT Remote Access Service (RAS) is a standard component from
Microsoft but it is not installed by default. RAS is designed to connect remote or
mobile systems to corporate networks and is a dial-up networking product. It is
not designed to provide “remote control” functions but to allow the sharing of
files and data between systems. RAS includes two main components, Client and
Server.

Client
The RAS Client allows a system to dial-in to a remote system or server.

Ser ver

The RAS Server can permit up to 256 remote clientsto dial in and can be
configured to provide access to an entire network or restrict access to the
RAS server only.

For the Sitespan application the RAS Server isusually installed on a stand-alone
system (the “Server” computer”).
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When a connection is established between the Server and Client machines,
Sitespan downloads the entire object mode (status and value of all attributes) of
the connected equipment to the Client. Whenever any changes occur in the
equipment (alarm or configuration) Sitespan updates the Client with the changes.

Theinitial download should take approximately 1 minute for a system connected
to 16 modem shelves and at a rate of 9.6 kbits/s. Once downloaded, changes are
updated almost immediately providing a smooth graphical user interface.

Requirements
The following items are the required minimum in order to setup NT RAS:

Windows NT Setup files. These can be on the local hard drive or the
CDROM (version dependant upon the installation)

2 off 3.5” blank diskette.

Login Name and Password with Administrative rights,

Access Rights

In order to complete the operations outlined below, it will be necessary to log into
Windows NT with a name and password with Administrative rights.

Emer gency Repair Disk
Before carrying out any changes to the existing setup of a Windows NT system, it
is strongly recommended that a repair disk be created. This can be achieved by
inserting a blank formatted floppy disk into drive A: and selecting, Start/Run type
“RDISK” and then click OK

The dialogue shown below will be presented. Click on Create Repair Disk

r& Repair Dizk Utility

Thiz utility updates the repair information saved when pou installed the system, and
creates an Emergency Bepair dizk. The repair infarmation iz uzed to recaver a
bootable zpztem in case of failure. This utility zhould not be uzed as a backup tool.

Create Repair Dizk E xit | Help |

Figure 17: Using RDISK to Create an Emergency Repair Disk

Labd the disk “Emergency Repair Disk - Original Config”, write protect it by
diding the corner tab and store safely. Y ou may need this disk in the event of a
device conflict preventing the system from working correctly.
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Server Components

This section covers al components required on the “server” machine (thisisthe
computer connected to the equipment).
Installing RAS on the* Server”

1. Sedlect Sart, Settings, Control Panel. “Double Click” the Network icon on Control
Panel.

B4 Control Panel =] E3
File Edit “iew Help
L6l T - |
Forts e,
Optiors Metwork [viewing mode] K E3

Identification  Services | F'ru:utu:u:u:ulsl .-’-'-.daptersl

MNetwark Services:

Multimedia Metwiork, =
Cormpiter Browwser

MetBI0S Interface

A = Remote Access Service |
1 I RPC Configuration

|Ennfigures nebwork, hardware ai Server
Workztation

Sddl. | Hemowe Eraperties,.. [Ipdate

Dezcription:
Enables uzers to work offsite as though connected directly to a
netwark.

Cloze I Fancel

Figure 18: The Network Control Dialogue
2. Sdlect the Services tab.
3. Click Add and salect Remote Access Service from thelist.

4. You will be prompted for the location of the Windows NT setup files. Enter this
information and the setup routine will load the necessary files.

5. Oncethefiles are loaded the system will take you through the logical steps of RAS
setup. Firstly you will be asked to specify which modem (if you have more than one)
you wish to use for RAS then select Configure and select “Receive callsonly”.

6. Select OK

7. Sdlect Network
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8. Typically, you should only need to select NetBEUI
9. Select OK

10. Sdlect Continue

RAS should now be install ed.

Network I dentification

The Identification tab (located in Settings, Control Panel, Network) provides information
on the Computer Name and Workgroup associated with the network. The Computer
Name here on the “server” system is used by Sitespan for identification. It isimportant
that thisis unique. The Sitespan Client requires this namein order to connect to the
correct Sitespan Server.

The Workgroup name should be the same for the “Client” and “Server” machines. The
default Workgroup is“ WORKGROUP”.

Installing MS Loopback Adapter

The MS loopback adapter should only be installed on the computer that is going to be the
Sitespan Server PC. It alows a remote machine, connecting via RAS, to see the Server
identified in the Network Neighbourhood window. It is not essential to the function of
Sitespan Client/Server set-up.

1. From the Network window select the Adapterstab. If “ MS Loopback Adapter” is not
listed then follow the instructions bel ow.

2. Select Add

3. Scrall down thelist and highlight the MS Loopback Adapter as shown below and
select OK

4. You will beagain prompted for the location of the installation files, enter the required
information and select OK

5. Accept the default Frame Type by selecting OK
6. Thefinal step isto select Close

7. The system will now re-organise bindings for network operation. If TCP/IP protocol
isinstalled additional information may be requested.

8. When complete a system message requests arestart. Select Yes

9. The system should now shut down and re-start automatically. If it does not re-start
after 5 minutes, try switching off manually for 10 seconds and then turn it on again.
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User Names

It isimportant that the user names that are going to be used on the Sitespan Server
computer are also registered on the Sitespan Client machine. It is also important to note
that the passwords must also match for each user on both machines. For thisreason
ensure that the option to force a new user to change their password on initial login is not
checked. See DLP-001

Each user that islikely to dial in from the Client to the Server must also be granted Dial-
In access rights on the Server machine.

RAS Server

On the Sitespan server machine only, ensure that the Remote Access Server is running.
To do this select Remote Access Admin (Start/Programs/Administrative ToolsRemote
Access Admin)

If a RAS server is not running then go to the Services applet in the Control Pand and
attempt to start it here. Ensure that Startup parameter is set to Automatic. If it failsto start
look in the Event Viewer for reasons for this.

“Remote Client” Setup

This section details the procedure for the Client setup. RAS should already be installed. If
it is not then follow the procedure described above. Y ou should note however that the
modem should be setup for “Dial Out”. To set the modem. Start,/Settings/Control
Panel/Network/Services/Remote Access/Properties/ Configure/Dial Out Only/OK

Dial-up Networking

The remote Server machine needs to entered asa dial up system. To do this start Dial-Up
Networking from the * My Computer” icon on the desktop and enter the name of the
machine running Sitespan Server. The name can be found under Network in the Control
Pandl. It isimportant that this name is entered accurately. Entering therest of the datais
assisted by Windows NT itself, prompting you for the telephone number etc. See DLP-
003

Using Sitespan Client for the First Time

Remember to ensure that the user name and password you are using must be registered on
the Sitespan Server” machine and the current login name and password currently logged
in here must be registered on the Client machine. See DLP-005
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Troubleshooting
Listed below are the most common problems experienced and their possible

Causes.
Symptom Probable Cause

1 The server status Check that the User Name currently logged
shows Connected onto the remote server are registered on the
and Downloading local workstation/server
but nothing happens

Verify that the protocols are installed
correctly

Check that the Server serviceis running on
the Client machine.

2 The system responds  Ensure that the remote Sitespan Server
with “Cannot application isrunning. Install Sitespan
connect to Server...”  Server in the Startup group on the server

machine.

3 If theremote Server  Ensure that the RAS system has started
failsto Answer the  properly on the server machine.
call

4 The Remote system  Ensure that the user name and password
answers but used to login isregistered on the server
disconnects almost machine.
straight away

Try to manually dial the server using “Dial
up Networking”. This sometime provides
additional dialogues which may assist with
diagnosing the problem.
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NOTESON USING DETAIL LEVEL PROCEDURES

1. Thissection explainsthe use of the Detail Level Procedures (DLP)

2. The DLPs are organised into sections relating to the equipment being worked on.
Inevitably there are procedures that bridge between equipment and references may
often be made to proceduresin other sections. Asfar as possible the procedures are
designed so that the procedures follow in alogical order through the processes of
configuring and managing a network.

3. The DLPs are sectioned as follows.

51-100

101-200

Use

General AS8100 Sitespan procedures and procedures common to all
variants

ASA000 Fixed Assignment specific procedures

ASA000 Demand Assignment specific procedures

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SET-UP USER ACCOUNTSAND DIAL-IN ACCESSRIGHTS

This procedureisfor the both the Server and Equipment View PCs. The Remote Access Server
(RAYS) utilities need to be installed on the Server PC. This procedure gives users on other
Sitespan Equipment View stations permission to access the Server and vice versa. Every user
must have an account on the Server Machine registering the same name and password as that on
the Equipment View machine. Every user must have an account on the Equipment View
registering the same name and password as that on the Server.

STEP PROCEDURE

At Server

1. Each client wishing to access the server needs to have an account created regardless of
whether they are on afixed or dial-up network. When the Equipment View accesses the
Server, Sitespan automatically forwards the User ID and the Password of the Equipment
View Machine to gain access.

2. Select the User Manager, from Sart. Programs, Administrative Tools to set up an account
for an Equipment View Machine.

Administrative Toolz [Common]  * Backup
- g Dizk. Adrninistrator
Event Viewer
ﬁ Perfarmnance Maonitor
_% Remote Access Admin
€ User Manager
Q‘ whndowes MT Diaghostics

3. From the User menu select New User.

! Uzer Manager [j=] E3

Uzer

Mew Uszer...
Mew Local Group...

Copy.... Fa
Delete Del
Rename...

Properties. .. Enter
E it Alk+F4
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4. Enter details of the Equipment View Account in the New User window. The User Name and
the Password must be the Equipment View Machine. Click Help Button on the New User

window for more details.

Mew User

Uzernarne: |

Full 1 ame:

Dezcription:

Pazsword:

LConfirm
Fazzword:

¥ Lser Must Change Password at Mest Logon
[ User Cannot Change Pazsword
[ Pazzword Mever Expires

[ Account Dizabled

e =, ‘

Groupz

G

Profile Djalin

]
Cancel

Help

dilf],

5. Create a set of accountsto support all of the likely Sitespan users of the server by repeating
steps 3&4. Further details of this procedure can be found in the Windows NT Workstation

Installation Guide and on the NT help menus.
At Equipment View PC

6. Each Server wishing to access the Equipment View Client needs to have an account created
regardless of whether they are on afixed or dial up network. When the Equipment View
accesses the Server, Sitespan automatically forwards the User 1D and the Password of the
Equipment View Machine to gain access. In order that the Server can access the Equipment

View it also needs to have an account on the Equipment View

7. Sdect the User Manager, from Sart, Programs, Administrative Tools, to set up an account

for Server Machine.

Administrative Toolks [Common]  » G Backup

B Fr;% Dizk. Adrninistrator
Event Viewer
% Perfarmnance Maonitor
_% Remote Access Admin

Bi% Uzer Manager

-«@é. whndowes MT Diaghostics
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8. From the User menu select New User.

Lzer
Mew User...
Mew Local Group...
Copy... Fa
Delete Del
Bename...
Properties... Enter
E xit Alt+F4

9. Enter details of the Equipment View Account in the New User window. The User Name and
the Password must be the Server Machine. Click Help Button on the New User window for
more details.

Mew User
Usemname:  |Server]
Fuill M arne: |Beu:|f|:|nt Lakes Cancel
Description; |Test Site Help
Pazzwaord: i
Corfimn ——

Pazzward: | 1

¥ Uszer Must Change Password at Mest Logon
[ User Cannot Change Password

[ Pazsword Mever Expires

[ Account Dizabled

£

Groups

G

Frofile Dijalin

:Flig ‘

10. Create a set of accounts to support all of the likely Servers to be accessed by the Equipment
View by repeating steps 8 & 9. Further details of this procedure can be found in the
Windows NT Workstation Installation Guide and on the NT help menu’s.

Tocreate dial up accessfor remote Equipment Views at the server.

1. After installing Remote Access Service software on a server, Remote Access permissions
must be granted to Sitespan Equipment View users before they try to connect through
Remote Access client software. Without permission, users cannot successfully connect to the
Remote Access computer even if the Remote Access client software has been installed on
their computers.

2. Start the Administrators utility by clicking Remote Access Admin from Start, Programs,
Administrative Tools.
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3. Set the focus on the server or domain for which permissions are to be set. For detailed
instructions on setting the focus, Click the Remote Access Admin on-line Help.

4. From the Users menu, choose Permissions.

5. The Remote Access Permissions dialog box appears. For further instructions, click the Help
button on the dialog box.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING A PHONE BOOK FOR THE EQUIPMENT VIEW

Before the Equipment View can connect to and access remote Servers a Dial-Up
Networking entry must be recorded for each connection required. Once the entry has
been recorded Windows NT manages the connection to the Server.

STEP PROCEDURE

1. Double-click the My Computer icon on the desktop and the double-click the Dial-Up
Networking icon.

H My Computer =l

File Edit ‘“iew Help

o s N

Control Panel Frinters Dial-Up
Metworking

1 object(z] selected

Select New from the Dial-up Networking Window

% Dial-Up Metworking

Fhonebook enty to dial;
|§h-1_l,lDiaIL|pSewer ﬂ

Hew... More - |

FPhone nurber presisw:

Dialing from:

| Mew Location j

Location....

Dial | i |
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2. Enter relevant details of the remote site to be accessed using the New phonebook entry
wizard fields. Select Next and enter the information as requested by the wizard.

Mew Phonebook Entry Wizard

network.

Mame the new phonebook entny:

Dial-Up Metworking connects you o remote networks
uzing your modem, [SOM, ar other WAk adapter. This
wizard helps vou create a phonebook, entry that stores
the zettings needed to connect to a particular remaote

|M_I,IDiaIL| pSerer?

| Hest > |

[ | know all about phonebook entries and
would rather edit the properties directly

Cancel

3. The Dial-Up Networking screen now displays the phonebook entry. To make more entries

repeat from step 2.

E!'ﬁ Dial-Up MNetworking

Fhonebook, enty to dial;

INODE 120 RID -]
Hew... More = |

Fhone number preyis:

| 1234567890

Dialing From:

|New Location ﬂ

Location.... |

Dial | P |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MONITORING A MODEM CONNECTION TO A SERVER

Use this procedure to set up an onscreen monitor to indicate the performance of a modem
connection. This procedure is optional and a connection is made even if the monitor isnot in
operation.

STEP PROCEDURE

1. Sdect the Control Pand from Start, Settings Folder in the Program Manager.

Control Panel Hi=]
Eile Edt %iew Help

B 4 & mm
Dhal-Up Dizplay Find Fast Fonts |nternet F.eyboard
b anitar j

konitors status of dial-up connections

2. Select the Dial-Up Monitor icon to open the Remote Access window.

™= Dial-Up Networking Monitor 7 x|
Status l Surmmary ] Freferences ]
Dievice: | Mull Modem 9600 (COM1] |
Condition: | nactive
v _ T _I
Device response: |L|nava||a|:|le =i
Line bpz: 0 Duration: (0 00 00
Device statistics
Bytes in: ] Bytes out: ]
Connection statistics
Bytes in; ] Buytes out: ]
Framesz in: ] Framez out: 0
Compreszion in: 0%  Compreszion out: 0%
Device emors
CRC: 1] Framing: 1]
Timeout; 0 Hardware overunz: 0
Alignmment; ] Buffer overuns: ]
Ok | Cancel | |

3. Set the modem to monitor by selecting from the device list
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STARTING AS8100 SITESPAN

Use this procedure to log on to the system and to gain user access to the Sitespan system.
This procedure is dependent on the completion of the procedures GSI-009, 010, 011; and
012.

STEP PROCEDURE

1. The Sitespan programs may be accessed from Start, Programs, Sitespan.

i
-f Server
I Signaling File Editor
g Trans

2. If the PCisthe Sitespan Server, run the server software by selecting the Sitespan Server. A

& icon should appear at the system tray in the bottom of the screen. If the server isto be
accessed from dial-up links ensure users have been given accounts and access rights
(procedure DLP-002) before continuing.

3. Torun the Equipment View software select the Sitespan Client. The Sitespan Equipment
View startup screen should appear.

4. When running the Equipment View for thefirst timeit is recommended that the file
Template.SSD is used to set the screen. Thisfileis provided by the set-up program and is
placed in the directory where Sitespan isinstalled. It is selected from the File menu.

File ,
Mew Ctrl+M
Open... Ctrl+0
Print Setup...

1 Template. z=d

E it

5. Note: Only one copy of the Equipment View software may run and any attempt to run
another Equipment View invokes the following message:

AS8100 Sitespan ]|

& CSiteSpandpp - There iz already an E quipment Wiew executing

STOP. THISPROCEDURE HASBEEN COMPLETED.
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AS8100 SITESPAN VERSION.

Use this procedure to view version and copyright information about Sitespan Software.

STEP PROCEDURE

1. From the Help menu choose About Stespan.

Help

Index
Using Help

Ahout Sitespan...

5

2. A window details version and copyright information about software.

About AS8100 Sitespan |

AS58100 Sitezpan Equipment YWigw W37 [Build 4]

‘T Ajrzpan Metworks e € 2000
hithp: A A, airspan. com

3. Click the“OK” button to close the display.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SETTING UP THE AS8100 SITESPAN DISPLAY OPTIONS

Use this procedure to customise some the screen display parameters of the Sitespan

software.

STEP

PROCEDURE

1. From the Tools drop-down menu select Colours. This produces the Edit Colour dial ogue box.

2. Select the property to be changed from the Property list by selecting with the mouse.

Edit Colours

Froperty

Alarrn Clear =]
Faulty

In Service J
Inkermittent Alarms

Lacked

Mormal Text

R areivine & Hanbine j
Sample

LChange... |

| Cloze |

3. The Properties which can be colour coded are:

Absent -
Alarm Active -
Faulty -

In Service -
Locked -

Receiving Attention -
Shelf Not Connected-

Shelf View Highlight-

Shelf View Text-
Spare -

Under Test -
Alarm Clear

I nter mittent Alarms

LED Activity On
Nor mal Text

Page 83 of 305

Indicates absence of resourcein Shelf, Card and ST Views.
Appearsin Site and Shelf Views.

Fault Condition detected.

Indicates which resource items arein service in all views.
Indicates that the resource in locked against use.

Appears when alarm condition has been acknowledged.

This colour appearsin the border of any shelf not currently in
contact with Sitespan.

The sdlected text in Shelf View.
Thenormal text in Shef View.
Resource not in use.

Item not available -under test.
Previous alarm is cleared
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4. Click on Change and the colour chart appears.

B azic colors:

BT EMEEN
B FEETEN
HEMEENEEEN
ENEEEENEN
BECCET ET

Cuztom colors:

| W NN N W
I

Drefine Custom Colors =3 |

(] | Cancel ]

5. Thecurrent color isindicated by a dotted rectangle round the color sample and is changed by
clicking on a new color sample. Sixteen further colors can be customized by selecting Define
Custom Colours in the Colour dialogue box and adding them to the Custom Colours sample
boxes in the Colour dialogue box.

6. Click the OK button. The Edit Colour s dialogue box shows the amended color in the
“sample’ box. Click on the Close button to initiate change and return to the menu bar.

Switching the Toolbar and Status bar on or off.

1. Seect the View drop-down menu and click Toolbar on the menu to toggle toolbar on or off.
The Toolbar provides shortcuts to certain menu functions. Similarly click Status Bar on the
menu to toggle status bar on or off. The Status Bar provides messages as to the functions of
an object when the mouse pointer isover it. A v indicates bar ison.

Wi
v Toolbar
v Statuz Bar
Subzcribers
° Sitezpan Equipment View - [Network[Object___ [lj[=] E3
}E’- File Edit “iew Tool: “Window Help - | ﬂ
Obiject List... ==1E] |Th| | Toolbar
b ap View Marne
Tree Yiew 1 2
Sublogs... For Help, press F1 Status Bar

STOP. THISPROCEDURE HASBEEN COMPLETED.
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FILE OPEN

Use this procedure to access an existing network.

STEP PROCEDURE

1. From the File menu, choose Open or click the E"W| on the toolbar.

open HH|
Lookjn | =3 ASE100 Skespan V37 = =3

1703.22d
Template. z2d

File narme: || Open I
Filzs af type: ISitespan Docs [*.22d] j Cancel |

2. Sdect the appropriate Drive and Directory and type in File name or select file by clicking on
the relevant file name. Click the OK button to initiate retrieval. Sitespan database files have
the extension .ssd.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE A SERVER CONNECTION RECORD WITH THE
EQUIPMENT VIEW

Before Equipment View can connect to the Server arecord giving the connection details of the
server must be created at the Equipment View. Use this procedure to set up an Equipment View
PC in preparation to connect to a Server.

STEP PROCEDURE

1. Connect to Sitespan Equipment View. See DLP-005.

2. With the Sitespan Equipment View opening screen displayed choose Create Server from the
Edit Menu.

Edit
Undo Chrl+Z

Create Server [%

3. Sdect the server in the Object List Server. In the Edit Server Properties window enter the
server name into the Remote Machine Name box. Click the mouse in the box to produce a
flashing cursor and enter machine name. The remote machine name must be exactly the same
asthat of the Server machine or the Equipment View will be unable to connect.

Edit Server Properties |

Hemote Machine Hame

|
' Fixed Metwork Cancel |

" Dial Up Netwaork

4. Select the Fixed Network radio button if the connection is on the same machine or to a
persistent network (e.g. Ethernet). Select Dial-up Network if there is aremote access (RAS)
network connected. (note: ensure that RAS is executing on the server machine and that there
isan entry in the RAS Phonebook with the correct phone number of the Server Machine and
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an entry name identical to the one entered in the Remote Machine Name edit box of the
server properties dialogue. (See DLP-003).

5. Click OK.
6. The Network[Object List, Server] window displays a valid record for the nominated server.

Network[Object List Server] [_ O]

MHame Description
I | =
[« 3

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE SITE

A Siteisamanaged collection of Sitespan Network Elements. In practice a Site consists of
several Racks of differing types, usually co-located, and managed by one Sitespan Server
machine. Each Site has a unique name within its Server peer group and can be displayed in a

separate window with the Equipment View. To create a Site a connection to a Server machine a
must already be established.

STEP PROCEDURE

1. With the Sitespan Equipment View opening screen displayed select server from the Server
Object List and choose Connect Server from the Edit Menu to connect to the server.

2. From the Edit Menu select Create Ste. A default siteis loaded into the Network[Object List,
Site] window.

Edit
Undo Chrl+Z

Server Properties. ..

Create Server
Create Site
Delete Server... l}g

Dizconnect Server

3. Sdlect the newly created site by clicking the field in the Network[Object List, Site] window.

Metwork[Object List Site] M=l E3
Hame Ibgescriptinn
[ -
! o
_I_I Edit Child %
LCreate Server
LCreate Child Element...
Delete Site...
Site Wiew
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4. Click the right mouse button or use the Edit Menu and select Site Properties. to produce the
Edit Site Properties Window.

Edit Site Properties

X
Mame
IBase Station 1|
Address ﬂl
A T o |
Arynuhere Help
s ¥
{100 |40

5. Click the mouse in the Name box to produce a flashing cursor. Enter the site name into the
box. Entering the information in the Address, X and Y map view co-ordinates are optional.
For further details on map view see DLP-029.

6. Press¢ onthe Keyboard or click OK toinitiate changes. The following screen appears with
Site details displayed.

Hetwork[Object List Site] M= E3
Harme Ibgescriptinn

| | _I

| _"|_I

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DELETING SITES

Use this procedure to delete Sites that have previously been created and are not needed.
The Equipment View must be connected to the Server to perform a deletion.

STEP PROCEDURE

1. Select the Network [Object List, Site] window. From the list of sites click the mouse on the
siteto be deleted. The Site selected is highlighted in blue. Click the right mouse button and
select Delete Ste from the drop menu.

Metwork[Object List,Site] [_ O]

Harme Ibgescriptinn

Metwork: AIRDD1703:Base Station 1 Mame Base Station 1, 1d 48, Oh Create, Address Any Tawn, L;l
I |

Site Properties. ..
Edit Child

Create Server
Create Child Element. ..

p I I Site Wiew LI—I

2. A confirmation window is displayed. Click the ‘OK’ button to initiate deletion.

ASE100 Sitezpan Ed

& 0K to delete Site1?
Eanceq

3. Theobject list is displayed with the site removed.

Network[Object List,Site] [_ |O]
Hame Ibgescriptinn
| =

i o

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CONNECT TO A SERVER

The Server manages the equipment shelves connected to it. It must connect to an Equipment
View to accept user commands and report system status. Once the Remote Access (RAS) is
configured access to the Server is managed by Windows NT and initiated from within the
Equipment View. In practice the Equipment View probably manages a number of Servers. A
Server can also connect to a number of Equipment views simultaneoudly.

STEP PROCEDURE

1. From the Network[Object, List, Server] highlight the server to be connected by clicking the

mouse on the server record. If thereisnot a Server record present use the procedure outlined
in DLP-009. to create a connection record.

From the Edit Menu select Connect Server. This Equipment View attempts to contact the
specified Server machine. If the connection iswith a modem it may take a few seconds as the
user name and password must be authenticated on the remote machine before access can be
granted.

Undo Clrl+Z

Bedo Chrl

Cut Chrl+

Copy Chrl+C

Faste Chrl+4f

Server Properties. ..

Child...

Create Server

Create Site MNetwork[Dbject List.Server] =]

Delete Server... —
Kame Description

Beceiving Attention | | =
4 I I 3

Dizconnect Server l%

If the connection is successful the Network [Object List, Server] Window shows the server as
connected.

Metwork[Object List.Server] M=l E3
Harme |Qescriptinn

'M E

The server now downloads it’s current state to the Equipment View and on completion of

thistask isready to receive further instructions from the Equipment View. If attempts are

made to use the Equipment View while the Server is downloading the warning messageis
given.
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If the connection is unsuccessful a message box is displayed indicating ‘ Failed to connect to
nominated server’. In this case check the details entered in the server properties dialogue
box and that the RAS password and connection details agree for both the Equipment View

and the Server.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DISCONNECT FROM A SERVER

Use this procedure to disconnect from a server. The server continues to monitor the AS4000 and
updates the Equipment View when it is re-connected.

STEP

PROCEDURE

1. From the Network[Object, List, Server] select the server to be disconnected.

2. From the Edit Menu sl ect Disconnect Server.

Undo Clrl+Z
Bedo Chrl+&,
Cut Chrl+
Copy Chrl+C
Paste Chrl+4f

Server Properties. ..

Child...

Create Server
Create Site
Delete Server...

Beceiving Attention
Connect Server

Metwork[Object List,5erver] [_ (O]

Blarme Igescriptiun

'M £

M

3. The Network [Object List, Server] Window shows the server as unconnected.

Network[Object List,Server] [_ O]

Marme Igeacriptinn

e

_*llﬁ

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE AN A3000 RACK

Use this procedure to create an ASA000 Rack from the Network Object List view.
Racks can also be created from the Site View.

STEP PROCEDURE

1. Ensurethat the site has been created and this view appears on screen click the mouse
in the Ste window to highlight it as the active window.

Network[Object List Site] _ (O] x|
Ibﬂame Igeacriptinn
HetworkcAlRO01 703 Base Station 1 o S0 T T8, Ob Create, Address Any Town 1—
Site Properties... x
| 4 | Edit Child o
Create Server
LCreate Child Element...
Delete Site... D\"
Site Wiew

2. Sdect the site using the mouse. When sdlected the site is highlighted in blue.
3. Click right mouse button to drop menu or from the Menu Bar select Edit.
4. Select Create Child Element.

5. Sdect therequired rack type from the options window then click the OK button.

Create Child Ed
Select the child type to create DKF:' I

454000 Rel 2 [FA) Rack

454000 Rel 2 [FA) Rack Cancel
A54000 [DA] CT Rack, :

454000 [DA) AC Rack,
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6. A rack isshown in Site View with the RF Combiner shelf highlighted as active.

" Network:A___ =]

A54000 (DA CT B ack Properties...
Shelf Properties. !

Create Rack
Create AS4000 [DA] CT Madem Shelf
Delete Element...

Racki Element g

o | 51

7. Select ashdf by pointing at the shelf with the mouse and clicking the | eft button.
From the Edit menu select ASA000 (rack type) Rack Properties. The Edit Rack

Properties window is displayed. Enter the rack namein the box and click on the OK
button to edit the desired rack.

Edit Rack Properties

Mame

[DacTi

Cancel

dii

Help

8. Therack appears with rack name inserted.

| Hetwork:A___ =] B4

.
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9. Additional racks may be added by selecting Edit, choosing Create Rack and repeat
from step 5. The view below shows the different rack types that can be created.

" Metwork:AIRDD1703:Basze Station 1 M= E3
|

04 CT 1 04 AC FACT Rel 2 FA -

<] | vl 4

10. Racks may also be viewed in an object list. See DLP-027 View Object Lists and
GSI-018 Managing Larger Networks.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DELETING AS4000 RACKS

Use this procedure to delete AS4000 racks that have previously been created and
are not needed. The Equipment View must be connected to the Server to perform
adeletion.

STEP PROCEDURE

1. From the View menu, select Object List.

Wi
v Toolbar
v Statuz Bar

Elerment Yigw

Subscribers

History

Alarmz

Active Alarms

Object List...

Update Server Files b\
Tree Yiew

Sublags...

Map View

2. The Slect View Variant window is displayed. Select Rack

Select View Variant Ed
Wiew Type | 0K |
[Obisst Lis o 8 |

ance
W ariantz
Semver -
Site Few Wariant... |
Rack
Shelf .
12DN Phore List [elete Wariant. . |
IS0 Phone List Ent
Al one st By ;I [ iy it |

3. The Network [Object List, Rack] window is displayed. Use the mouse to select the
Rack to be deleted. Click right mouse button and from the drop menu, select Delete
Airspan (rack type) Rack.
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Metwork[Object List.Rack] |_ (O] x|
Marme |Qescriptinn

Metwork:AIRODDTT03:Base Station 1:0A CT 1 AS4000 (DA CT Rack, Number;l
FetworkcAIRD01 Y03:Base Station 1:0AAC 1 AS4000 (DAY AC Rack, Humber
Metwork AIRODD1T03:Base Station 1:Fa CT2  AS54000 Rel 3 (FA) Rack, Mumbe

[Hetwark:AIRDO1 7O3:Base Statie~ 1Dl 2 EA - ASARAA DAl 2V EM Bac | Murmke
A54000 [FA] Back Properties. ..

Edit Child

Create Server =
| Create Child Element... LIJ

Delete 454000 [FA] Rack...

Element Ei;.-gv

4. A confirmation window is displayed. Click the‘OK’ button to initiate deletion.

AS8100 Sitezpan Ed

& 0K to delete Fiel 2 FA7

Cancel

H

5. The object list is displayed with the rack removed.

Metwork[Object List,Rack] [_ O]
Hame Igescriptinn

Metwork:AIRDO01703:Base Station 1:DACT 1 AS4000 (DAY CT Rack, Number;l
MetworkcAIRODDT T03:Base Station 1:04 AC 1 AS4000 (DAY AC Rack, Mumber
Metwork:AIRODD1T03:Base Station 1:Fa CT2  AS4000 Rel 3 (FA) Rack, Murmbe

w

af | »

STOP. THISPROCEDURE HASBEEN COMPLETED.
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GENERAL STATUSPOLL AND SELF TESTS

The Shelf Controller can initiate general status pollsto ensure that all the
information contained in the database is current. The general status poll isfor
Fixed Assigned systemsonly. It is good practiceto initiate a general status
poll before making any Sitespan measurements of the system. At power on
the Subscriber Terminal (ST) and AS4000 Central terminal (ACT) perform
self tests. The FRU's with self test facilities perform a self test and inform the
relevant [shelf] controller, which in turn passes the overall result of the self
test to the management system. The self tests can also be requested by the
management system from the Card View dialog boxes at any timethelineis
not in use.

STEP PROCEDURE
Status Palls
1. Select Card View for the Shelf Controller (FA only) on the shelf to be polled (see

Selecting Views, GSI-017).

2. Initiate a general status poll by clicking the mouse on the General Satus Pall
button.
=3 Metwork:MWINDETT:5Site1:Rack12:DaszsShelfl

Inventory Infarmation Alarms

Setial Mumbet: |

Currert FAA 0.0

Cither FAN oo Reset |

State: |EMPIS

Zelf Test
Zeneral Status Pall |
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Salf Tests

1. Select Card View for the desired card to be tested (see Selecting Views, GSI-017).

73 Metwork:UK1PC3181:Bedfont Lakes:Rackb:CasSh...

Inwertory Information Alarmz

Serial Mumber: |

Firmwware Code:

Ztate: |
{Sel Test!

Link Performance (BER

Diowenlink

Iglink
Reszet ST Wiew

2. Thefollowing Card Views provide a self test option

FA Analogue Card View.

FA Modem card View.

FA Terminating Unit View.

FA Shdf controller View.

FA ST View.

DA Terminating Unit View( DTU,CTU,XTU)

3. Click on the Salf Test button to initiate testing.

4. Thetest field indicates that the test istaking place by displaying ‘operating’ in the
test result box. Theresult of the test is displayed as:

Pass (Everything is OK).

No Result (A test result has not been passed back to the
Sitespan).

Fail (The unit has failed and needs replacing).

STOP. THISPROCEDURE HASBEEN COMPLETED.
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VIEW SYSTEM STATUSIN TREE VIEW

STEP PROCEDURE

1. From the View menu select Tree View

Wi
v Toolbar
v Statuz Bar

Subzcrbers

Object Lizt...

Map Yiew
Tree Yiew
Sublogs... L\\S

2. Thetreeview displays the system in a hierarchical order. Clicking the icon reveals

the child elements of that icon. A + in the box adjacent to the icon indicates that there
are child elements. When theicon is clicked the child e ements are revealed and the +
changestoa-. Clicking the - closesthe child dements and display the parent e ement
with a+. The name field shows the objects associated with the selected parent and
the description shows their status. When in Tree View the presence of Alarm
conditions are indicated by the colours of the variousicons. For example, an alarm
emanating from an ST changes the colour of that icon on the tree view to the colour
selected for that condition (in this case Red), and the e ements above the ST - Shelf,
Rack and Site also show the same colour. In the figure below the element showing the
alarm condition Poor BER isthe ST3, on CAS Shelf 2, in Rack2, in the Bedfont
Lakes Site - but all the elements listed are showing the same alarm condition colour.
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2 Metwork

RERERLN

- UKIPCE1ET
- g Bedfont Lakes
i

Fack 1
Rackz2

== Combiner

TributaryU nit
RfCard
AnalogueCard
todemCard] —
b odemCard2
todemCard3
todemCardd

b odemCards

M odemCarde
tademCard?

b odemCards
5T1

572

5T3

Rak

Mame Description
M etwork: UETPC3181 Bedfont Lakes: Rack2:CassShelf2:5T3 Fru, Present ﬂ
metwork UKTPC3181:Bedfont Lakes:RackZ:CasShelf2:5T4 Fru, Absent
metwork UK1PC3187 :Bedfont Lakes: Rack2:CasShelf2:5TS Fru, Absent
metwark KPP C3181 :Bedfont Lakes Rack2:CasShelf2:5Th Fru, Absent
metwork: UE1PC3181 :Bedfont Lakes: Rack2:CasShelf2:5T7 Fru, Absent
M etwork UEI1PC3181 Bedfont Lakes: Rack2:.CasShelf2:5T8 Fru, Absent
M etwork UE1PC3181 Bedfont Lakes: RackZ:CasShelf2:5TY Fru, Absent
M etwork: UETPC3181 Bedfont Lakes: Rack2:CasShelf2:5T10 Fru, Absent
metwork UKTPC3181 :Bedfont Lakes:RackZ:CasShelf2:5T11 Fru, Absent
Metwork KTPC3181 Bedfont Lakes:Rack?:CasShelf2:5T12 Fru, Absent
metwork KPP C3181 :Bedfont Lakes: Rack2:CasShelf2:5T13 Fru, Absent
Metwork UK1PC3131:Bedfont Lakes Rack2:CasShelf2:5T14 Fru, Absent |
M etwork: UE1PC3181 Bedfont Lakes: Rack2:CasShelf2:5T14 Fru, Absent
M etwork UE1PC3181 Bediont Lakes: Rack?:.CasShelf2:5TPsul  Fru, Present
M etwork: R PC3181 Bedfont Lakes: Rack2:CasShelf2:5TPsu2  Fru, Present
Metwork JKTPC3181 Bedfont Lakes:RackZ:CasShelf2:5TPsu3  Fru, Present
metwork UKTPC3181:Bedfont Lakes:RackZ:CasShelf2.5TPsud  Fru, Absent
metwork KPP C 3181 :Bedfont Lakes:Rack2:CasShelf2:STPzus  Fru, Absent

Metwork LT P31 81

sl

‘Bedfont Lakes:Rackz:CasShelf2:5TPsuf

Fru, Absent =

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MONITORING ALARMSUSING SITESPAN GUI VIEWS.

Use this procedure to | ocate the source of an alarm on the network.

STEP PROCEDURE

1. Fromthe NETWORK [Object, Site, List] select site to monitor.

2. From the View menu, select the Ste View. In Site View all cardsthat are installed and
operating normally are displayed in green. Any alarm condition causes the shelf that
isin receipt of that alarm condition be to displayed as red.

" Metwork:A__ =]

3. Double click the mouse on the shelf showing the alarmed state to get Shelf View or
from the View menu, select Airgpan 60 [ shelf type] Modem Shelf View to display the
shelf view.

4. Inthisview, the individual modules display the appropriate status colour. In the
illustration below (M2) on Modem Card 1 shows a different colour for an active
alarm.

5. Anintermittent alarm is shown as an amber clock icon and a permanent alarm as a
red clock icon.
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g Metwork-AIR001703:B ase Station 1:DA CT 1:5helf1

L
]
e
I=
el
m

6. Double clicking on the modul e showing the alarm state opens the Card View for that
module. Alternatively select the card then View, Modem View from the menu Card
View.

7. Looking at the Card View for the Shelf Controller gives further detail of the alarm

state. The alarm is shown asaa icon. A red icon indicates a permanent alarm and a
yellow icon an intermittent alarm. The Card View below shows that theShelf
controller has lost communication with Sitespan

— &larms

() Card Mismatch

TV Lost Comms With EM

(L) AC Shelf SwdlSwitch Failed
() CT Shelf SwlSwitch Failed
() Ctu SwdliSwitch Failed

(2 Clu SwollSwitch Failed

(2 Cas ¥ty SwolliSwitch Failed

(2 wa1 Miu SwolSwitch Failed [

8. Deails of alarm states and the interpretation for each card are given in the Operations
and Maintenance Guide 605-0000-451.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SELECTING CARD VIEWS

Individual cards may be viewed. Each Card View gives inventory information
and allow the operator to view and set parameters relevant to the particular card

being viewed. This procedure provides guidance on viewing a card from the GUI
shelf view. Alternatively the card could be displayed by double clicking the card

on an object list.

STEP PROCEDURE

1. Display the shelf containing the card to be viewed. (See GSI-017 Sdlecting Views).

Alternatively the card view can be displayed by clicking the object in Tree View.

2. Double click the mouse while pointing to the required card.
3. TheCard View should now be displayed.

4. Each Card View displays inventory information as follows:

Serial Number: Electronically retrieved from the card.
Firmware Code:

State; IS =In Service.
FLTY = Faulty.
ENP = Equipment not provided.
SP = Spare.
uT = Under test.
LK = Locked.

SEC = Secure (ST only)
5. AlarmsIconsare displayed as:

() ok

ﬁ‘? Intermittent Alarm (Amber).
W Permanent Alarm (Red).

i Receiving Attention (Tick).

6. Other information may appear in a specific Card View. For details see DLP-020 and

DLP-021.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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COMBINER SHELF CARD VIEWS

This procedure describes the Combiner Shelf Card Views.

STEP PROCEDURE

1. Display the Combiner Shelf. To display a view see GSI-017.

i Metwork-AIRDD1703:5ite2:Rack4:Com... [l=] B3

| Jagyduey J=mog
7 Jagdwey =g
+ Jagduey J=mog
7 Apddng Jmmog
¢ pddng Jsmog

Jadi BS10p Mo

Release 2

i Hetwork:AIR001 703:5ite2:R ack3: Combiner H=]

| Jopudn
& lojuapny

I NS4 PIED 44
Z NSAZPIED 41

Fixed Assignment
i Metwork-AIRDD1 703:Site?:Rac... =] E3

Demand Assignment
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2. Todisplay the Low Noise Amplifier LNA double click the mouse while pointing to
the card. The following information is displayed:

Inventory Information. See DLP-019 for details.
Alarms; FRU Fail.
725 Network:AIRD01703:5ite2:Rack3: Combiner:Low. .. [l[=] [E3

— & larms

—Inventory Information

Setial Number: || @ FRU Failed
Firmeasare Cocle: I Q.00

State: |ENF' =

3. Todisplay the Monitor card double click the mouse while pointing to the card. The
following information is displayed:

Inventory Information. See DLP-019 for details.
7= Metwork:AIRDOT __. H=] E3

—Inventary Infarmsation

Serial Mumber: ||
Firmwware Code: I 0.00

State: IENF' =

4. Todisplay a Power Amplifier double click the mouse while pointing to the card. The
following information is displayed:

Inventory Information. See DLP-019 for details.

Alarms; FRU Fail.

Output Leve The range should be between 1 and 4 volts.
=3 Network-AIR001703:Site2-R ack3: Combiner: Pow... [Hj[=] E3

—Inwvertary Information —&larms

Serial Numker: I @ FRU Failed
Firtmsasare Codle: I Q.00

State: |EMP IS

—output Level

|n

5. Todisplay a Power Supply Unit double click the mouse while pointing to the card.
The following information is displayed:

Inventory Information. See DLP-019 for details.
Alarms.  FRU Fall.

Page 112 of 305



AS8100 Sitespan User Guide Version 3.7

605-0000-426 DL P 020

Draft Issue 6.0 Date 4/4/00

7= Metwork:AIR001 703:5ite2:R ack 3: Combiner-Powe.__ M=l E3

—Inventary Infarmation —— —Alarms

Serial Mumber: || @ FRU Failed
Firmwvare Code: I 0.00

State: IENF‘ Iz

6. Todisplay the RF card (Not release 2 ) double click the mouse while pointing to the
card. The following information is displayed.

7. Inventory Information. See DLP-019 for details.

RF Gain Adjust. For information on using these fields see DLP-024
Configuration showing which RF channel and which frequencies are being
used.

The Edit Shelf Configuration button allows the user to edit modem shelf
properties. For details on using this button see DLP-053 (FA) or DLP102
(DA).

7= Metwork:AIR001703:5ite2: Rack3:CasShelf1:RiC. .. M= E3

—Invertary Information

Setial Mumbet: I Receiver Transmitter

—RF Gain &djust

Firtmunvare Code: IEI.IZIIII ] Up

State: | ENP I |u.|:|n woks | 000 votts
Dawvn [y

— Configuration

Channel: IIII Davwnilirk: I Uglink: I

|VF‘|:|wer Levelz

AGC (dBm: I 0.00 Output Poveer (dBm): I

Edit Shelf Configuration... |

FA display
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Setial Mumbet: I Receiver Transmitter

—RF Gain Adjust

State: IENP Iz

— Configuration

PR Code: I 0

Channel: IEI Davvmlik: I Lplirik: I

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SETTING ALARM THRESHOLDS

Note: Not functional on AS4000 equipment.

Use the procedure below to set alarm thresholds to allow for efficient alarm
management of the system. Each alarm can be set so that alarms are only
indicated when those limits are exceeded.

STEP PROCEDURE

1. Start this procedure from Rack View.
2. Select amodem shelf by clicking on the desired shelf.

3. From the Edit menu or click right mousebutton, select ASA000(FA) Type Modem
Shelf Properties.

—&larm Filker Configuration

Alam: [MEPS SignalLoss ¥

Intermittency Window [ms]: |1 o0
Perziztency YWindaw [mz]: |1 o0
Intermittency T hreshald: |1 i

4. To set parameters for the desired alarm condition by click on ¥ on Alarm Field. This
drops amenu of alarm fields. Click the appropriate condition. The following alarms
may be set:

2 Mbit/s Signal Loss ( on E1).

AIS (Incoming AIS on TU from Central Office).

Comms Lost with ST (loss of frame alignment on Radio Link to ST).
CT Power Fail (power supply out of spec on AU, SC or Modem).
Frame Alignment (loss of frame alignment on Radio Link from ST).
FRU Fail (Self test failed or SC unable to contact card).

Poor BER (Radio link it error rate worse than 1in 10°%"

Total RX Radio Fail.

Total TX Radio Fail.

Trans system clock fail.

Unavailability ( no message are being received from the operations and
maintenance channdl).

Note: All other fields are not applicable to AS4000.
5. Set the value for Intermittency Window by placing cursor at the start of the box and

typing value. The intermittency value isthe time interval over which the alarm
conditions are measured in milliseconds.
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6. Set the value for the Persistency Window as above. The persistency window isthe
time that a condition is persistently clear before the alarm is considered clear.

7. Set the value for the Intermittency Threshold as above. The intermittency threshold is
the number of alarm hits measured within the intermittency window for an alarm to
be initiated.

8. Repeat the process for each alarm to be set.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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RECEIVING ATTENTION

Use this procedure to receiving attention and restore the alarm
Once an alarm has been receiving attention it is latched until the alarm is cleared.

STEP PROCEDURE

1. To set receive attention on the alarms, either in Card View or Card View ST,
highlight the alarm by clicking the mouse over the alarm displayed. Receive attention
the alarm by double clicking the icon or select Receiving Attention from the Edit
menul.

2. Theaarm isin areceve attention mode when the icon contains atick. w

3. Theaarm indicationsin the site, rack, and shelf views change to the receive attention
colour.

STOP. THISPROCEDURE HASBEEN COMPLETED
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SETTING FREQUENCY OPTIONS

Use the procedure bel ow to change frequency pairsthat are offered for selection
in the Edit Modem Shelf Properties box.

STEP PROCEDURE

1. From the Tools menu, select Options. Click the tab titled Modem Shelf

E dit Options Ed
Subscriber  ModemShelf | Phone Listl Wien ‘»-"ariantsl
— Erequencies add
Chan ReceiveltMHz] Tranzmit[kHz] -
205 18532.0000 1972.0000 ;I kadify... |
206 1893.0000 1973.0000 —
207 18932500 1973.2500
508 18487.0000 1977.0000 4lﬂemm'"
209 185380000 1978.0000
210 1900.0000 19800000
21 19020000 19520000
212 19030000 19830000
213 19050000 19850000
214 19070000 19870000
215 1908.0000 19880000 w7

] 4 I Cancel | Help |

2. Toadd afrequency, click the Add button. To modify an existing frequency pair select
frequency from the list and click Modify button.

Modify Frequency Ed
Channel Humber:
B C I |
208 = ance
Tranzmit Frequency [MHz)

|1 977.0000

Beceive Frequency [MHz]

|1 897.0000

Note: Frequencies must be specified as ###H.##H#H# where each # is exactly one decimal
digit and each channel number must be unique.
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3. Todeete afrequency from the frequencies listed click the Remove button. Click OK
to confirmation message.

Confirm Frequency Delete Ed

0Ok to delete the channel:
Channel 203
Receive 1897 0000kMHz

Tranzmit 1977 0000MHz

] Cancel |

[

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE AN OBJECT LIST

An Object List isagroup of related objects. [Object List All] containing all
objects. Other Object Lists can be created to show objects in more convenient
and useful groupings. These are especially useful when managing a number of
Servers, Sites and Racks. See Managing Multiple Server Sites GSI-018.

STEP PROCEDURE

1. Inorder to selectively view any group of objects, select the Object List from the View
menu. This brings up the Select View Variant Box below.

Select View Variant Ed
Wiew Type | ok I
IEII:uien:t Ligt Carcel |

ance
Wariantz
Server -
Site i Mew ariant... |
R ack,
Shelf :
DN Phore List [elete Wariant. . |
ISOM Phone List Ent
Al one st B ;I [ mdifi s Eriart., |

2. Select the object to be viewed by clicking the mouse on the chosen item.

3. If an object view iswanted other than those listed in Variant views, a new variant can
be created by clicking the New Variant button.

Mew Hame 0 rh I
ISuI::su:riI:uerI Ean:gl |

4. Type name for the new variant in thefield. In this case the variant is called
‘Subscriber *. Click the OK button.

5. Drop the Model Type to Display fields by clicking ¥ move to the desired object and
click to select. In this case Subscriber Objects.
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E dit Object List Variant

Name
ISubscriI:uer Cancel |

kaodel Tepe to Dizplay
I Subgcriber Objects j

6. Click OK toinitiate the changes and return to Select View Variant menu. The new

view has been added.

. Variants may be modified or deleted by selecting the variant and clicking Modify or
Delete Button. Before a Variant is deleted the confirmation message is displayed.

Select View Variant Ed

@ OF. to delete the variant "Subzcriber” of view twpe “Object List''?

il Cancel |

. Toview the variant, select by clicking theitem on the variant list and click the OK to
display. The display shows all the STs, clicking any object on the list invokes the ST
View.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CUSTOMISING LISTS

Use this procedure to change the field order of object list views, subscriber list
views and history list views. Fields may either be moved in which case al the
other fields are displaced to the right of the insertion point or swapped in which

case the fields change places with each other. This procedure describes both
processes.

STEP PROCEDURE

Move Field

1. Select from the View menu an object view or history view to be customized.

2. Movethe cursor over list heading bar and it changes to the cursor shown in the screen
shot below.

3. Move cursor over thefidd to be moved.

4. Hold down (keep pressed) the left mouse button; the field darkens. Drag the field to a
new position on the bar.

Metwork[Object List Shelf] [_ (O] =]

MName =Description

MetworkcAIRDD1703:5ite2:Rack2: Shelf AS4000 (D& CT Shelf, Mumber 1, COMO Unavailable, TE~
Metwork:AIRDDT1703:Site2:Rack2: Comhiner AS4000 (D& Combiner shelf —
1 M EODATD 0 e el DD Dl S T ;l_

5. Release the mouse button and the field is now positioned in the new order.
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STEP PROCEDURE

Swap Fields

1. Toswap two fieldsin a menu move the cursor over one of the items and then click
the mouse.

2. A menu drops down. Select the field to swap with by clicking the mouse button on
thefield name or alternatively use the hot keys. The fields then interchange.
& Metwork[Subscribers] HEi=1 E3

Hame =Phone Humber Active | Address Tariff hdci Intr Moderm Shel
=

Mame
1 | | Phone Mumber 4 |

Active
Address

T ariff

Mci L\X}
Intr

kadem Shelf
Hardware

hd drin

Line

Slat

LChan

Order Lists

To sort alist into ascending or descending order click the mouse on the list name field.
Each click toggles the order, a> before the title indicates ascending order and a < before
the title indicates descending order.

Hetwork[Object List.Rack] =l Hetwork[Object List. Rack] [_ (3]

Description Description
arkeAIRDOT703:Site2Rackl  AS4000 {DA) AC Rack, Number 1 ;I orkcAIRD01703:Site2:Rackd  AS4000 Rel 2 (FA) Rack, Mumber 4 ;I
Metwork AIRO01703:5ite2:Rack?  AS4000 (DAY CT Rack, Number 2 Metwork AIRDO1703:5ite2Rack3  AS4000 Rel 3 (FA) Rack, Mumber 3
MNetwork AIRD01703:5ite2.Rack3  AS4000 Rel 3 (FA) Rack, Mumber 3 NetwarleAIRDOT703:5ite2:Rack2  AS4000 (DA) CT Rack, Mumber 2

o

MetworkAIRD01703:Site2:Rackd  AS4000 Rel 2 (FA) Rack, Mumber 4 Metwark AIRD01703:Site 2:Rackl  AS4000 (DAY AC Rack, Mumber 1

"N

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING SUBLOGS

A sublog allows events from a specific object or group of objects to be filtered,
logged and then displayed using Wordpad or any other text viewer.

STEP PROCEDURE

1. From the View menu select Sublog

Wi
v Toolbar
v Statuz Bar

Site Wiew

Subscrbers

Hiztory

Blarmng

Active Alarms
Object Lizt...
Update Server Filez
Tree View

Sublogs. ..
Map Yiew [}S

2. Tocreateasublog click New. Click OK.

Sublogs |

M arme | Server | |

b | k| oK

3. Sdlect the server attached to the equipment to be logged.
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Mew Sublog

Select a zerver:

FATR 700

o |

Cancel

4. Enter name for sublog in the Name field. Select the destination for log file
information destination. Selecting file directs the files to a location entered in the Box
adjacent to the radio button (Enter Path and file name). Selecting Port directs the files
to a printer or external monitoring device attached to a PC Port to which the deviceis
attached.

General |

—Mame
INew Sublog

— Server
|aIR001703

— Destination
@ File  |cLOG4_4_00
" Port I j

5. Select the Operations menu to enable alarm filtering. The events for all objects are

reported. To select specific objects check Enable Operational Filtering box and select
operations by checking the appropriate box(es). A v indicates an object has been

selected. To de select re-check the object.

Operatiohz I

— Enable
¥ Enable Operation Filkering

— Operationz

|

L]
1454000 (D) AC Rack

B

[w[854000 [D4] AC Shelt

[1&454000 (D) Alarmn Filker

=

6. Select the Locations menu and check Enable Location Filtering to select objects from
a specific location. Select operations by checking the appropriate box(es). Select
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Exact Match to receive reports only from that object or Match Children to select all

child objects associated with the object checked.

Locations |

—Enable
¥ Enable Location Filkering

— Locations

(v ebwork: AR 001703 s

[ IMetwark:Al R OO0 703 Subscriber Container o

[ etwork:al B 001703 Subszcriber Container _ILI
D 3

l—|I| . e ., ' - I

— Optionz
¥ Exact Match I}S
= Match Children

7. Select Descriptions to filter for specific messages from the shelf controller. Check

Enable Description Filtering. Select New or modify an existing el ement.

D escriptionz I

—Enable
¥ Enable Description Filkering

— Elements
Offhaok <= 11110011

== fmdlifiy..

— Options
" Match &l Elemnents
¥ hatch Any Elements

8. Set the value to be searched in the appropriate boxes. Click OK to initiate.

Element |

— Mame

| Offhook
— W alue

Type Comparizon

|nteger jl Lesz Than Or Equal j
11110011
Qk I Cancel |
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9. Click OK toinitiate the Sublog. The Sublog appearsin the Sublog window as active.
Click OK to return to the Equipment View

Sublogs [ ]
Mame | Server I |
Mew Sublag AlROM 703 Active

F e, | Delete |

Ok |

10. To view the output of a sublog that has been sent to file select the file stored in the
location specified in step 4 folder and view with Notepad or any other text viewer.

11. The figure below shows a typical logfile output.

B tu - Notepad |- (O] x]
File Edit Seach Help
B6/07/98 17:08:04;Sublog Closed;; :J

86/07/98 17:88:04;5ublog Dpen;;

B6/07/98 17:88:15;nirspan 68 CAS Tributary Unit;Hetwork:Server:SiteB:Rack1:CasShelf1:Tributarylnit;

86/07/98 17:88:15;nlarm;Network:Server:Site@:Rack1:CasShelf1:TributaryUnit:aIS;Alarm Clear

86/07/98 17:88:19;Alarm;Network:Server:Site@:Racki:CasShelf1:TributaryUnit:AIS;Alarm Intermittent

06/07/98 17:08:23;airspan 60 CAS Tributary Unit;Network:Server:Site@:Racki1:CasShelf1:TributaryUnit;

B86/07/98 17:88:23;nlarm;Hetwork:Server:Sited:Rack1:CasShelf1:TributaryUnit:AlS;Alarm Persistent

B86/87/98 17:88:28;nairspan 68 CAS Tributary Unit;Hetwork:Server:Site@:Racki1:CasShelf1:TributaryUnit:

86/07/98 17:88:28;nlarm;Network:Server:Site@:Rack1:CasShelf1:TributaryUnit:AIS;Alarm Clear =
| »

4

STOP. THISPROCEDURE HASBEEN COMPLETED.
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VIEWING ALARM OBJECTS
Use this procedure to create an object view for system alarms.

STEP PROCEDURE

=

From the View menu, sdect Alarms.

2. The Alarm View then shows the current alarm status.
Red = persistent Alarm, Yellow = Intermittent Alarm, Green = Persistent Alarm
Fields show the time and date of the event, source and type of alarm, the current state
and the state previous to the event.

‘@ Network:UK1PC3181[Alarms] Hi= x]

Time Target After Before

Sun Jun 07 00:22:24 1998 Metwork LIK1PC31 81 Bedfont Lakes:Rack2:MultilineShelf1:5T3:Poor E1 BER  Alarm Persistent Alarm Intermittent ]

Sun Jun 07 00:02:47 1998 Metwork UK1PC31 81 Bedfont Lakes:Rack2:MultilineShelf1:ShelfContrallerLost CAlarm Clear Alarm Receiving Attention

Sat May 16 07:09:48 1998 Metwark UK1PC3181:Bediont Lakes:Rack2:MultilineShelf :ShelfContrallerLost CAlarm Receiving Attention  Alarm Persistent =
»

STOP. THISPROCEDURE HASBEEN COMPLETED.
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VIEW-HISTORY

Use this procedure to assist in performance monitoring. All system messages are
logged and can be viewed.

STEP PROCEDURE

1

N

w

5.

From the View menu, select History. The window below is produced showing the
system messages generated.

8 Network:UK1PC3181[History] =] E3
Time |Qperati0n |Qirectinn |Target

Sun Mar1513:24:401988  Alarm Cl == Swr Metwork UK1PC3181:Bedfont Lakes: Airspan Rlse ﬂ
Sun Mar 191324401998 Alarm Cl =-—- Swr Metwork LUK1PC3181 Bedfont Lakes: Airspan Rlse J

Sun har 191324401998 Airspan 60 DASS Tributary Linit Zl = Swr metwark UK1PC3181 Bedfont Lakes:Airspan Rlse :
Sun har 191324401998 Airspan 60 DASS Tributary Linit Zl = Swr Metwark UK1PC3181 Bedfont Lakes:Airspan Rlse :

Sun dar 191324281998 Alarm Zl = Swr Metwark UK1PC3181 Bedfont Lakes:Airspan Rlse :
Sun har 191324271998 Alarm Zl = Swr Metwark UK1PC3181 Bedfont Lakes:Airspan Rlse :
Sun Mar 15 13:24:26 1998 Alarm Cl == Swr Metwork UK1PC3181: Bedfont Lakes: Airspan Rlsnjﬂ
] 3

The system is capable of storing approximately 1000 system messages.

Different events are colour coded as follows;

Persistent Alarms - Red.
Intermittent Alarms - Orange.
Alarm Clear - Green.

All other events - Black.

The History fields are:

Time -displays Day, Date, Time (Hours: Minutes: Seconds), Y ear.
Operation -this displays the object generating the event.

Direction - Thisfield shows if the communication was from the
Server to the Equipment View (Cl<---Ser) or from the Equipment
View to the Server (Cl--->Ser).

After - Gives current state of event.

Before - Gives details of state before the change of state.

Target. - The object receiving details and the details of the event.

To alter the order of presentation of the fields, see Customizing Lists (DLP-028).

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MAP VIEW

STEP PROCEDURE

1. From the View menu, select Map View.

Wi
v Toolbar
w Statuz Bar

Site Wiew

Subszcribers
Hiztory
Alarmz
Active Alarms

Object Lizt...
Update Server Filez
Tree View
Sublogs...

Map Yiew r

2. Tocreate anew map select New Variant .

Select View Variant
Yiew Type | 0k I
ki ap

I Cancel |

W ariantz
Mew Yanant... |
Delete Wariant... |
todify YWariant... |

[
3. Enter the name of the variant. Click OK
M ew M ame

IIreIand Cancel |

4. Enter detailsincluding the location of the map file on the PC. The map must be a
Windows Enhanced Metafile (.emf). Enter therangevaluesfor X and Y to set the
bottom left and top right corners of the map.

Page 133 of 305 © 2000 Airgpan Communications Ltd



E dit Map Yariant

AS8100 Sitespan User Guide Version 3.7

605-0000-426

Draft Issue 6.0 Date 4/4/00

DLP 029

Hame Q. I
IIreIand Cancel |
Eile
IE:HIreIand.emf Browse. .. |
— Bottarm Left

= Y

|n 0
— Top Right

= Y

|1 iy |1 il

5. To set the Sites onto the map open the Ste Object List and select the site to be placed

on the map. Right click the mouse and select Ste Properties from the drop menu.

Enter the co-ordinates of the site. The co-ordinates must lie within the range set for
the Map. Repest for the other sites.
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6. Return tothe Select View Variant window and select the map to view. Double click

the variant and the Map view is displayed showing the stations.

Select View Variant
Yiew Type | 0k I
ki ap
I Cancel |
W ariantz
Ireland
Mew Yanant... |
Delete Wariant... |
todify YWariant... |
[

7. If the location is not accurate adjust the values for the site until an accurate

representation is obtained.

LI etwork[M ap_lreland]

EBase Station 1

EBasge Station 2
Galway
Limmerick

: Cork “\_H_:'.,

EAccess Conc 1

J
Dublin

Note. Each map must be given an exclusive range of numbers failure to do so may result

isastation being shown on more than one map. If maps are designed to overlap the

number ranges must also be designed to overlap isf a station is to appear on two maps

STOP. THISPROCEDURE HASBEEN COMPLETED.
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PRINT SETUP

Use this procedure to set up the printer. Different printers have different set-up
properties, consult the printer user manual if needed.

STEP PROCEDURE

1. From the File menu, choose Print Setup. This produces a Print Setup dial ogue box

Print Setup
Frirter

Mame: |§'\'\EI STRLMARKET ﬂ Properties

Statuz: Ready
Type: HF Lazerlet 45i
Where:  MOSTROMARKET LPT:

Comment:

Faper Orientatian

Size: |.-'-‘-.4 ﬂ * Partrait
Source:; |.-'1‘-.uh:|matin:all_l,l Select j " Landzcape

M etwork. .. k. | Cancel

2. Sdlect printer, page size and source by clicking on ¥ and then select the item by
clicking on the desired choice on thelist.

3. Sdect the appropriate orientation by clicking the mouse pointer next to either portrait
or landscape.

4. Click on the Properties Button to produce a window allowing more printer
parameters to be set. The contents of this window depend on the specific printer used.
Refer to the printer user manual for details.

5. Click the OK button to initiate changes and return to menu.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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FILE PRINT

Use this procedure to print an event history or list. Ensurethat the printer is set
up in (DLP-033), is switched on and has paper.

STEP PROCEDURE

1. From the View menu select Object List to view the object list to be printed.

2. If required from the File menu select Print Preview to view file to be printed.

3. Select File Print (or Ctrl P) from the menu bar or click the@ icon toinitiate
printout.

Frinter

Hame: |§\\SATUHN\Marketing Frinter j Properties
Shatus: Ready

Type: HP Lazerlet 451

Where:  104.11.2141:RAW

Comment; [ Frirt to file
Frint range - Copies

Al Mumber of copies: 1 33
= [ e :

2

~
Header

Heading: |Netw0rk[D bject List.Shelf]

4. Select printer if different from the default one listed in printer namefield.
5. Select number of copies.

6. Click OK toinitiate Print and return to Equipment View.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SAVING THE CONFIGURATION FILE

Use this procedure for saving configuration files.

STEP PROCEDURE

1. From File menu select:, Save or Save As or alternatively click the on the toolbar.
Select drive and directory and insert filename. Click OK to initiate save and return.

Save Az

Save i | _ Airzpan

__| uzergid

[#] malcolm. 550
8] new. z2d

=] Template. zad
[#] Test zad

File name:  |TEMPLATE] | Save |
Save as type: |SiteS pan Docs [* szd) j Cancel |

2. The Servers automatically save and load their individual databases on exit and entry.
This starts the Sitespan Equipment View's cached database.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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FILE BACK-UP PROCEDURE FOR AS8100 SITESPAN

It is recommended that the Sitespan files be periodically backed-up on a Floppy or Tape
Drive and stored in a secure location. The .SVD Fileis automatically backed up every 30
mins

STEP PROCEDURE

1. Thefollowing files are essential to back-up.
Server Database Files *.SvD
Equipment View Database Files *.SSD
Signalling Files *.SGF

Note The* represents the file name designated by the user.
Thesefiles are located in the root directory.
2. It would be desirable to back-up the following file though not essential.
Log File *.0LG
Note Thelog fileislocated in the Sitespan directory.
3. Automatic Back-up of SVD database files. The SVD fileis saved with a temporary
name. When the save is completed the original fileis deleted and the new fileis

renamed with the same name as the deleted file. This ensures that in the event of a
write problem there will always be a good database available.

4. To back-up usethefile manager to locate the filesin the relevant directories.

File Edit “iew Toolz Help

Al Folders Contents of ' [C:]'
_,._J‘E? Deszktop i‘ Mame | Size | Type ﬂ
= A=) My Computer ) Site1.tlg BO1KE  TLG File
+=J 3% Floppy [4:] ] Site.tp 501KE TLFFile |
“wlC) + | | ] Site s BKE  TL<File
4 > 4| | »
36 objectz] B4 EME [Dizk free space: 49.8MB]

5. Place a formatted floppy disk in the A: drive or atapeinto a Tape Backup drive.
6. Open Windows Explorer by selecting it from Start, Programs.

7. Select thefile(s) to be copied by clicking the file name (s). To copy to the drive
A, drag and drop the selection to the A driveicon.

8. To complete copying, choose the Y es button in the confirmation message box.
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0. If the destination directory contains a file with the same name, a dialog box

prompts you to verify that you want to replace the existing file. Choosethe Yes
button to replace the existing file, or if you are copying more than onefile, choose
the Yes To All button. If you choose the Yes To All button, Windows Explorer

does not prompt you for each file that is replaced.

10. Thesize of the Transaction and Performance Log files are user definable using the
Options Log File menu within site controller. If the transaction and performance
log file sizes are large and do not fit on a floppy disc they may be compressed

using afile compression utility such as PKZIP.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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UPDATING SERVER FILES

This DLP describes the procedure for downloading software from the client to the server.

STEP PROCEDURE

Installing Server Files
1. Display rack or shelf view, select Update Server Files from the View menu
Wie

v Toolbar
v Statuz Bar

Site Wiew

Subzcrbers

Hiztory

Alarms

Active blarms

Object Lizt...

Update Server Filez %
Tree Yiew

Sublogs...

Map Yiew

2. Sdect the drive/directory containing the client files to download in the Update Server File
window. Downloadable files have the extension .dat. An error message isinvoked if a
download of other filetypesis attempted.

I Metwork:MWIHNDETT[Update Server Files] =] kS

File Selection

Client File[z] Server Filels]
Drive [[-a] =
Directom
| j Add x>
Dawnload File(s)
Concac.dat
Conchy, dat
wh whu, dat M
Download Progress
File Marme | Wergion | Start Time End Time % Done
. | +]
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3. Sdect thefilesand click the Add button. The files download into C:\Download directory on
the Server. The progress of a download is monitored in the Download Progress window.

Download Progress

File Name | Werzioh | Start Time | End Time | # Daone
Concsc. dat 1.70 Wed Jan 06 14:41:53 1939 26
Conctu.dat 1.70 1]

wB st dat 1.65 1]

1 | ]

Cancel

4. On completion of the download the files appear in the Server Files window.

Server File(z]

Conczc.dat

Femowve <<
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Removing Server Files
5. Display rack or shelf view, select Update Server Files from the View menu
Wie

v Toolbar
v Statuz Bar

Site Wiew

Subzcrbers

Hiztary

Alarms

Active blarms

Object Lizt...

Update Server Filez %
Tree Yiew

Sublogs...

Map Yiew

6. Sdect the server Filesto be removed and click Remove button

File Selection
Client Filelz] Server File(z]
; Concac. dat
Drive |[-a] jv Concty. dat
Diirechany w51 b dat

| j Add =

Diownload File(z)

Concsc.dat
Conctu,dat

wE Tt dat Femove <<

7. Click OK on confirmation message window. Note Remove file deletes the file It does not
placeit back in the client file directory.

Confirm File Deletion

Are pou sure you want to proceed with deleting the zelected files ?

Cancel

8. For details on downloading software into the shelf controller in the Rack see DLP 038

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DOWNLOADING SOFTWARE

This DLP describes the procedure for downloading software from the server to the Modem Shelf
and to Subscriber Terminals. The Modem shelves hold two versions of software, current and
other. When software is downloaded it is downloaded into other and then has to be switched to
current. The shelf cards will not use the new software until they have been reset. Software can
be downloaded to Subscriber Terminals over theradio link.

STEP

PROCEDURE

Downloading to Shelf

1. Display rack or shelf view, select Update Server Files from the View menu

View Child

Select the child type to wigw

Airzpan DA AC Shelf

Software Download

[,

ST List

2. Highlight and double click software to download.

Hetwork:MWINDETT:5itel:Rack11:5helf0

Description Current Version | Other Wersion Mew WYarsion St
C Shelf Controller 0.0o 0.0o =
T Modem Shelf Controller 0.0o 0.0o
Modem EFLD 0.o0 0.oo
UEPLD 0.oo 0.oo
CAS KTL 0.o0 0.oo
T 5 0.0o 0.on
OTuU 0.o0 0.oo
ST W2 (Dual Flash) - Upper Bank .00 0.00
ST %2 (Dual Flash) - Lower Bank .00 0.00
ST Wision - Upper Bank .00 0.00
ST wWision - Lower Bank 0.0o 0.0o
ST W2 (Single Flash-Upper Bank .00 0.00
ST %2 (Single Flash-Lower Bank .00 0.00
51 KT 0.oo 0.oo
ot '
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3. Click to download new version

Anrspan DA Software Download E3

— Download Mew Verzion

Mew Wersion :

File M arme : IEonctu. dat

Time Created ; |Tue Mow 10 11:16:35 1938

Doveload

Eanee! Dawnad

= Switch Versions

Current ID-DD <- Switch -» I 0,00 Otker

LarEeliS ek

Cloze |

4. New version is downloaded to the Shelf Controller

Metwork: MWIHNDETT:5itel1:DA Rack:5helfl

Description Current] Other | Mew | State
T 0.00 0.00 1.70 Download pending _
] B

5. When download is complete the window shows the new version installed as other.

Metwork: MWIHNDETT:5itel1:DA Rack:5helfl
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6. Toswitch from current to other version highlight double click field to download and select
<-Switch-> on Software Download window.

Aurzpan DA Software Download

Download Mew Yersion

Mew Wersion: |[1.70 -

File Mame : |En:unu:tu.u:|at

Time Created : |Tue Mo 10 17:76:35 1998

Switch Versions

Current |5.00 <'5WithK> | 170 Other
M

|
Cloze

7. When the two versions are switched, reset the cards using the software to complete the
software change.
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FILE IMPORT AND EXPORT

Sitespan Import/Export is used for:
Rapid configuration of large numbers of STs off-line
Archiving of configuration for inventory purposes.

STEP PROCEDURE

Sitespan Import/ Export
Every Object List in Sitespan can be exported to afile. Thefileistab delimited and can
be imported into databases or spreadsheets for inventory tracking.
The following views can also be exported:
History View.
Alarm View
Active Alarm View
The Subscriber list also has an import feature; that allows a previoudy exported list to be
imported into another Sitespan database. It should be noted that the following restrictions
apply to imported files
The import feature is only intended to cover STs and their associated lines. Thereis
no ability to import AC or CT shelf configuration. Therefore for an imported ST to
work correctly, it is assumed that the AC / CT rack configuration in the new database
matches that in the original database.
There are afew attributes that are not currently preserved in the import — V5.1 L3
addresses, SW download and authentication flags.
There are currently no safe-guards to deal with what to do if an imported ST already
existsin the database or isinvalid.

Exporting Lists

1. From the View menu select the view for export or from an Object List select object
list for export from thelist click OK.

2. From the File menu select Export.

3. Sdect thedirectory and insert file name. Click Save.

Importing Subscriber Lists.
1. From the View menu select Subscriber View.

2. From the File menu select Import.

3. Sdect thedirectory and insert file name. Click Open.
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SITESPAN DATABASE TRANSLATION V2.X TO V3.7

Use this procedure when transferring a database constructed in Sitespan 2.5/2.8 into

Sitespan 3.7.
STEP PROCEDURE
1. Closedown all Sitespan Client/Server applications running on the network.
2. Ensurethat the server25.0lg & server25.svd files are located on theroot C: drive
of your PC.
3. Ensurethat server35.0lg & server37.svd files DO NOT exist on theroot C: drive
of your PC.
4. |If thereisaserver35.0lg or server37.svd file in the directory then delete it/them.
5. Run the Sitespan V3.7 “trans’ program.
A581005itespan 37 b Client
-f Server
I sSianaling File Editer
| Trarqf
Translation Sitezpan Client
Source Server oK
|Name: Cancel
Description:
I
Destination 5 erver
M ame:
| e
- X
escrption:
|
Steps
1. Start the source server with the data to transfer
2. Create the source server object - click the 'Create’ button
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6. Run the Sitespan Server for Sitespan V2.5.

2] “Windows NT Explorer

= Sitespan 25 b ™| Client
| Mew Office Document =} Sitespan V27 ¥ T Server
L/’-’ Open Office Docurment =), Sitezpan’yal L H Signalling File Editaor
=}, Sitezpan a4 k
J==| Programsz L4
_] kD =l Startun b

7. Inthe“Trans’ program connect to the V2.5 Server by selecting “Create” and
Select OK when prompted to connect to the Remote Machine Name.

x|
Source Server oK
Mame: Create
Cancel

|
[ Dt

Dezcription:

Edit Server Properties
Eemate tachine Name

Destination Server |MWINDETT| -. k

MHame:

(¥ Fixed Mebwork Cancel
" Dial Up Network,

Description:

Steps

1. Start the source server with the data to ransfer
2. Create the source server object - click the 'Create’ buttan

8. The Source Server then indicatesthat it is connected and readly.
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Source Server akK
Hame: Lelete
Cancel

|MWINDETT

Description:

|Name MWINMDETT, Metwork Fised. Connected. Ready

Destination Server

Mame; Create
Degcription;

Steps

4, Start the destination zerver with no data [delete server.zvd file]
5, Create the destination server object - click 'Create’ button
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9. Disconnect the Source Server (V2.5).

Transzlation Sitespan Client

Source Server

M amne: Delete

|MWINDETT

D ezcription:

|Name MYWIMDETT, Metwork Fixed, Unconnected, Ready

Destination 5 erver

I ame; Create

!

Drescription:

Steps

L

4 Start the destination server with no data [delete server.svd filg)
5. Create the destination server object - click 'Create’ button

10. Shut down the Sitespan V2.5 Server program.

— Sitespan Server HiEl E3

File Edit “iew Help

Egit[ ﬂ

0

Cancel

i

Client Mame |CnnnectIime |Queued Operat

«] |

Guit the application; prompts to save documents

11. Start the Destination Server V3.7.

A581005itezpan V37 b Client

gt Server

=

m

I'§ Signaling File Editer

i Trans
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12. Connect to the Destination Server.

Create server

L | E Y'ou specified the same machine name as for the source serverl Make sure you run the destination server nowl
L]

13. The destination server indicates that it is connected and ready.

14. Click on the Transfer button. This starts converting the V2.5 database to the new

Tranzlation Sitespan Clhanl

Soires Serser oE
= e
[MwANDETT

[leseniption: Trarmelan

[ M M INDETT. Matkaork Fread, Lincorrecter. Aaady

Deshinaiion Sever
Hare

[RReTHDETT

Crasoapion:

|H-5|Tlﬂ MWIHOETT. Mebwerk Fred. Cormmchsd. Ready

Chaps
7. Trarwler the data - click Tiansfer buton

V3.7 format.

Translation Sitespan Client

Source Server 0k
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|MWINDETT

Description; IraEsfer

|Name MYWINDETT, Metwark Fiked, Unconnected, Ready

i

Destination Server

Marne; Delete

|

|MWINDETT

Description:

|Name MWINDETT, Metwork Fiked, Connected, Ready

Steps
7. Transfer the data - click 'Transfer' buttan
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15. A status message is displayed when the conversion has been compl eted.

16. Close the V3.7 Server and exit the “trans’ program.

Thefiles C:\ server35.0lg & C:\ server37.svd should now be created on your PC.

Y our Database is now compatible with the new V3.7 Server & Client applications.

STOP. THISPROCEDURE HASBEEN COMPLETED.

Page 159 of 305




This Page Intentionally Blank

Page 160 of 305

AS8100 Sitespan User Guide Version 3.7

605-0000-426

Draft Issue 6.0 Date 4/4/00

DLP 037




ﬁspan

S

AS8100 Sitespan User Guide Version 3.7

605-0000-426

Draft Issue 6.0. Date 4/4/00

DL P 038

CLOSING AS8100 SITESPAN

Use this procedure to exit from Sitespan Software.

STEP

PROCEDURE

1. From the File menu choose Exit.

2. A confirmation message window appears, giving the options to Save changes.

File
Hew
Open...
Cloze
Save

Save bz

Ctrl+H
Chrl+0

Chil+5

Impart
Export

Print...

Frint Presie
Print Setup....

Chrl+F

1 C:MProgram Files'.. 51703 22d
2 Template. zzd

E xit

Click on appropriate option button.

Yes.
No

Cancd

Page 161 of 305

Saves the changes made during this session

Exits the program without saving changes.

Returns to Sitespan.

Sitespan

! E Save changes to Template. zzd?

Mo | Cancel |
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3. If the Equipment View Database file has not been saved before the following
window is displayed.

Save As

Save i | 4 Sitespan.

[#] Template, szd

File narne: |Netwu:urkl:||]'| Save |
Save az type: |Sitespan Docs [*.exd] j Cancel

4. TypeFile Namein the File Name box, Choose the drive and directory to save the
filein. The Network button allows the users connected to a network to select a
network drive other than those listed under drives.

5. Click OK to savefile.

6. Thefileis saved and Sitespan closed.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE A34000 FIXED ASSSGNMENT MODEM SHELF

Use this procedure to create an AS4000 Modem shelf. Two alternative procedures are

documented, (a) To create a shelf using GUIs and (b) To create a shelf using the
object lists. Each shelf is created together with its signalling properties. The shelf

type should be selected to match the installation type.

STEP PROCEDURE

(a) Tocreate a Modem Shelf, using GUIs.

1. Select therack either by selecting View, and choosing Site View when in the

network object list window, or continue from DLP-014.

F —_— 2

1
Trrrnenni

| | | AS4000 [FA) Rack Properties. ..
Shell Broperties...

LCreate Rack
LCreate 5 helf l«\\g
Delete Element...

Element Yigw
Fix80 ~5smgneg

2. Click on the desired Modem Shelf (1-4). The selected shelf is highlighted with

black markers.

3. Place cursor over shelf and click the right mouse button. From the menu select:

Create Shelf.

4. To create ASA000 Shelf, select the type of Modem Shelf from the Create Child

window and click on the OK button.

Create Child Ed
Select the child type to create ] I

ASA000 [FA] DASS Modem Shelf — |
AEANHE [FATCAS Modem Shelf

ASA000 [FA) Data Modem Shelf A

ASA000 [FAT 150N Modern Shelf

ASA000 [FA) 5.1 Modem Shelf
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type of shelf created. The Icons are shown below:

(o)
E" CasMass

Data/v5.1

E‘ﬁ% ISDH

6. To set shelf parameters, go to Edit Shelf Properties DLP-053.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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STEP PROCEDURE

(b) Tocreate a Modem Shelf using object lists.

1. Sdect therack by pointing to the rack in the Network [ Object List, Rack] window
and click right mouse button. From the menu select: Create Child Element.

Metwork[Object List Rack] _ (O] =]
Hame Igeacriptinn

Metwork AIRO01703:.Base Station 1:Rackl  AS4000 (DAY AC Rack, Mumber 1 ﬂ
Metworkc AIROD1T03:.Base Station 1:Rack?  AS4000 (D&) CT Rack, Mumber 2
[Hetwork:AIRODT F03:Base Station 1:Rs-"  rorienn =t man e = v bember 3

AS4000 [FA) Rack Properties... [
Metwork AIRD01703:Base Station 1:R:

Edit Child mherd
KX b

Create Server

Create Child Element... L\\S
Delete AS4000 [FA) Rack. .

Element Yiew

2. Tocreate an ASA000 Shelf, select the ASA0000 (type) Modem Shelf from the
Create Child window and click on the OK button.

Create Child Ed

Select the child type to create EIIT_\. I

454000 [FA] DASS Modemn Shelf Cancel |
A54000 [Fa1 CAS Modem Shelf

£54000 [FA) Data Modem Shelf

A54000 [FA) 150N Modemn Shelf

A54000 [FA) W51 Modem Shelf

3. Using the mouse select an empty dot. Click the OK button to initiate changes and
return.

AS4000 [FA] Modem Shelf
Shelf Shot Murnber: oK I
1 (Top) Caz5Shel
2 (Upper Middl=] . Slot Emoty Cancel |
3 [Loweer kiddle] Shat Empty
4 [Bottom) Slat Emphy

4. The Network [ Object List, Shelf] window now includes the new shelf.

5. To set shelf parameters, go to Edit Shelf Properties DLP-053.
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6. Note: Itisnot possiblefor auser to gain accessto any object if it, it’s parent or

child is currently being edited by another user. It is possible however to edit a peer

object. For exampleif auser is editing a shelf then all Site, Rack, Card objects

relating to that shelf are locked. This does not however stop another user creating,

editing or deleting other shelves on the same rack or other shelves, racks etc. on

the same or other sites.

7. If an attempt is made to access a locked object then the following message
appears.

AS8100 Sitezpan E3

& This Elernent is carrentlsy being edited by another Equipraent Wiew

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DELETING MODEM SHELVES

Use this procedure to del ete Modem Shelves that have been created and are now

not needed. Procedure (a) isfor deleting a shelf from the GUI View and

procedure (b) isfor deleting a shelf from an Object List View.

For a Shelf that has just been created consider using the Undo command in the
Edit menu. The Equipment View must be connected to the Server to perform a

deletion.

STEP PROCEDURE

(a) Deleting a shelf using the GUI View.
1. Display the Rack containing the shelf to be deleted.

" Metwork:AIRD. .. =] E3

H

LT L\}**'-S 4000 [Fa) Fack Properties. ..
|| | || ||| || AS54000 [FA] 1SDM Modem Shelf Properties. ..

|

Create Rack
Fixed Az Create Shelf
1 | | Delete ASA000 [FA) ISDM Maodem Shelf...

A54000 [FA] 1SDM Modem Shelf Yiew

2. Place cursor over shelf and click the left mouse button. The sdected shdlf is

highlighted with black markers. Place cursor over shelf and click the right mouse

button. From the menu select: Delete (type) Shelf.

3. A confirmation window is displayed. Click the ‘OK’ button to initiate deletion.

ASB100 Sitezpan E4

& 0K to delete lsdnSheli3?
Eancell

4. TheRack is now displayed with the deleted shelf returned to the non-active color.
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STOP. THISPROCEDURE HASBEEN COMPLETED.

STEP PROCEDURE

(b) Deleting a shelf using an Object List.

1. Display the Network [Object List, Shelf] containing the shelf to be deleted. Select the
Modem Shelf to be deleted Click right mouse button and from the menu select:
Delete ASA000 (shelf type) Modem Shelf.

Metwork[Dbject List,5helf] [_ (O] x|

Marme |Qeacriptinn

Metwork AIRODD1T03:Base Station 1:Rack2: Combiner AS4000 (DAY =~
MetworkcAIRDDT T03:Base Station 1:Rack?:Shelfl AS4000 (Da)

Metwork AIRODD1T03:Base Station 1:Rack3: Combiner AS4000 (FAY
MetworkAIRODDTY03:Base Station 1:Rack3: Cas5helf AS4000 (FA)
IBetwork:AIROOT TO3:Base Station 1:Rack3:Cgr™th~H WP AT A0 :

: 454000 [FA) CAS Modem Shelf Properties. ..
Metwork AIRD01Y03:Base Station 1:Rackd:. Col e
Edit Child
A
J_I Create Server

Create Child Elemert...
Delete ﬁ?\dﬂﬂﬂ [F&] CAS Modem Shelf...

ASAD00 (FA] CAS Madsm Shelf Visw

2. A confirmation window is displayed. Click the ‘OK’ button to initiate del etion.

ASE100 Sitezpan E4

& 0K to delete CasSheli2?
I:ann:ell

3. TheObject List is now displayed with the shelf removed.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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EDIT AS000 FIXED ASSIGNMENT MODEM SHELF
PROPERTIES

Use this procedure to edit AS4000 fixed assignment modem shelf properties. The shelf
view, or an Object list containing the shelf, should be displayed at the start of this
procedure. See TNG-004 Selecting Views.

STEP PROCEDURE

1. Place cursor over shelf and click the right mouse button, or select the shelf on an Object List.
2. From the Menu, choose AS4000 Modem Shelf Properties.

Edit AS4000 [FA] Modem Shelf Properties

Harme: Il:asS helf

Dés CT Shelf  Port
Pot. [coMz x| M iaDA[1 =] [scaux x|
BixfTx FrequenciesibHa] [1 2029 7500 2204.7500 =]

PH Code |-| j

— Signalling Configuration File

—&larm Filker Configuration

Alam: [MBPS SigralLoss ¥

Intermittency ‘Window [ms]: |1 o0
Perzistency YWindaw [mz]: |1 oo
Intermittency Threshold: |1 0

|' Output PC [dBm per uzer] |' ST Configuration

Flequied: |21 IICP Threzhold I':I
k. I Cancel | Help |

3. Enter the shelf name/number into the dialog box and click the OK button.

4. Select the Port by clicking W to drop the options box and choosing the appropriate
communications/serial port on the Server PC that is connected to the Shelf Controller on the
ASA000 Rack (each Modem shelf requires a different COM port). The portslisted are those
available on the Server machine; this may not necessarily be the machine running the
Sitespan Equipment View.
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Paort: 1com1 *
X COM2 +
sMHz) | o3 [ * ]

COM4 s
| Code COMS
COME +

If the FA shelf isfitted into a DA Rack thereisthe option to backhaul the Sitespan
connection to aremote server at the Access Concentrator site viathe DA modem Shelf.
Check the Via DA box by click left mouse button with the cursor over the box. Select the DA
CT shdf that isgoing to host the back haul and the port that the output of the FA shelf to
Sitespan is connected to on the DA Modem Shelf. The options are to connect either to the SC
AUX port or the Sitespan 2 port.

D& CT Shelf  Part
W &aD& (1 -] [scaux -]

Select Rx & Tx Frequencies by clicking W to drop the options box and clicking the
appropriate frequency pair on the drop down list. The frequency pairs are usually determined
as part of the system planning process.

Fi/Tx Frequencies(MHz] | 2 2225 7500 2050.7500

*

5 27502500 20752500 | +

PN Lode | 35583 7500 20787500
11 2257, 2600 20822500 ||
12 2960, 7500 2085, 7500 |+

Select PN Code (1-7) by clicking W to drop the options box and clicking the appropriate
number from drop-down list. The PN codes are usually determined as part of the system
planning process.

PH Code

o s g —
«| [[+]

For CASfilesfill in the Sgnaling Configuration File or select one using the browse option.
The Signaling configuration files areingtalled in a directory on the server named Sigfiles.
Signaling configuration files have the extension .SGF. If an SGF fileis not specified then
config file that existsin the shelf isused. If providing an ISDN Shelf then this box istitled
Supplementary Services File Name. This file contains network specific keypad functions and
has the extension .IDN. Enter the file name or select using the browse option.

The output of the system per user is set into the Output Required per User field. Thisis
dependant on the frequency band in which the shelf is operating.

The UCP Threshold sets the limits of code phase displacement that are tolerated before an
alarmisgiven. If a CRU is moved to another location an alarm is raised at the Sitespan
Equipment View.
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11. The Alarm Filter Configuration section of the window allows the user to increase or decrease
the sengitivity of the alarms. Thisis not operational on AS4000 systems. These are
automatically set to the default levels.

Note: Allocation of Frequency and PN code usually forms part of the network planning
and is not usually determined by an individual editing the shelf properties.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MODEM SHELF CARD VIEWSFIXED ASSIGNMENT

This procedure describes the Modem Shelf Card Views.

STEP PROCEDURE

1. Display the Modem Shelf. To display view see GSI-017.

i M etwork-AIRD01 703:Base Station 2:Rack3:-DataShelfl

(0]
=
o™
=
)
o
=
=
=
=
)
i

Release 2

i Metwork-AIRD01 703:Base Station Z2-Fixed Azsigned:CasShelfl

Fixed Assignment

2. Todisplay the RF card (Release 2 only) double click the mouse while pointing to the

card. Thefollowing information is displayed:
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Inventory Information. See DLP-019 for details.
RF Gain Adjust. For information on using these fields see DLP-024
Configuration showing which RF channel and which frequencies are being used.

The Edit Shelf Configuration button allows the user to edit modem shelf properties.
For details on using this button see DLP-053.

7= Metwork:AIR001703:B aze Station 2:Fixed Assign... M=l E

—Invertary Information

Setial Mumbet: I | Receiver Transmitter
Firtmunvare Code: IEI.IZIIII ] Up

State: IENF‘ IS ||:|.|:u:| votts | 000 svoits

—RF Gain &djust

Dawvn [y

— Configuration

Channel: |1 Drovvmlirk: |22EI4.?5EIEI igalirk: IEEIEEI.?SEIEI

|riner Levelz

AGC (dBm: I 0.00 Output Poveer (dBm): I

Edit Shelf Configuration... |

3. Todisplay aModem card double click the mouse while pointing to the card. The

following information is displayed:

Inventory Information. See DLP-019 for details.

A Sdf Test button. For details of use see DLP-016.

Link Performance (BER). For details of these measurements see DLP-068.
Alarms  Poor BER.

FRU Falil.

Lost commswith ST.

Reset button to reset the Modem.

ST View button to display the Subscriber Terminal Card View. See DLP-056. Note
this has no function on Demand Assignment Modem card views.
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7= Metwork:AIRD01703:Base Station 2:-Fixed Aszigned:__. =] E3

—Inventary Information — &larms
Serial Mumber: || @ Paor BER
Firmuvare Code: ID.UD @ FRI Failed
State:  [ENPIS () Lost Comms With ST
Self Test | IND Reszuft
—Link Petformance (BER])
Davenlirk Uplink
Current: IN':' Diata Current; IN':' Data
Prewvious: II:I.I:II:IE+I:II:IIII Previous: II:I.I:II:IE+I:II:II:I

ST Wiewy | Reset |

4. Todisplay the Tributary Unit(TU) card double click the mouse while pointing to the

card.
The following information is displayed:

Inventory Information. See DLP-019 for details.
A Sdf Test button. For details of use see DLP-016.

Reset button to reset the card.
Alarms; FRU Fail.
Poor BER.
2Mbit/s Lost.

System Clock Fail.
Frame Alignment Lost.
AlS.
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Watchdog: A [ indicates the watchdog is checking the system. If it is locked up it
reset accordingly.

AIS transmit: A [l indicates that Alarm Indication Signal is being sent towards the
Central Office.

Clocksource : either Internal or External.

5= Metwork:AIRD01703:Baze Station 2:Fixed Assi.. H=] E3

—Invertary Information

—&larms

Serial Number: | () FRU Failed
Firmyvare Code: I 0.00 @ Foor BER:

State: IENF‘ 1= (L) 2MBS Lost

(23 System Clack Fail
<ol I | I @ Frame Alignment Lost

—Configurstion ———— @ A=

[T AIS Transmit
[ watchoog

Clock Source

I Internal

Reset |

Tributary Unit Fixed Assignment

5. Todisplay the Shelf Controller Card (SC) card double click the mouse while
pointing to the card. The following information is displayed:
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Inventory Information. The inventory shows both the current and other Firmware See
DLP-019 for other inventory details.

A Self Test button. For details of use see DLP-016.

Reset button to reset the card.

Alarms.  Lost Commswith EM: PSU Fail.

General Status Poll Button to initiate a poll of FRUs on the modem/combiner shelf

7= Metwork:AIR001703:B aze Station 2:-Fixed Assig. . M=l E

—Inventary Infarmation Alarms
Serial Mumber: ||— ’ﬁ Lost Comma With EM
Current FAf IIIIIIIIII— FeuFal
Cther Fivy: I,:,_,:,— E— |
State: |ENP IS

Self Test | I—

General Status P'u:ulll

6. Toedit card state choose Edit (Card Type) Properties from the Edit menu.

Edit Card State

¥ In Service

Cancel |

[~ Emulator

7. Set the card state to the required service state by clicking the check box with the
mouse.

In Service
Emulator

8. Click OK toinitiate state change.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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RESERVED FOR FUTURE USE
STEP PROCEDURE

STOP. THISPROCEDURE HASBEEN COMPLETED.
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>

SUBSCRIBER TERMINAL VIEWSFIXED ASSIGNMENT

This procedure describes Subscriber Terminal Views.

STEP PROCEDURE

1. Display the Modem Shelf. To display a view see DLP-019 or GSI-017.

[47]
=2
o
=
@]
o
=
=
=
=2
)
L

,&"&‘

2. Todisplay the Subscriber Terminal either double click the mouse while pointing to
the ST icon on the Modem Card, or use the ST View button when in the Modem Card
View.

3. The ST Icon indicates the type of ST connected to the Modem

(o)
E" CasMass

Data/v5.1
ol

_ﬁijrl ) 1SDH

4. The ST View displays the following information:

Inventory Information. The inventory shows both the Current and Other
Firmware versions being used. See DLP-019 for other inventory details,
A Sdf Test button. For details of use see DLP-016.
Reset button to reset the card.
An Apply Loopback button. Thisis not operational in this version.
Alarms.  Link Unavailable.

Poor BER.

PSU Tamper (CRU using Type 2 PSU only).

Switch to Battery (CRU using Type 2 PSU only).

Low Battery (CRU using Type 2 PSU only).
CRU Signal Strength. See DLP-069 Measuring Signal Strength.
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7= Metwork:AIR001703:B ase Station 2:Rack2:CasSh... M=l E

—aT Inventory Information —CRU Signal Strength ——————
. P IIZI
Serial Mumber ||
0
Firmwware Code IIII.IZIIII Pawer Cortrol I
Ttate IENP IS Lplink Code Phase IIII
Zelf Test | IND Result —Alarms
(23 Link Unavailable -
—P3U Inventory Information
! () Poor BER
Serial Mumber I @ Ringer Fault
Firmwware Code IIII.IZIIII @ Pzu Tamper
@ =wvitch to Battery
State  |ENP I3 hd
Line1: o= Line 20 oo Reset | Apply Loophack... |
B1 - Releszed
Rezerve Line... | B2 - Releazed

5. The ST Viewsfor the ST-V2 and the ISDN also shows the status of equipment
connected at the ST in the lower left hand corner of the window.

Line 1: Line 2: i ; i P Line 1: Line 2:
ine w ine %‘5 Line1: gy Line 2 g ing ine

Mot equipped DassiCass ISDN

6. Toedit card state choose Edit (Card Type) Properties from the Edit menu.

Edit Card State =]
¥ In Service
Cancel |
[~ Emulator

7. Set the card state to the required service state by clicking the check box with the
mouse.

In Service
Emulator
8. Click OK toinitiate state change.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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FA ALARMSIN ST VIEW

Use this procedure to look at the alarmsin ST view Fixed Assignment only.

STEP PROCEDURE

Page 183 of 305

If thealarm is at the ST, the symbols displayed on the Shelf View are coloured red.

Clicking on the symbol brings up the Card View ST. Alternatively the ST View can
be displayed by clicking on ST View button when in Modem Card View.

. TheCard View ST in the screenshot shows the status of the ST, i.e., Poor Bit Error

Rate. The alarm icon colour indicates whether they are OK, faulty or receiving
attention. Also shown are details of the Serial Number and Firmware Code of the ST.

=7 Network:AIRD01703:Base Station 2:Rack2:CasSh... =] E3

—=T Inventory Information —CRU Zignal Strength ———————
_ e In—
Setial Mumber I
1]
Firmyvare Code IIII.EIIII Pawver Control I
State IENP = Lplink Code Phase IIII
Self Test IND Resutt —Alarms
(23 Link Unavailsile -
—PSU Inventory Information
g @ Poor BER
Serial Mumber I @ Ringer Faut
Firmmneare Cocde IIII.IIIIZI @ Pzu Tamper
@ Switch to Battery
State  |ENP I3 hd
Line 1: @ Line 2: @ Reset | Apply Loophack... |
B1 - Releazed
Rezerve Line... | B2 - Releazed

Alarm States possiblein ST view are:--
. Poor Bit Error Rate  (Errors greater than 1in 10°%).
Link Unavailable (Complete failure of RF path).
Ringer Failed
ST PSU Tampered
ST Switched to Battery
ST Battery Low

© 2000 Airspan Communications Ltd
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Inventory Information box.
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DASS/CASS (FA) SUBSCRIBER CREATOR WIZARD:

It is recommended when provisioning a shelf that the wizard is used to
create default subscribers and then provision details for each subscriber can
amended to insert details.

STEP PROCEDURE

1. Select which site to create subscribers on by clicking on the appropriate item in the
listing.

Metwork[Object List.Site] [ O]

Blarme |Qescriptinn

MletworkcAIRO01 Y03:Base Station 1 mHame Base Station 1, 1d 80, ﬂ

IBetwork:AIRDDT FO3:Base Station 2 Hame Base Station 2 1d 51

Fetwork:AIRDOT F03Access Canc 1 MHame Access Conc 1, 1d 52,

Metwork: SYSTEMS _LABE_1:Beta FHame Beta, [d 48, Ob Crea_telj
3

< |

2. Fromthe Tool bar, select Subscriber List icon |H to generate alisting of all available
subscribers, if any.

& Metwork[Subzcribers] M= E3
Mame Active | Mci Intr Mdm | =Line | Modem Shelf | Tariff
K _>I_I

3. From the Tools pull-down menu, select Subscriber Creator Wizard.

Tools

Colours
Optianz

Subszcriber Creator Wizard. .. [\lL
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4. The Subscriber Creator dialog box displays.

Subszcnber Creator

Shelf
I...:Ease Station 1:Rackd:Dazz5helf j

Cancel |

Hame

|ModemZmLine|
*m = Modem Mumber
%l =5T Line Mumber
%o = TU Channel Mumber

V¥ Active
[ Irtrusion Tone
[T MCl Recal

To choose the shelf to create subscribers on, click on W next to the Shelf field. A list
of shelves displays. Click on the desired shelf.

No entry is needed in the name field. The Creator Wizard names the subscribers
according to modem and line number.

Click the cursor in the Active box at the bottom of the dialog box to cause each
subscriber to default to activeif required.

Set the Intrusion Tone if the subscriber is to receive indication of a test clerk on the
line. Thisisfor ST-V2 using DASS only.

Set the MCI (Malicious Call Indication) to enable the facility. Thisisfor ST-V2 using
DASS only.

Review the choices made. Click the Create button to create the subscribers with
information just entered.

The following subscriber view displays:

&= Metwork[Subscribers] M=l E3

Mame Active | Mei Tariff
MndemHLine'I/ 1 MetworkAIRDDTS ;l
Modern10Linet 7 10 1 MetworkAIRODT
Modern?Ling Z 7 1 MetwiorkAIRDDT _|
Modem10Line? |y 10 1 MetworkAIRODT
Moderm4Line 7 4 1 Metwork AIRODT,
Moderm12Linet 7 12 1 MetworkAIRODT
ModemBLinet |yf] B

Nehﬁmrk:AIHDDT._I;I
»
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Subscriber or by double clicking the mouse on the name field of the selected modem.
See DLP-064 for details of editing subscribers
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|SDN (FA) SUBSCRIBER CREATOR WIZARD

It is recommended when provisioning a shelf that the wizard is used to create
default subscribers and then provision details for each subscriber can amended to
insert details.

STEP PROCEDURE

1. Select which site to create subscribers on by clicking on the appropriate item in the
listing (example shows Site0 selected).

Metwork[Object List.Site] [ O]

Blarme |Qescriptinn

MletworkcAIRO01 Y03:Base Station 1 mHame Base Station 1, 1d 80, ﬂ

IBetwork:AIRDDT FO3:Base Station 2 Hame Base Station 2 1d 51

Fetwork:AIRDOT F03Access Canc 1 MHame Access Conc 1, 1d 52,

Metwork: SYSTEMS _LABE_1:Beta FHame Beta, [d 48, Ob Crea_telj
3

4 |

2. Fromthe Tool bar, select Subscriber List icon |H This generates alisting of all
available subscribers, if any.

& Metwork[Subzcribers] M= E3

Mame Active | Mci Intr Mdm | =Line | Modem Shelf | Tariff
K _>I_I

3. From the Tools pull-down menu, select Subscriber Creator Wizard.

Tools

Colours
Optianz

Subszcriber Creator Wizard. .. [\lL

4. The Subscriber Creator dialog box displays. Choose the shelf to create subscribers on,
click on ¥ next to the Shelf fidld. A list of shelves displays. Click on the desired
shelf. If the Shelf is configured for ISDN the Subscriber Creator changes to offer
ISDN options

Page 189 of 305 © 2000 Airgpan Communications Ltd



AS8100 Sitespan User Guide Version 3.7

605-0000-426 DLP 059

Draft Issue 6.0 Date 4/4/00

Subscriber Creator

Shelf

Create
[ otion 2-Fiwed AssigredisdnSheliz -]

Cancel
Hame
|ModemZmLine|

#m = todem Number Subscribed Services

%l = 5T Line Murnber [ J&dvice of Charge

%0 = TU ChannelNumber | [LZ2Lfotarng noondiional - =
™ Irbaring [ ]Calling Line |d Restriction =

[T Out-baring

;]

5. Noentry isneeded in the name field. The Creator Wizard names the subscribers
according to modem and line number.

6. Click the cursor in the Active box at the bottom of the dialog box to cause each
subscriber to default to activeif required.

7. Enter the Subscribed Services by clicking the mouse on the boxes next to the service.
When a serviceis selected a M is shown. Usethe scroll bar to view other services.
The services available are;

Advice of Charge

Call Forwarding Unconditional
Calling Line Id Presentation
Calling Line Id Restriction
Closed User Group

Call waiting

Call Hold

MCI

Sub Addressing

Terminal Portability

User to User Signalling

8. Click XI In Barring and Out Barring if required

9. Review the choices made. Click the Create button to create the subscribers with
information just entered.

10. The following subscriber view displays:
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Mame Active | Mci Intr Mdm | =Line | Modem Shelf | Tariff
MndemHLine'I/ 13 1 MetworkAIRDDTS ;l
Modern10Linet 7 10 1 MetworkAIRODT
Modern?Ling Z 7 1 MetwiorkAIRDDT _|
Modem10Line? |y 10 1 MetworkAIRODT
Moderm4Line 7 4 1 Metwork AIRODT,
Moderm12Linet 7 12 1 MetworkAIRODT
ModerniLling 7 B 1 Metwirk AIRDDT

of
11. Each subscriber can be edited by using the Edit pull-down menu and choosing

Subscriber or by double clicking the mouse on the name field of the selected modem.
See DLP 065 for details of editing subscribers

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING ST-V2 (FA) SUBSCRIBERS

Use this procedure to create/add subscribers on the CAS/DASS shelf. Also consider
using the ST-V2 Subscriber Creator Wizard DLP-058.

STEP PROCEDURE

1. Display the Network[Subscribers]view by clicking the |H button on the toolbar or by
selecting Subscribers from the View menu.

& Metwork[Subzcribers] M= E3
Mame Active | Mci Intr Mdm | =Line | Modem Shelf | Tariff
K _>I_I

2. From the Edit Menu sdlect Create Subscriber. or click the Ll button on the toolbar.
to produce the Edit Subscriber dialog box.

E dit Subscriber Ed
—Customer Infarmation —————  —Hardware Configuration
Mame: Zhelf
| Doe | .52 Stetion 1:Rack3:CasShelft ¥ |
Address ¥ Circuit &ctivation
anywhere i e
|1 vI |1 vI
[ MElRecall

[~ Intrusion Tane

Telephone Mumkber

|12345E =T Programming Cocde

i ||:u:| 001 000000 0

I_Elusiness j Print Inztallation Instructions. .. |
I Cancel | Help |
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Note: to moveto anew line in the address field use Ctrl and ¢,.

Select the Tariff from the drop down menu. The inclusion of the tariff isfor

information only and does not set a tariff.

Tarift

Business *

Businezs
Damestic
Econamy

Enter the customer information in the Name, Address, and Telephone Number fields.

5. Sdect the hardware configuration by selecting the Shelf, (the field may be dropped by
clicking the mouse on the ¥) Modem and Line number. If the modem / line is already
in use then the Sitespan displays a message, select anew modem / line.

Edit Subscriber Ed

& Subscriber already exiztz on shelf Metworl:AIRO07 703:B aze Station 1:Rack3:CazShelfl, modem 1, 5T line 1.

6. Set thelntrusion Toneif the subscriber isto receive indication of atest clerk on the

line. This

isfor ST-V2 using DASS only.

7. Setthe MCI (Malicious Call Indication) to enable the facility. Thisisfor ST-V2 using

DASS onl

y.

8. Set the customers active by clicking in the circuit activation box (O). A [X] shows that

the subscr

9. Click OK toinitiate the creation of the subscriber. The Network [ Subscribers]

iber isin service.

window shows the configuration details.

& Metwork[Subscribers] [_ O]

Active | Mdm JLine | Bhone Mumber] =Address Modem Shelf | Har

Wl 1 123456 amywhere  MetworkAIRDOT7 =5
‘ _ »
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CREATING ISDN (FA) SUBSCRIBERS

Use this procedure to create/add subscribers on an ISDN shelf. Also consider using the
ISDN Subscriber Creator Wizard DLP-058.

STEP

PROCEDURE

1. Display the Network[Subscribers]view by clicking the |H button on the toolbar or by
selecting Subscribers from the View menu.

2. From the Edit Menu sdlect Create Subscriber. or click the Ll button on the toolbar.

to produce the Edit Subscriber dialog box.

—Customer Infarmstion

Mame:

—Hardware Configuration

Shelf

Address

Aryavhere

Edlit Phone List

Taritf

Husiness

=

|... 2Fixed Assignedsdnsheliz ¥
¥ circuit &ctivation
Modem Lime

Subzctibed Services

[ JAdvice of Charge -
[ JCall Forwarding Uncondtional
[ |Zalling Line Id Presentation

[ JCalling Line |d Restriction *

[~ InBarring [ Out Barring

=T Programming Cocde
||:u:| 001 000000 0

Print Inztallation Instructions. .. |

ik

Cancel | Help |

3. Enter the customer information in the Name, Address, and Telephone Number fields.
Note: to moveto anew line in the address field use Ctrl and ¢,.

4. Sedect the Tariff from the drop down menu. The inclusion of the tariff is for

information only and does not set a tariff.
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5. Sdect the hardware configuration by selecting the Shelf, (the field may be dropped by
clicking the mouse on the W) Modem and Line number. If the modem / line is already
in use then the Sitespan displays a message, select a new modem / line.

E dit Subzcriber E

& Subscriber already exiztz an zhelf Metwork: AR 001 703:E aze Station 2:Fiked Azzigned:|zdnShelf2, madem 1. 5T line 1.

6. Enter the Subscribed Services by clicking the mouse on the boxes next to the service.
When a serviceis selected a M is shown. Usethe scroll bar to view other services.
The services available are:

Advice of Charge

Call Forwarding Unconditional
Calling Line Id Presentation
Calling Line Id Restriction
Closed User Group

Call waiting

Call Hold

MCI

Sub Addressing

Terminal Portability

User to User Signaling

7. Click X In Barring and Out Barring if required

8. Set the customers active by clicking in the circuit activation box (O). A [X] shows that
the subscriber isin service.

9. Click OK toinitiate the creation of the subscriber. The Network [ Subscribers]
window shows the configuration details.

When a subscribed serviceis selected the subscribed serviceis also applied to the
other line on the modem. A message appears on the screen to show that thisisthe
case. Click yesto apply to both lines, or no to leave both lines unchanged and return
to the subscriber Editor.

AS8100 Sitespan Ed

& The canfiguration changes you have made will alza aftect madem 3, ling 1. Do paw wish bo continue? Selecting Mo’ will

return you to the subscrber editor.
] o |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING ISDN SUBSCRIBERS PHONE LIST

The Phone List provides the TU with information for mapping the ISDN B channelsto a
specific modem line. Each number can be mapped to a number of different
subscribers or a group of numbers can be mapped to a particular subscriber.

STEP PROCEDURE

1. Select Object List from the View menu
2. Sdlect ISDN Phone List from the view variants and click OK.

Select View Variant Ed

Wiew Type | 0k I
IEII:uiect List

Cancel |

W ariantz

S!E!wer -
Site Few ariant... |
Rack

Shelf
[S0OM Phone List

[SDM Phone List Ent |
N one List Enlry ;I [ ity W ariamt.. |

[eleteWariant. . |

3. ThelSDN Phone List contains alist of all the TU cards associated with ISDN
shelves. To set the number of digits acted upon by the ISDN mapping select the TU
card from thelist.

Metwork[Object List ISDN Phone List] M=l E3

Iﬂame Igescriptinn

Metwork AIRODD1T03:.Base Station 2:Fixed Assigned:lsdnShelf2: Min. Regd. Digits =0 ;l

EHetwork AIRODDT T03:Base Station 2:Fiked Assigned:lsdnShelfamin. Regd. Digits = EI_|;|
'l 3

4. From the Edit Menu select ISDN Phone List Properties.

5. Enter the Minimum Required Digitsin the Edit Phone List Properties window. If a
number contains less than the required digitsit is not mapped. If the number is set to
zero it attempts to map any number but in the failure of a match defaultsto the first
linein the phonelist.

Edit Phone List Properties Ed
Mir. Reqd. Digits
IE

Cancel |
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6. The Phonelist now shows the minimum required digits.

Metwork[Dbject List.ISDN Phone List] M=l E3
=Marme Igescriptinn

[WetworlcAlROOT 703 Base Station XFixed Assigned:lsdnShelf2 Min. Regd. Digits = & ;l
Metwork AIRODDT T03:Base Station 2:Fixed Assigned:lsdnShelf3min. Regd. Digits = EI_Ij
3

< |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING AND EDITING ISDN SUBSCRIBERS PHONE
LIST ENTRIES

The Phone List provides the TU with information for mapping the ISDN B channelsto a
specific modem line. Each number can be mapped to a number of different subscribers or
a group of numbers can be mapped to a particular subscriber.

STEP PROCEDURE

1. If aphonelist does not already exist, create one. (See DLP-062)
2. Display the phonelist by selecting Phone List from the View, Object List menu.
3. Sdect required phonelist from the list.

Metwork[Dbject List.ISDN Phone List] M=l E3

=Marme Igescriptinn

[WetworlcAlROOT 703 Base Station XFixed Assigned:lsdnShelf2 Min. Regd. Digits = & ;l
Metwork AIRODDT T03:Base Station 2:Fixed Assigned:lsdnShelf3min. Regd. Digits = EI_Ij
3

< |

4. Place cursor over shelf and click the right mouse button. To create phone list entries
for mapping the numbers Select. Create ISDN Phone List Entry from the Edit menu

Metwork[Object Lizt ISDN Phone List] M= E3
Harme Igescriptinn

[HeteoricRO0 [D2E: IS_DN F"h-:u.n;List. E-ru.:upe.rti;s..... pad.Digis =1 il

Metwork AIRDDT703:8: £ ohild qd. Digits = 6
FetworkcAIROO01Y03:B: gqd. Digits =0
. Create Server _’I_I
—I—I Create 1S0M Phone List E ntr

Delete Element. . k

Element Yiew

5. The phonelist entry is automatically created in the Network[Object List, ISDN Phone
List Entry. To view the object list use the Select Object List from the View menu and
choose ISDN Phone List Entry.

Metwork[Object List ISDM Phone List Entry] M=l E3
Hame Igeacriptinn

Metwork AIRO01T03:.Base Station 2:Fiked Assigned:lsdn3Shelf2Tel. 8500..835498, Channels [117 jﬂ
Metworkc AIRDO01 Y03 Base Station 2:Fixed Assigned:lsdnShelf2Tel. 1, Channels [ ] j

< | 2
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6. To edit the properties of a phone list entry select the entry by Place cursor over shelf
and click the right mouse button and choose ISDN Phone List Entry Properties. from
the menu.

Hetwork[Object Lizt ISDH Phone List Entry] M=l E3

=Marme Igeacriptinn

[Betaork:AIRODT Y03:Base Station 2Fixed Assighed ools it RERm Qe wrbsee sl
i i i [SDM Phone Ligt Entry Broperties. ..
MetworkcAIRODDT T03:.Base Station 2:Fiked Assigned l%

Edit Child
4] |

e b

| Create Server
11 Create Child Element...
Delete IS0 Phone List Entry...

| Element e

7. In the Phone Number Range text box enter the number to be mapped. The length of
the number should be the same as that specified in the minimum required digits. The
number can then be mapped to a channel by clicking on the channe box. The Number
can be mapped to more than one channel. A range of numbers may also be mapped
to achannel(s). To enter arange enter the first and last number separated by .. e.g.
1234..1244,

Edit Phone Entry Properties E

Phone Mumber B ange LChannels

IEEEIEI..EE'.EIEI W|Charnel 1«
[1Channel 2

E nter nurmber ar range [(IChannel 3 —

e.g. 8439 or 34008419 [[IChannel 4 Cancel |
[(IChannel &
[(IChannel &

[(IChannel 7
[1Channel3 ™

8. Click OK and the Object List, ISDN Phone List Entry shows the channels mapped
against that number.

Metwork[Object Lizt ISDH Phone List Entry] [_ (O] x|

|bﬂame Igescriptiun

Betwark AIRODDT F03:Base Station 2 Tel. 8500 85484 Channels [1,15] —'
|_I< N o

9. Toddeteaphonelist entry, select entry on the Object List, ISDN Phone List Entry
and choose Delete ISDN Phone List Entry from the Edit menu.

10. A confirmation window confirms choice. Choose OK to initiate deletion, or Cancdl
to abort.
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& 0F. to delete PhoneE ntnl ?

Cancel |

11. The Object List, ISDN Phone List Entry has the entry removed.

Hetwork[Object Lizt ISDN Phone List Entiy] M= E3
=Marme Description
Metworkc AIRDD1 703 Base Station 1.Tel. 0, Channels [ ] ﬂ
Metwork AIRO01703:.Base Station 1 Tel. 1, Channels [ ] _Ij
4| | 3

STOP. THISPROCEDURE HASBEEN COMPLETED.
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EDITING ST-V2 (FA) SUBSCRIBERS

Use this procedure to edit ST-V 2 subscribers on the CAS/DASS shelf.

STEP

PROCEDURE

Display the Network[Subscribers]view by clicking the |H button on the toolbar or by
selecting Subscribers from the View menu.

2 MNetwork[Subscribers] =] E3
klame Phaone Mumber Active | Address Tariff M Intr Modem Shel
1 Doe 123456 / ampwhere Business Metwork: A =
: _.f' ......... -

5 I I A54000 [F&) Subzcriber Erupertles..% """"""""""""""

Edit Child

Create Parent
LCreate Subzscriber
Delete ASA000 [FA) Subzcriber.

| Line Test Wiew

Place cursor over shelf and click the right mouse button. From the menu select AS4000
(Type) Subscriber Properties. or click the Ll button on the toolbar to produce the Edit

Subscriber dialog box.

E dit Subzcrnber
—Customer Information

—Hardware Configuration

Telephone Mumkber

Matme: Shelf
I any Name I_..se Station 1:Rack3: CasShelf j
Address ¥ Circuit &ctivation

any place Mocem Lire

|'1 vI
[ MElRecall

[~ Intrusion Tane

|12345?

Tariff

[Busines= i |

ST Programming Code

—

||:u:| 001 000000 0

Print Installation Instructions. .. |

1K

Cancel | Helg |
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3. Edit the customer information in the Name, Address, and Telephone Number fields. Note:
to moveto anew linein the address field use Ctrl and ¢,.

4. Sdect the Tariff from the drop down menu. The inclusion of the tariff isfor information
only and does not set a tariff.

Tariff

Business *

Business
Domestic
Economy

5. The customer may be moved to a new equipment by selecting the Shelf, (the field may be
dropped by clicking the mouse on the W) Modem and Line number. If the modem / lineis
already in use then the Sitespan displays a message, select a new modem / line.

Edit Subscriber Ed

& Subgcriber already exiztz on shelf Metwork:AIR001 703:B ase Station 1:Rack3:Caz5hell, modem 1, 5T line 1.

6. Set thelntrusion Toneif the subscriber isto receive indication of atest clerk on theline.
Thisisfor ST-V2 using DASS only.

7. Setthe MCI (Malicious Call Indication) to enable the facility. Thisisfor ST-V2 using
DASS only.

8. Set the customers active by clicking in the circuit activation box (d). A [X]I shows that the
subscriber isin service,

9. Click OK toinitiate the creation of the subscriber. The Network [Subscribers] window
shows the configuration details.

& MNetwork[Subszcribers] [ _ |O] =]
kame Ehaone Mumber Active | Address Tariff i Intr Modem Shel
1 Doe 1234456 / amywhere Business Metwark: A &
Any name 1234467 .,/ any place Husiness [M]

KI

STOP. THISPROCEDURE HASBEEN COMPLETED.
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EDITING ISDN (FA) SUBSCRIBERS

Use this procedure to edit subscribers on an ISDN shelf.

STEP PROCEDURE

1. Display the Network[Subscribers]view by clicking the |H button on the toolbar or by

selecting Subscribers from the View menu.

&= Metwork[Subszcribers]

Mame Bhaone Mumber Active | Address Tariff
.| Doe 1234586 / amnwhere Business
: B
" | | A54000 [FA] Subscriber Er|:||:u3rtinas..L\\s """"""
Edit Child
Create Parent

Create Subszcriber

Delete AS4000 [FA] Subscrber. .

| Line Test Wiew

2. From the Edit Menu select ASA000 (Type) Subscriber Properties. or click the Ll button on
the toolbar to produce the Edit Subscriber dialog box.

E dit Subzcrnber
—Customer Infarmstion

—Hardware Configuration

Matme: Shelt
| Dae | .. 2Fixed sssignedsdnshetz v |
Address v Circuit Activation
Arywvhere it e
|3 vI |1 vI
Subscribed Services
[ JAdvice of Charge -
w|Zall Forvvarding Unconditional L
[alling Line Id Presentation
[iCalling Line Id Restriction 7
[~ InBarring [ Out Barring
Edit Phone List |
=T Programiming Code
i ||:u:| 003 000000 2
Business j Print Installation Instructions. .. |

ik Cancel | Help |
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3. Edit the customer information in the Name, Address, and Telephone Number fields. Note: to
move to anew line in the address field use Ctrl and ¢,.

4. Select the Tariff from the drop down menu. The inclusion of the tariff is for information only

and does not set atariff.

Tarift

Business *

Businezs
Damestic
Econamy

5. The customer may be moved to a new equipment by selecting the Shelf, (the field may be
dropped by clicking the mouse on the W) Modem and Line number. If the modem / lineis

aready in use then the Sitespan displays a message, select a new modem / line.

E dit Subszcriber

& Subgcriber already existz on shelf Metwaork:AIR001703:Baze Station 2:Fired Azzigned:|zdnShelf2, modem 3. 5T line 1.

6. To Edit the Subscribed Services click the mouse on the boxes next to the service. When a
serviceis sdected aM is shown. Usethe scroll bar to view other services. The services

available are:

Advice of Charge

Call Forwarding Unconditional
Calling line Id Presentation
Calling Line Id Restriction
Closed User Group

Call waiting

Call Hold
MCI

Sub Addressing
Terminal Portability
User to User Signalling

7. Click X In Barring and Out Barring if required

8. Set the customers active by clicking in the circuit activation box (d). A [X]I shows that the

subscriber isin service.
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9. Click OK toinitiate the creation of the subscriber. The Network [Subscribers] window shows
the new details.

&= Metwork[Subszcribers]

IS[=] E3
Mame Phane Mumber Active | Address Tariff Mci
.| Doe 1234586 i amnwhere Business
:«'a_nijame 123457 .,{ any place Husiness
1
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DELETING SUBSCRIBERS

Use this procedure to del ete Subscribers that have previously been created and
are not needed. The Equipment View must be connected to the Server to perform

addetion.

STEP PROCEDURE

1. Display the Network[Subscribers]view by clicking the |H button on the toolbar or by
selecting Subscribers from the View menu.

& Metwork[Subszcribers] HE=l B3

Mame Bhone Mumber] Active | Address Modem Shelf

P : . e : e
Dog 133498 i AS 4000 [FA) Subzcriber Properties. . etk

[Modem1Ling? v E dit Child \Jehwrk:ﬂlREE‘F
1] | - 3

Create Parent
Create Subszcriber
Delete AS4000 [F&] Subscriber. . %_

Line Test Wiew

2. From thelist of subscribers click the mouse on the subscriber to be deleted. The
subscriber seected is highlighted.

3. Place cursor over shelf and click the right mouse button. From the Edit Menu, select
Delete AASAO00 Subscriber.

4. A confirmation window is displayed showing which subscriber will be deleted. Click
the‘OK’ button to initiate deletion.

AS8100 Sitezpan E3

& 0K to delete J Doe?
Eancell

5. The Network (Subscribers) list is displayed with the subscriber removed.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SETTING FIXED ASSIGNMENT RF GAIN LEVELS

Use this procedure to set the RF gain levels for Fixed Assignment AS4000 RF
cards.

STEP PROCEDURE

Fixed Assigned Racks

1. From the Modem Shelf View (release 2 equipment) or from Combiner Shelf View
(Fixed Assignment Release 3 equipment) click right mouse on the RF Card.

2. From the menu, sdect AAA000 RF Card View.

" AS8100 Sitezpan E quipment Yiew - [Network:AIRDD._. =] E3

Eile Edit “iew Toolz ‘window Help -||5’|£|

|| = |7 1] ]

—Inventary Information

Setial Mumbet: I | Receiver Transmitter
Firtmaneare Code: IIII.EIIII ] (]3]

State: IENF‘ Iz ||:|.|:n:| votz | 000 watts

—RF Gain Adjust

Doy [

—Configuration

Channel: IEI Doverlimk: I Uglink: I

|'F'DWE[’ Levels

AGC (dBmy: | 0.00 Ot Poswer (dBm):

Edit Shelf Configuration... |

For Help, press F1 o

3. Recelver and Transmitter gains can be adjusted by using the mouse to adjust the
voltage up and down. See 605-0000-432 or 452 for details on level settings.

4. Clicking the Edit Shelf Configuration button invokes the Edit Shelf Properties
window. For details on using this window, see Edit Shelf Properties DLP-053.

5. Close by clicking mouse on the screen outside of the RF card view window.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MEASURING FIXED ASSIGNMENT BIT ERROR RATE
(BER).

Use this procedure to monitor the error performance of Fixed Assignment
Modem links. The Downlink is from the CT to ST and the Uplink isfrom the ST
to CT.

STEP PROCEDURE

1. Sdect Shef View
2. Click on the modem to be measured.

3. Either double click the mouse on the modem or from the View menu, select Airspan
60 Modem Card View.

4. TheLink Performance (BER) is displayed for both the Uplink and Downlink.

=3 Network:AIR001703:Base Station 1:Rack3:CasShel .. [H=] E3

—Inventary Infarmstion — Alarms
Serial Mumbet: I [f_f-ij Poor BER
Firmweare Cocde: IUDU— @ FRU Failed
state:  [ENPIS (23 Lost Comms With ST

Self Test | IND Result

—Link Performance (BER)
Davwenlirik: Uglink

CLrrent; Il.DﬁE-EB Current: I 1.535e-07
Previous: IEI.EIEIE+EIEIEI Previous: IIZI.IIIIZIE+IZIEIIJ

=T Yiew | Reset |

5. In normal operation the BER should be equal to or better than 1in 107. An darm is
initiated when the BER is greater than 1 in 103,

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MEASURING FIXED ASSIGNMENT CRU SIGNAL
STRENGTH

Use this procedure to monitor performance of the Fixed Assignment Subscriber
Terminal.

STEP PROCEDURE

Measuring the ST performance
1. Fromthe Modem Card View click on ST View button.

2. CRU Signal Strength section shows values for:

AGC.
Power Control.
Uplink Code Phase.

=3 Network:AIR001703:Base Station 1:Rack3:1sdnSh... =] E3

— =T Inventory Informstion —CRU Signal Strencth

2 AT
Setial Mumber

I— Poyver Contral oe

Firfmvware Code | 0.00

h

State  |ENPIS| Uplink Code Phase | 2100
Self Test | |N-:| Resutt - Alarms
() Link Unavaiable =

—PSU Inventory Information

1} Poor BER
Setial Mumber I @ P=u Tamper

Fitmyware Code IIII.IZIIII @ Swvitch to Battery

@ Lowy Battery

e

L

State IENF‘ I

Lire 1: Lime 2 Reset | Apply Luupback...l

B1 - Releazed

Reserve Line. .. | B2 Raleased
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AGC In ST View the value shown in the CRU Signal Strength AGC
box is the voltage measure from the RF stage of the CRU, and,
although related to, is not the same as the voltage measured at the CRU
terminal block. The graph below shows the relationship between the
AGC voltage and the ST receive level (dBm).

5-
AGC
Volts
4-
RX AGC Equalised
Characteristic

27 10dB Fade Margin
1.7

6dB Fade Margin
1.3

“| 0dB Fade
_Margin

| 98 92| 88 ! ! ! |
-105 -100 -90 -80 -70 -60 -55

RX Level (dBm)
Power Control In ST View the CRU Signal Strength Power Control measures
a voltage corresponding to the output power from the CRU. The graph below
gives the relationship between that voltage and the output power (dBm).

5 -
PC
Volts ]
Al TX PC Equalised
Characteristic
3- 2-2.3GHz and 2.3-2.5GHz
-
10dB Fade Margin
1.4
6dB Fade Margin
0dB Fade
0.3 |.Margi
0
+21 +15  +11l | | | |
+25 +20 +10 0 -10 -20 -25
TX Level
(dBm)
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VPE TX PC Equalised Characteristic
olts

44 3.4-3.6GHz

3-

2- .
1.7 10dB Fade Margin
1.3 6dB nge

1| odBFadd"
0.7 b Margin

0 4

+18 +12 | +8 | |

+25 +20 +10 0 -10 -20 -25
TX Level (dBm)

The Uplink Code Phase The value shown in the Sitespan ST View Uplink
Code Phaseis an indication of how much the ST transmit waveform has been
time advanced in order for it to be received at the CT time synchronised with

the downlink waveform, and may be used to compute the distance between an
ST and the CT.

Page 217 of 305

The range of the uplink code phase valuesis 0 to 4095. Uplink code
phase is measured in sixteenth-chips where 1/16th chip is equivalent to
24.414 ns. Multiplying the uplink code phase value by 24.414 nsyields

the approximate round trip delay from the CT to the ST and back to the
CT.

For an ST located within 14829m of the CT, approximate ST rangeis
computed as follows,

Range = (Uplink Code Phase -50) * 3.666 m

The correction of -50 made to the uplink code phase valueisincluded to

take account of the fixed delay within the AS4000 system.

For an ST located between 14830 and 29850m of the CT, approximate
ST range is computed is modified to take account of the wrap-around in
uplink code phase when the value reaches 4095;

Range = (Uplink Code Phase + 4046) * 3.666 m

Uplink code phase accuracy is +/- 3/4 chip which correspondsto a
ranging accuracy of +/- 44m.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE AS4000 DEMAND ASSIGNMENT MODEM

SHELF

Use this procedure to create an AS4000 DA Modem shelf. Two alternative procedures

are documented, (a) To create a shelf using GUIs and (b) To create a shelf using the

object lists. Each shdlf is created together with its signalling properties.

STEP PROCEDURE

(&) Tocreate a Modem Shelf using GUIs.

1. Select therack either by selecting View, and choosing Site View when in the

network object list window, or continue from DLP-014.

AS54000 [DA] CT Rack Properties. ..
Shelf Properties. .

Create Rack
Create 254000 [DA] CT Modem Shelf [%
Delete Element. ..

Element Wigw

2. Click on the desired Modem Shelf (1-2). The selected shelf is highlighted with

black markers.

3. From the Edit menu sdlect: Create Airspan DA Modem Shelf. The shelf now

appears highlighted in the active colour.

4. To set shelf parameters, go to Edit DA Shelf Properties DLP-102.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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STEP PROCEDURE

(b) Tocreate a Modem Shelf using object lists.

1. Seect therack by pointing to the rack in the Network [ Object List, Rack] window,
click right mouse button. From the drop menu select: Create Airspan DA CT

Modem Shelf.

Metwork[Object List.Rack]

IS [=] E3

Hame Igescriptinn

Metwork:AIRD01703:Base Station 1:Rackl AS4000 (DAY AC Rack, Mumber 1 ;l

A | | AS4000 [DA) CT Rack Properties. ..
E dit Child

IBetwork:AIRDDT T03:Base Station 1:Rackz AS4000 (D& CT Rack, Numberjj
3

Create Server
Create 454000 [DA] CT Modem Shelf
Delete 454000 [DaA] CT Rack...

Element Yiew

2. Using the mouse select an empty dot. Click OK button to initiate changes and

return.

AS4000 [DA) Shelf

Shelf Slat Mumber:

1[Top) Shelf1

2 Upper Middiel ™ Slat Empty

3 [Loweer kiddle] Slat Ermpty
4 [Bottom) Slot Empy

Cancel

o]
_ Careel |

3. The Network [ Object List, Shelf] window now includes the new shelf.

4. To set shelf parameters, go to Edit DA Shelf Properties DLP-102.

5. Note: Itisnot possiblefor a user to gain accessto any object if it, it's parent or
child is currently being edited by another user. It is however, possible to edit a
peer object. For example if a user is editing a shelf then each of the Site, Rack,
Card objects relating to that shelf are locked. This does not however stop another
user creating, editing or deleting other shelves on the same rack or other shelves,

racks etc. on the same or other sites.

6. If an attempt is made to access a locked object then the following message

appears.
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& This Elernent is carrentlsy being edited by another Equipraent Wiew

STOP. THISPROCEDURE HASBEEN COMPLETED.
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EDIT A4000 DEMAND ASSIGNMENT MODEM SHELF
PROPERTIES

Use this procedure to edit AS4000 Demand Assignment Modem Shelf properties.
The Site view, Shelf view, or an Object list containing the shelf should be displayed
at the start of this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Either select the shelf from Site View or select the shelf on an Object List. Click theright
mouse button and select Shelf Properties.

ﬂ

Site Properties. ..

Shelf Properties... L\\S

THHH
Create Rack

Delete Airzpan DA CT Modem Shelf...

ik

Element Wiew

2. Select Airspan DA CT Modem Shelf and click OK.

E dit Properties Ed
Select the property to edit ]
A54000 DA CT Modem Shelf Cancel |
Software Dovwnload
Send Script File

3. IntheAirspan DA CT Shelf Properties window enter the shelf name into the dialog box
and click the OK button.
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Edit AS4000 [DA) CT Shelf Properties [X]
Hame: [Shelf1

—&C Shelf Connection

MName INDI"IE

Murnbier I1

— Connechion Ref. Clock Source——
Port: ||:|:|w|1 'I I Indirect Slat |5 "I
% hdaster
TEL: I1 jv i~ Slave El I'I "I
—RF Settings

Card Type [(303-0093-920] C2 Haris

BT Frequencies(MH 2] B 2047, 25800 222225800

Tx Gain |33DD ﬂ
Bx Gain IEEUU ﬂ

[ Feedback Loop

— Statiztics
[ Collect

k. I Cancel Help

4. Select Com port communicate with the AC shelf.
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5. Each Shelf within a Sitespan domain requires a unique reference number to be allocated
in the TEI drop menu.

Connection

Port: |COMZ2 =

TEIL |2

-
Y

6. Set thereference clock sourceto the DTU connected to the CTU in the AC rack from
where the clock sourceisderived. Thisisusually Sot 5 E1-1 for 750hm Backhaul or
Slot 5 E1-5 for 1200hm Backhaul. Enter the RF card type, Frequency and PN Code and
set the TX gain to 3300 and the RX gain to 2200 ( these are nominal values and are fine
tuned when the RX sensitivity is set)

7. If the shdlf isto be managed from the Access Concentrator remotely then check (v') the
Indirect box. If the Server PC connects to the Shelf Controller on the AS4000 Rack
(each Modem shelf requires a different COM port). Select the Port by clicking ¥ to drop
the options box and choosing the appropriate communicationg/serial port. The ports listed
are those available on the Server machine; this may not necessarily be the machine
running the Sitespan Equipment View.

8. Sdect Master / Slave. When Master is selected Sitespan isin control and objects are
downloaded into the shelf. When Slave is selected objects are uploaded from the shelf
into Sitespan.

Connection

* Ml aster

.
TEL |2 g By e .

9. Select Rx & Tx Frequencies by clicking ¥ to drop the options box and clicking the
appropriate frequency pair on the drop down list. The frequency pairs are usually
determined as part of the system planning process.
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B=/Tx Frequencies(MHz] | B 2047 2500 2222 2500 j

E 2047 2500 2222 2500 4]
7 20507500 2225, 7500

5 5054 F5A0 G559 SER0

9 2057, 7500 2232 7500

10 2061, 2500 2236, 2500

11 2064. 7500 2239, 7500

12 2068 2500 2243 2500
13 2071, 7500 2246 7500
14 2075 2600 2250 2500

16 2078 7500 2253 7500

Ok | 16 2082 2500 22572500 =

10. Select PN Code (1-7) by clicking W to drop the options box and clicking the appropriate
number from drop-down list. The PN codes are usually determined as part of the system

planning process.
PM Code 1 =
g %
Tx Gain {3300

2

3

; 4

B Gain (2200 5
G

v

Cancel | Help |

11. Note. The Feedback Loop checkbox has no function in this release of software
12. Click the OK button to set.

13. Note: Allocation of Frequency and PN code usually forms part of the network planning
and is not usually determined by an individual editing the shelf properties.

RF Output Scaling

1. The Scaling Factor optimises the system by fine tuning the power output depending on
the number of users. The scaling is set on the AU card. To display the Analogue
Unit(AU) card double click the mouse while pointing to the card on the Modem Shelf
view
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=3 Network:AIR001703:Base Station 1:Rack2:Shelf.. [H[=] E3

—Inwertary Information ——— — Alarms

_ () Card Mismatch
Serial Mo, ||

Firmsneare Code; I

State: IENF‘ IS

A54000 [DA) AL Properties.
Child Properties. . L\\(‘)

Sealing Factor |9 User(s)

Card Yariant [0 Create Parent
Create
Delete

Element Yiew

Reset |

2. Click the right mouse button on the Analogue Unit (AU) card to drop menu. Select
Airspan DA AU properties.

3. Sdect the number of usersthat can use the system at any onetime. When in serviceit is
necessary to check the soft errorsreported. If soft errors occur the number of users
should be increased or the TX power reduced to produce less power output until the soft
errors are eiminated.

E dit Analogue Properties
—Scalng————— [ FuState
Factor [Users) ¥ InService
— Card % ariant

|0(3.75 MH2) |

] I Cancel

STOP. THISPROCEDURE HASBEEN COMPLETED.
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S

MODEM SHELF CARD VIEWSDEMAND ASSIGNMENT
This procedure describes the Modem Shelf Card Views.

STEP PROCEDURE

4. Display the Modem Shelf. To display view, see DLP-019 or GSI-017. To display acard
double click the left mouse button while pointing to the card on the Modem Shelf view.

iy Hetwork:SYSTEMS_LAB_1:Beta:CT Rack:CT Shelf 1

=
[
w
o
=
)
m

Demand Assignment

Modem Cards

1. Double click the left mouse button while pointing to the card on the Modem Shelf view
to display card.

2. Thefollowing information is displayed:

Inventory Information. See DLP-019 for details.

A Sdf Test button. For details of use see DLP-016.
Alarms.  Card Mismatch

Reset button to reset the Modem.
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7= Metwork:SYSTEMS_LAB_1:Beta:CT Rack:CT Shelf. .. |_ O] x|

—Invertary Information —&larms

Serial Mo, | F00028300T0002M0 | | |() Card Mismatch

Firmmuneare Code: I

State: IIS

Feset |

Tributary Units

1. Todisplay the Tributary Unit(TU) card double click the mouse while pointing to the
card on the Modem Shelf view
The following information is displayed:

Inventory Information. See DLP-019 for details.
A Sdf Test button. For details of use see DLP-016.
Reset button to reset the card.
Alarms.  Card Mismatch

FRU Fail.

E1 Loss of signal

El Loss of Frame

E1 Loss of Multiframe Alignment

E1TS16 AIS

E1AIS.

E1 Remote Alarm Indication

E1 Remote Loss of Multiframe A.

TheRW Management View. This displays the current state of the RW codes
IS In service
00Ss Out of service no acquisition possible.
OOS(10K) Out of service but a service engineer can forcethe ST to
acquire from STMON for Windows at 10kbits/sec.

OOS(160K) Out of service but a service engineer can force the ST to
acquire from STMON for Windows at 160kbits/sec.

El in use. Showsthe E1 link used to backhaul to the CTU at the Access
Concentrator
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Beta:CT Rack:CT Shelf 1-:AL1

—Invertary Information — &larms
Card Mismatch
Serial No. [FOO038480TO00 % AR e
FRL Failed
Firmyware Code: I
@ E1 Los= Of signal
s
State.l . E1 Loss Of Frame
Self Test | IF'ass () E1 TS16 &S
i B () E1 Az
r Anageme
|@ E1 Remote Alarm Indication

Ry | State 2

1 15

2B

318

45

5 I E1 -I_ in uze

E IS

7

5 IS = reset

Shelf Controller

1. Todisplay the Shelf Controller Card (SC) card double click the mouse while pointing
to the card on the Modem Shelf view. The following information is displayed:

Inventory Information. The inventory shows both the current and other
Firmware See DLP-019 for other inventory details.

A Sdf Test button. For details of use see DLP-016.

Reset button to reset the card.

Alarms. Lost Commswith EM.

PSU Fail.

Page 231 of 305



AS8100 Sitespan User Guide Version 3.7

605-0000-426 DLP 103

Draft Issue 6.0. Date 4/4/00

=3 Network:SYSTEMS_LAB_1:Beta:CT Rack:CT Shelf 1:SheliC_.. [H[=] E3

—Inventary Information ——— —Alarms

_ () Card Mismatch
Setial Mo. I.f$
|@ Lost comms iith EM

Firtmweare Code: I

@ A Shelf SwedlSwitch Failed
Cther Code: I

@ CT Shelf Swdli=witch Failed

Stete: |13 () Dtu SwaltSwitch Failed

() Ctu SwdliSwitch Failed

(23 Cas ¥tu SwoliSwitch Failed

Reset | (23 Wa1 Hiu SwolSwitch Failed ~|

2. Toedit card state, select the SC card from the shelf view, Click the right mouse button
anywhere on the window and select Airspan DA SC properties.

=3 Network:SYSTEMS_LAB_1:Beta:CT Rack:CT Shelf 1:SheliC_.. [H[=] E3

—Inventory Information ——— —Alarms

Zerial Mo. Ilﬂ; @ Card Mizmatch

Firtmsyweare Code; I

@ A Shelf SwedlSwitch Failed
Cther Code: I

@ CT Shelf Swdli=witch Failed

|@ Lost comms with EM

Stete: 19 (23 Dtu SwdliSwitch Failed
% 454000 [0A) ST Properties. . dliSwitch Failed
Child Propetties. . | SwvallSwitch Failed
Reset | Create Parent L SwallSwitch Failed =
Create
Delete
Element Wiew

3. Set the card state to the required service state by clicking the check box with the mouse.

In Service
Emulator

Edit Card State Ed

¥ InService

Cancel |

[ Emulator

4. Click OK toinitiate state change.
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AU Card

1. Todisplay the Analogue Unit(AU) card double click the mouse while pointing to the
card on the Modem Shelf view
The following information is displayed:

Inventory Information. See DLP-019 for details.
Card state.

Reset button to reset the card.

Alarms.  Card Mismatch

Scaling Factor See below

=3 Metwork:SYSTEMS_LAB_1:Beta:CT Rack:CT Sh... M=l E3

—Invertary Information —— — Alarms

Card Mizmatch
Serial Mo, | ::00024?31 T9951 MOI @

Firtmseare Code; I

State: I I

Sealing Factor |9 User(s) :
A54000 [DA] AL Erupertles...%

Child Properties. ..

Card Yariant [0

Create Parent
Create
Delete

Reset | Element Wisw

2. Click the right mouse button on the Analogue Unit (AU) card to drop menu. Select
Airspan DA AU properties.

3.  The Scaling Factor optimises the system by fine tuning the power output depending
on the number of users. Select the number of usersthat can use the system at any one
time. When in serviceit is necessary to check the soft errors reported (a soft error is
the errorsthat occur before error correction). If soft errors occur the number of users
should beincreased or the TX power reduced to produce less power output until the
soft errors are éiminated.
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E dit Analogue Properties |

— Scaling

Factor [Uzers]

—Fru State
¥ In Service

— Card Y aniant

| 0[3.75 MHz) |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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\

>

CREATE DEMAND ASSIGNMENT MODEM SHELF
AUX CARDS

Use this procedure to Create ASA000 DA modem shelf Aux Cards. The shelf
view, or an Object list containing the shelf, should be displayed at the start of
this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Either Select Shelf from Site View by clicking on the required shelf, or select the
shelf on an Object List. Click the right mouse button and select Create AUX

iy Metwork:SYSTEMS_LAB_1:Beta:CT Hack:CT Shelf 1

AS54000 (D] CT Modem Shelf Properties...
Child Properties. ..

Create Parent
Create Al
Delete Element...

Element "iew

2. For aModem Shelf select Airspan DA DTU from the cards listed.

Create Child ]
Select the child type ko create ok
AS54000 [DA) CTU
ASANON DA DT Cancel |

AS4000 [DA) Cas =TU
AS4000 [DaA) B XTU
AS4000 [DA) DATA XTU
A54000 [DA] Comprezsion card
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3. The Shdf view shows the card allocated to the selected dot.

i Hetwork:SYSTEMS_LAB_1:Beta:CT Rack:CT Shelf 1

=
[
]
o
I
)
m

owy A Card View

4. Repeat for each Aux Card ingtalled, and then create the corresponding Aux cards
in the Access Concentrator.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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EDIT A4000 DEMAND ASSIGNMENT MODEM SHELF
DTU CARD PROPERTIES

Use this procedure to edit AS4000 DA Modem Shelf DTU Card Properties. The site
view, shelf view, or an object list containing the shelf should be displayed at the start of
this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Open the object list AS4000 DA DTU. (See DLP 025)

2. Sdect the card to be configured, click the right mouse button and from the drop menu
select AA000 DA DTU Properties.

iy Metwork:SYSTEMS_LAB 1:Beta:CT Rack:CT Shelf 1

EELEEN L

A54000 [DA4] CT Modem Skhelf Properties. ..

AS4000 [DA] DTU Properties. .. M

0

Create Parent
Create ALl
Delete 454000 [Da) DTU. .

A54000 [DA) DT Wieww

5. TheEdit DTU Properties window is displayed. Enter the Radio List Management
values for the card into the boxes to optimise the performance of the system.

Max Net Entry Channels: On start-up the STs are made aware of the network and data
is downloaded into each ST. The larger the number of NET entry channels the shorter the
time to get the system operational. One channel per shelf within the system is always
configured to run net entry, but in addition, the user can configure additional potential net
entry channels. (Selected on the DTU propertiesin Sitespan). Each channel selected
hererequiresafull RW i.e. 160K of bandwidth, and therefore, if the RW is used for net
entry, it isremoved in entirety from the available pool for traffic.

FreeList: Thefreelist allocatesthe freelist at each traffic rate. (160k, 80k, 40k) The
way the list is divided depends on the ST population. If achannel isnot available at a
reguired rate the next highest rate is selected.

Incoming Call Availability: Incoming call availability is calculated from the allocation
and distribution of channds across the freelists

FRU State:  In Service makes the FRU available for system use.
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Emulator isfor development use only.

RW M anagement allows the RW codes to be set as:
IS In service
00Ss Out of service no acquisition possible.

OOS(10K) Out of service but a service engineer can force the ST to acquire

from AS7020 STMON for Windows at 10kbits/sec.

OOS(160K) Out of service but a service engineer can force the ST to acquire

from As7020 STMON for Windows at 160kbits/sec.

Edit DTU Properties =]

—Radio Ligt Management———— — FRL State
v, .
bax. et Entry Channels |3 W In Service

Free Ligt Entries [160k] I1
Free Lizt Entries [B0k] I'I
— R Management

Free List Entries [40k] I-I R/ | State -
1S

[~ Emulator

Incaming Call 2w ailability I|33 ¥

™| A Eal Eantal Ehatinels

000~ O O e 0 P —
o

—E1 Configuratian

Backhaul E1 |1 vI & 750km ¢ 120 0km

(] I Cancel |

6. Click OK to set values.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE A34000 ACCESS CONCENTRATOR SHELF

Use this procedure to create an AS4000 Access Concentrator shelf. Two

alternative procedures are documented, (a) To create a shelf using GUIs and (b)
To create a shelf using the object lists. Each shelf is created together with its
signalling properties. The Shelf type should be selected to match the installation

type.

STEP PROCEDURE

(a) Tocreate a Access Concentrator Shelf using GUIs.

1. Select therack either by selecting View, and choosing Ste View when in the network

object list window, or continue from DLP-014.

2. Click on the desired Access Concentrator Shelf (1-2). The selected shelf is

highlighted with black markers.

| |
AS54000 [DA] AC Rack Properties. ..

Shelf Properties. ..

LCreate Rack
Create AS4000 [DA) AC Shelf L\}
Delete Element...

Element Wigw

3. Place cursor over shelf and click the right mouse button. From the menu select:

Create ASA000 (DA) AC Shelf.

4. The created shelf is highlighted in the active colour

STOP. THISPROCEDURE HASBEEN COMPLETED.
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STEP PROCEDURE

(b) Tocreate an Access Concentrator Shelf using object lists.

1. Sdect therack by pointing to the rack in the Network [ Object List, Rack] window.
Click the right mouse button and select: Create Airspan DA AC Shelf.

Metwork[Object List. Rack] M=l E3
Lescription |
ws4000 (DA AC Fack Mumbar 1 AS4000 DA AC Flack P : ﬂ
ack Properties...
54000 (DAY CT Rack, Mumber 2 Edit Child [}S

54000 Rel 3 (FA) Rack Nurmber 3

54000 Rel 2 (FAY Rack, Murmber 4 %’Eateigﬁgn a1 AC Sl
k

AS4000 Rel 3 (FA) Rack Murmber1 | = (D) ©

ﬂ Delete 254000 [D&) AC Rack. .. Llj

Element Yiew

2. Using the mouse select an empty dot. Click the OK button to initiate changes and
return.

AS4000 [DA] Shelf

Shelf Slat Murnber: (] I

1[Top] Shelfd
2 [Botkam] Slot Empty Cancel

3. The Network [ Object List, Shelf] window now includes the new shelf.
4. To set shelf parameters, go to Edit Access Concentrator Shelf Properties DLP-107.

5. Note: Itisnot possiblefor auser to gain accessto any object if it, it's parent or child
is currently being edited by another user. It is possible however to edit a peer object.
For exampleif auser isediting a shelf then al Site, Rack, Card objects relating to
that shelf islocked. This does not however stop another user creating, editing or
deleting other shelves on the same rack or other shelves, racks etc. on the same or

other sites.
6. If an attempt is made to access a locked object then the following message appears.

& Thiz Element iz cumently being edited by anather E quipment Yigw.
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STOP. THISPROCEDURE HASBEEN COMPLETED.
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EDIT AS4000 DEMAND ASSIGNMENT ACCESS
CONCENTRATOR SHELF PROPERTIES

Use this procedure to edit ASA4000 Demand Assignment Access Concentrator
Shelf properties. The Site view, Shelf view, or an Object list containing the shelf,
should be displayed at the start of this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Either select the shelf from Ste View by clicking on the required shelf, or select the
shelf on an Object Ligt, Click the right mouse button and select. Shelf Properties.

Site Properties...

Shelf Broperties... L\\S

LCreate Rack

Delete Airzpan DA AC Shelt...

AL Rack

Element Yiew

2. From the Edit Properties window, select Airgpan DA AC Shelf and click OK.

E dit Properties Ed

Select the property to edit

Ok I
A54000 DA] AC Shel |

Saftware Download Cancel

3. The Edit Airspan DA Shelf Properties window appears.

4. Enter Shelf Name. Enter Reference Clock Source to derive timing from the network.
Thisisusualy thefirst E1 on thefirst XTU card i.e. dot 5 E1-1. Leave theindirect
box unchecked. The UCP threshold is used as a security measure to detect changesin
code phase caused by any changesin the location of the Antenna and should be set
between 3-5 to avoid unnecessary alarms.
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Edit AS4000 [DA] AC Shelf Properties
I ame Reference Clock Source
|Sheld Slot | B[ =
Connection ST Configuration
Port: |COMT x| & Master UCP Thieshold |3
- _ - 17 Slaye
TEL: [ [ Indirect

ST Line Statistic Parameters

Pall lrterval (15 Minutes  Collection Period |7 Dray|z]

YW arning: Changing Pall Interval anddor Collection Period will rezet all currently logaging line stat files
v Log File ... |E:"-.Sitespan'\statistiu:s"aLngs'\Lnstats.t:-:t

CTUT Connected CT Shelves

E1-1 [4IRO01703Base Station T:Rack2Shell = |

E1-2 [4IR001703 B ase Station T:Rack2Shell2 = |

E1-3 |N-:une ﬂ
E1-4 |Mone =]
E15 |N-:|ne ﬂ
E1& |N-:|ne ﬂ
E1-7 |N-:|ne ﬂ
E1-8 |N|:|ne ﬂ

k. | Cancel | Help |

5. Drop the Port Selection box and select the com port allocated the shelf by clicking
with the mouse on the required port. The com port is the Sitespan PC port connected
to the AC shelf.

Connection

Bort: [CORZ2 ﬂ {* Master

T " Slave
TEI- Egmg .............................. .jrect

6. Seect Indirect if the CT is managed through the Access Concentrator. Select Master /
Save. When Master is selected Sitespan isin control and objects are downloaded into
the shelf. When Slave is selected Sitespan uploads objects from the shelf.
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unique number within the system. The shelf object list shows what TEIs have been
allocated to each shelf.

J

TEI:

000 -] O O e L

8. The CT shdves connected to the Access Concentrator are allocated to the E1 link
connecting them, drop window and select all the CT shelves to be managed by the

AC Shelf.

Page 245 of 305

CTUA Connected CT Shelves

E1-1 |Mone =]

E1.2 Naore
AIRDOT #03:B aze Station 1:RackShell -
F1.7 [AIROOT703:Base Station 1:Rack?: Shelf2

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATE DA ACCESS CONCENTRATOR SHELF AUX
CARDS

Use this procedure to edit ASA000 DA Access Concentrator Shelf Aux Cards.
The shelf view, or an Object list containing the shelf, should be displayed at the
start of this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Any Aux Card may be assigned to any Aux dot, but it is preferable to assign CTU
Cardstodots 4,5, & 6, XTU cardsin dots 7-14 and Compression Cardsin dots 15-
17.

1. From Object List, Shelf select Access Concentrator, click right mouse button and
select Element View

Metwork[Object List.Shelf] |_ (O] x|
Hame |Qescriptinn

[Hetwork AIRDOT TO3:Base Station TASANAN MAY AT Shalf Mombor 0 .

NetworkcAIRD01 703 Base Station 145 arent Eroperies...
o Edit Child

Create Server
Create Child Elerment...
Delete ASA000 [0A) AC Shelf...

Element Wiew [~
2. From the shelf view point to AUX card and click the right mouse button. Create AUX

i Metwork-AIR001703:Access Conc 1:Hack1:5helf0

Parent Properties...
Child Properties. .

Create Parent
Create ALl

Delete Elemert...

Element *igw
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3. Seect card type from the cards listed. For Access Concentrator Shelf select CTU.
XTU(CAS), XTU(Data), V5.1 or Compression.

Create Child ]|

Select the child type ta create

R 4000 (DA LT

454000 (DA)DTU
A54000 [DA) CAS =TU
A54000 DA)WET »TU
A54000 DA) DATA =TU

A54000 [DA] Compression card

QK I
El;r%cel |

4. The Shdf View showsthe card allocated to the salected do.

5. Repesat for each Aux Card installed.

6. To configure Aux cards go to the following DLPs

CTuU DLP-109
XTU(CAYS) DLP-110
XTU(Data) DLP-111
V5.1 DLP-112
Compression. DLP-113
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CONFIGURE AS4000 DA ACCESSCONCENTRATOR SHELF

CTU CARD

Use this procedure to set-up the CTU Card on the AS4000 DA Access Concentrator Shelf.
The shelf view, or an object list containing the card should be displayed at the start of this
procedure. See GSI-017 Selecting Views.

STEP

PROCEDURE

1. Sdlect the Card to be set, click the right mouse button and select from the drop menu select
the Airspan DA (CTU)View.

iy Metwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

Parent Properties...
AS54000 [DA] CTU Properties... I
g

Create Farent
LCreate ALk

Delete 254000 (D& CTL...

AS4000 [DA) CTU Yiew

2. Sdect the Impedance of the E1 connections to match the impedance of the link to the
Central Terminal. Repeat for other CTU cards.

Page 249 of 1

Edit CTU Properties
—E1 Connections FRU State

E1-1 & G5 0hr ¢ 120 Ohm W In Service
E1-2 & 75 0hm  © 120 0hm

E1-3 & 750hm 120 0hm [ Emulator
E1-4 & 75 0hm  © 120 0hm

E15 75 0hm 120 Ohm

E1-6 75 0km ™ 120 Ohm

E1-7 75 0km ™ 120 Ohm

E1-8 75 0km ™ 120 Ohm

0k, LCancel
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CONFIGURE AS4000 DA ACCESSCONCENTRATOR SHELF
XTU CASCARD

Use this procedure to set-up the XTU CAS card on the AS4000 DA Access Concentrator
Shelf. The shef view, or an object list containing the card should be displayed at the start of
this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Sdlect the Card to be set, click the right mouse button and select from the drop menu select
the Airspan DA XTU(CAS)View.

i Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

Farent Broperties...
A54000 [DA] CAS #TU Properties. .

L

Create Parent
Create Al
Delete ASA000 [DA) CAS =TU. ..

A54000 [DA] CAS STU Yiew

2. With Shelf view displayed. Position mouse over the CAS Card position to insert card,
click right mouse button and select Airspan CAS Properties. Click left mouse button in
the box alongside each E1 link provisioned to the Switch.. Note: If the box remains
unchecked, the card till functions, but the card alarms are not reported by Sitespan.

3. Set theimpedance of each link. If special signalling features are required, click the
Configure button and enter the parameters. Repeat for other CAS cards.
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Edit CAS Properties Ed
— E1 Configuration —FRL State
W ET1 & 750hm 120 0hm ¥ InService
[T E12 & 750hm ¢ 1200hm
[T E132 & 750hm ¢ 1200bm [ Emulator
[T E14 & 750hm ¢ 1200hm
FE1S & 750mm  1200mm || o onaing
FE6 & 750 C1200m || M [
[T E1-F & 780hm  © 1200hm Ennfigure...l
[T E18 & 750hm ¢ 1200hm
k. Cancel |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CONFIGURE AS4000 DA ACCESSCONCENTRATOR SHELF
DATA CARD

Use this procedure to set the alarm monitoring for Data cards on the AS4000 DA Access
Concentrator Shelf. The shelf view, or an object list containing the card should be displayed at
the start of this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Sdlect the Card to be set, click the right mouse button and select from the drop menu select
the Airspan DA XTU(DATA)View.

iy Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

¥n
Xn
xn
Xn
Hn
|
¥n

CLGA) ML XN
ML WL - XN

Farent Eroperties...
ASA000 [DA] DATA =TU Properties. . %

Create Parent
Create A=
Delete ASA000 [DA) DATA XTU. .

A WTU Card Wies

AS4000 [DA] DATA =T U Wiew

2. With Shelf view displayed. Position mouse over the DATA card, click right mouse button
and select Airspan DATA Properties. Click left mouse button in the box alongside each E1
link provisioned to the Switch. Note: If the box remains unchecked, the card till functions,
but the card alarms are not reported by Sitespan.

4. Set the impedance of each link. If special signalling features are required, click the
Configure button and enter the parameters. Repeat for other DATA cards.
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—E1 Configuratian

Edit Data XTU Properties Ed
— FRL State
750hm ™ 120 0hm ¥ In Service
750hm 120 Ohm
750hm ™ 120 0hm [ Emulator

_l
]
o

I S e T e TS T T

750hm & 120 Ohm
750hm & 120 Ohm
75 0hm O 120 Ohm
75 0hm O 120 Ohm
75 0hm O 120 Ohm

)% LCancel

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CONFIGURE AS4000 DA ACCESSCONCENTRATOR SHELF
XTUV5.1CARD

Use this procedure to set-up the V5.1 cards on the AS4000 DA Access Concentrator Shelf. The
shelf view, or an object list containing the card should be displayed at the start of this
procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Sdlect the Card to be set, click the right mouse button and select from the drop menu select
the Airspan DA (V5.1)Properties.

i Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

FParent Properties. ..
AS4000 (D) Wh.1 =TU Properties. .

Create Parent by AUz BKTU (VS.17 Card Wiew
Create ALl

Delete AS4000 [DA] Y51 =5TU...

A54000 [DA] Y51 JTU Miew

2. With Shelf view displayed. Position mouse over the V5.1 Card, click right mouse button
and select Airspan V5.1 Properties. Click left mouse button on the E1 link tab to be
provisioned to the Switch.
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Edit ¥5.1 Properties

E1-1 |et2 |E12 |E14 |15 |E16 |E17 | E16 |

Channel
~
¥ Enabled & 750bkm 120 Ohm ~ :_:'.SSDTI‘T
Interface Id |2 Wariant |1 ¥ PSTH + 150N
FSTH Signalling
Time Slot [0 = " T5 15 Signaling
+ T5 1E Signalling
L3 Address | I Erovisioned £ T5 31 Signaling
ISOM Signalling
- B1Ch I
Port 01 S Type CPath [Channel 1(15 16) 7] =
-
EF Addresz |1 P Type CPath |Ehannel1 (TS 1E) j B2Chariel
IV Pravisioned F Type CPath |Charnel 1(T516) =] |02 =
Signalling FRL State
¥ |nService
|Swird ﬂ Configure ...
[ Emulator

To apply a configured wanant to the exchange. do a switch from the card viewl}S

| ok | LCancel |

Set the Channel Par ameters

3.

Set PSTN Parameters

5.
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Enable Channd by clicking left mouse button in check box, atick shows that the channd is

Click left mouse button on the radio button to select the impedance (75 or 120 ohm) for
each link. Enter aunique Interface ID and Variant Number (these must match those
provided at the switch). Select the service type (PSTN, ISDN or Mixed). Note: The display
reflects the configuration chosen and requests further information for signalling as

appropriate.

Select the signalling timeslots used to provide signalling back to the switch 15,16, and 31.
If 15 or 31 are chosen the timedlots are not available for calls and are not selectable from

thetimedot drop list. The timedots chosen for signalling must match the times ots chosen
at the switch.
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PSTHM Signalling

Time Slot |01 - " T5 15 Signalling
* TS5 1E Signalling
L3 Address |0 LB inned (15 31 Signaling

6. Each PSTN signalling time slot must be allocated a unique L3 address number (these must
also match those provided at the switch). Select each time dot in turn and enter the L3
address number.

Provision channd by clicking left mouse button in check box next to the provisioned script,
atick shows that the channd is provisioned.

8. When all parameters have been set for each timedot click left mouse button on the OK
button. If any conflicts occur in the configuration of any of the L3 addresses an error
message is displayed. An example of an error message is shown below. If there are
multiple conflicts acknowledging a conflict reveals another conflict window. The object
model is not changed until the conflicts have been resolved.

ASE100 Sitezpan E4

& L3 addresz at E1-2 T5-1 duplicated at E1-1 T5-1

9. If specia signalling features are required, click the Configure button to access the Global
Object Container. Select V5.1 TU signalling. Choose existing pre-defined parameters or
create a new object and enter the new parameters (See DLP-115).

10. Repeat for other E1 portsand 5.1 cards.
ISDN

11. Set the Port (Basic Rate Access Circuit) and EF addresses Number (these must match those
provided at the switch). The S, P and F type C paths can use the same timeslot Common
Channel signalling path asthe PSTN or may use a different time dot (these must match
those provided at the switch).

ISDM Signalling
B TR B1Channel
S Type CPath [Channel 1(TS 18] -]
04 "l
EF Address |2 F Type CPath ]Ehannel 1(TS1E] j B2Channel
¥ Provisioned F Type CPath |I:hanne|'| (T5 18] j 05 jv

12. When all parameters have been set click |eft mouse button on the OK button. If any
conflicts occur in the configuration of any of the timedots, ports or EF addresses an error
message is displayed. An example of an error message is shown below. If there are
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multiple conflicts acknowledging a conflict reveals another conflict window. The object
model is not changed until the conflicts have been resolved.

AS8100 Sitezpan E4

& E1-1 Part 1 BChannel1 [1] Conflict Witk BChannelz [1]

13. After any conflicts are resolved clicking OK allows the object model to be updated but the
settings do not take effect until the variant is switched into the current configuration. The
switching is done from the Airspan DA (V5.1) View as follows.

14. Place cursor over card and click the right mouse button. From the drop menu select the

Airspan DA (V5.1)View.

75 Metwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf:AUX2

—Irventory Information

Setial Mumber: IFEIDI3384T3TEIEIDEI‘I.

Firmwyare Code:

State: I

Self Test | IPaSS

— Alar

() Card Mismatch

() FRU Failed

() Signaling Failed
(22} E1-1 Loss Of Signal

@ E1-1 Loss Of Frame

—E1 Configuration

Signaling ISWim

E1-1 |E1-2 |E1-3 |E14 |E15 |E16 |E17 |E18 |

[¥ E1 Interface |2 Current Yariant Iz In Service
Current \-"ariard|1 Swyitch To Mew | Meswe Variant |1 Re-Estaklizh |
State |V5.1 interface in service.
Cause |V5.1 Irterface started.
Pstn
L3 Address Timeslot | Blocking status |
1 30 Blocked
2 3 Blocked
l=cn
EF Address B-Channel 1 | B-channel 2 | Blocking status | sctivation Status | il
1 1 2 UnBlocked Activated
2 3 4 UnBlocked Activated
3 a2 G UnBlocked Activated
4 7 g UnBlocked Activated LI
Block Block Regquest Unklock PL Activate PL De-Activate
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15. In the screen shot above the new variant number appears in the New Variant field but the
system is currently using variant 0. To switch to the new variant click left mouse button on
the Switch button and the new variant is adopted.

16. The Re-Establish button provides a 150 second break in the E1 link that isused if the E1
link needs to be reset. Use the re-establish in preference to hot plugging the TU card as
only the E1 being re-established is effected, all the other E1links on the card are | eft
uninterrupted.

17. The State and Cause fields display system state messages and cause as interpreted by
Sitespan

18. The PSTN field shows Addresses, Timedots, and Blocking status for each L3 address
provisioned. Any services not provisioned are not displayed. Timesots may be forced into
a blocked/unblocked state by selecting the Address and click left mouse button on the
Block/Unblock buttons. The Block Request button does not force the state but informs the
switch to block the channel when it becomes free.

19. The ISDN Field shows Addresses, Timedots, and Blocking status for each L3 address
provisioned as well as provision for activating and de-activating the ISDN Channel Any
services not provisioned are not displayed. Timeslots may be forced into a
blocked/unblocked state by selecting the Address and click left mouse button on the
Block/Unblock buttons. The Block Request button does not force the state but informs the
switch to block the channel when it becomes free.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CONFIGURE AS4000 DA ACCESSCONCENTRATOR SHELF
COMPRESSION CARD

Use this procedure to set-up compression cards on the AS4000 DA Access Concentrator
Shelf. The shef view, or an object list containing the card should be displayed at the start of
this procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. Sdlect the Card to be set, click the right mouse button and select from the drop menu select
the Airspan DA Compression Properties.

iy Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

Farent Properties. ..
A54000 [DA] Compression card Properties. .

(LS AN ML HNYy
MLX W15 - XNy

Create Parent
LCreate AL
Delete A54000 [D4] Compreszion card...

A54000 (D) Comprezsion cand Yisw

2. Inthisrelease of Sitespan the only compression type available is 32K ADPCM.

Edit Card State Ed

FRL State

Comprezzion Parameters
|7 ¥ In Service
[ ;

Type |32K ADPCHM

0K I Cancel | [ Emulator

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CONFIGURE AS4000 DA ACCESSCONCENTRATOR
SHELF XTU V5.2 CARD

Use this procedure to set-up V5.2 cards on the AS4000 DA Access Concentrator Shelf.
The shelf view, or an object list containing the card should be displayed at the start of this
procedure. See GSI-017 Selecting Views.

STEP PROCEDURE

1. ThisDLPisreserved for the V5.2 Card.

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CONFIGURING ST GLOBAL OBJECT CONTAINER OPTIONS

Use this procedure to configure Global Object Container options for AS4000 demand assignment

systems.

STEP PROCEDURE

1. The Global Object Container containsthe ST and TU configuration options.
ST options
ST Classes:
ST Signalling
ST Priority Numbers
ST Service Types
TU options
CASTU Signalling
V51 TU Signalling

2. Sdect therequired option by clicking the relevant tab at the top of the window.

DA Global Object Container Ed

ST Service Types | CAS TU Signaling | W&1 TU Sianaling
5T Classes | 5T Signalling I 5T Priority Mumbers

D1 etault Hew
STClaz=1 2Line 160k

B1150M odify
S5TClazz1 2 Line 160k
5TClaz=1 1 Line S0k
STClaz= 1Line 40k
L128

Fi1

Rz

4 line 160k

2L64

& Line 20k

1LE4

id

[elete

Cloze I [Eatizel Help

ST Classes;

1. Tocreateanew ST class click New. To modify an existing class, select the class from the list

and select Modify.
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2. Createanamein the namefield (it is suggested the name reflects the service being offeredi.e.
ST_R2 line @ 64khit/s) Select the type of ST employed and the number of lines supported by

the class.
Edit 5T Clazs
Clazz Radio Settings
M ame; |4 line 160k Acquisition Time: |2|:| seconds
Tupe: |ST N Series [Vaice) ﬂ [ Acquizition Comfort Tone
[ Unslotted Access
Humber of Lines 4 [ Enable DTMF Meszages

Clear Call an Fail Time: |5 geconds

Bandwidth [kbit/sec] ¢ 40 ¢ 20 & 160

Dial Tone Configuration

Frequency |380Hz ﬂ Qk | Cancel

3. Set the acquisition and clear call on fail times. The acquisition time sets the elapsed time before
the ST deems it has been unsuccessful and disconnects. The ST attempts to re-acquire choosing
achannd from the latest freelist. The clear call on fail time sets the time allowed for the
system to clear before re-acquiring.

4. Set the bandwidth to agree with the service selected. Failure to do so may result in channels not

being supported due to lack of bandwidth. The table below shows the bandwidth required for
each service offering.

Rate Allocation Band Width kHz
40 80 160

1*64 kbits/s

2 *64 kbits/s

1*32 kbits/s

2* 32 kbitg's

4* 32 kbits/s

1*64 kbits/s +2* 32 kbits/s

5. The Acquisition Comfort Toneis generated from the ST to give the user an indication that the
ST istrying to acquire.

Page 266 of 305




AS8100 Sitespan User Guide Version 3.7

605-0000-426 DLP 115

Draft Issue 6.0. Date 4/4/00

6. Undotted access may improve acquisition times as the ST attempts to acquire from the stored
freelist and not wait for the free list to be updated in the next polling cycle. However asthereis
an increased chance of collision causing the ST to back off and re-acquire, this ultimately would
cause longer acquisition times. It is therefore recommended that Undotted Accessisonly set on
lightly loaded systems

7. Enable DTMF Messages. Currently this box should not be checked. Future releases of Sitespan
will use thisfeature for test messages.

ST Signalling
1. Tocreate anew signalling class click New. To modify an existing class, select the class from

thelist and select Modify.

2. Theonly fidds available for change are the Name and SPM (Subscriber Private Metering)
mode.
Edit Signalling Class

Name: |siaCral

Caonfiguration Cancel |

Exchange Feleaze Pulse width |0
Seize Time
Clear Tirne
kin Anzwer Becognition Time

b ax Anzwer Recognition Time

LLRE

[nter Digit Pause

HookDigitTime [0 Minims) [0 Max(ms)
Bbm Fiatia [0 Minme [0 Makimg)
Thbr Break, Ini bin [mz] Ini b ax [mz]
O Haok [0 Minme [0 Maximg)

SPM Mode |1E kHz =
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ST Service Types

5T Service Types

Cretanlt Hew
Qe

32k todify
B4k

id

elete

3. Tocreate anew service type click New. To modify a new service, select the service from thelist
and select Modify.

Edit Service Type Ed
Configuration Cancel

Rate |32k aDPCM x|

ST Priority Numbers
Priority Numbers are not functional in thisrelease of Sitespan

ST Priarity Mumbers

Default Mew

todify

i

[elete
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E dit Priority Humbers

M arne:

— Configuration
Miode

Mumber 1
Mumber 2
Mumber 3
Mumnber 4

MHurnber &

IDefauIt ik
Cancel

| < N

|n

|n

|n

|n
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CA5 TU Signaling ]

Drefault
Flezzey

Mitel

Consult the switch user guide and set the values to match the requirements of the connecting
switch. The interpretation of incoming patterns can be set by moving the cursor over the relevant
Outgoing Call or Incoming Call field and clicking the left mouse button. The options available are

changed with each click.

Options available are: Unknown, Meter Pulse, Reverse Seize, Normal Ring, Idle, Seize, Reverse

Ring.

Edit E1 Configuration
E1 Configuration

|Mite|

Incoming Patternz | Incoming Call | Outgoing Call
] [Inknowe [Inkriown
aom |dle |dle
aomo [Inknowe [Inkriown
oo [Inknowe Seize
moo [Inknowe Rewverze Sei...
mm [Inknowe [Inkriown
010 [k nioan [k nowvan
mn [Inknowe Meter Pulze
1000 IInknowan nknowvan
1001 |dle |dle
1010 IInknowvan nknowan
101 Maormal Ring  Unknown
1100 IInknowvan nknown
1M |dle |dle
1110 Inknovn Inknown
111 [Inknowe [Inkriown
Outgaoing Patterns

a4 B C D
O Hook Output W v [
Off Hook Ouput [ [ v
Recall Output [T W+ I
Blocked Output W ¥ W W Clearal
Trunk Conditioning [+ [ T
Input Pattern b azk v v v v el
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Tirning

L2 Failure Time

[0
)
=
(==

Releaze Guard Time 200

Ring Cycle Time

Ring Trip Time

[0

Output Pattern Min Time

Dhigit On Hoak,

(78]

Crigit Off Hook, Time

Drigit Intersal Time 75

Debounce Time

o

Flazh On Hook,

JEERERRE

[ Debounce On
[v Simple Exchange

&

s

&

&

&

s

&

&

&

&

Digit Pulzes
ST
oo 2
3= [3
w= 4
5= 5
T
7- [
g- 5
=[5
o= [0

0k

LCancel
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Y&71 TL Signalling

Cretanlt

Hew

Swinmn
SigClg2

todify

id

Consult the switch user guide and set the values to match the requirements of the connecting

switch.

Edit ¥5.1 Common E1 Configuration

Mame |Swim
Fulze Signalz
Eattern Type milli Sec
m - |F'ulseu:| Mormal Polarity ﬂ Cruration —j 1000 ﬂ
DUt-IrI E-lrlcle LI U I I I N R A ) Wﬂ
Ring Cadences Dhuration Type
Pattern Cadence Pattem Type
o1 =] C— 53 [
On Diwration [fF Ciuration Diwration
. . milli Sec milli 5ec o . milli Sec
1 — F—— [iom = — —— [ioo0 ] [1000 ﬂ

2 I—'|7' N mnn%
3 I—I|7I S 1000 —

4 I—I|7I S 1000 —

I—'|7' oo i _] ' "" " [500 ﬂ

._.]7. — [fooo =

I—I|7I . mm —

(] Cancel

STOP. THISPROCEDURE HASBEEN COMPLETED.
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ADJUSTING RF RX GAIN (DA)
STEP PROCEDURE

1. Using Sitespan highlight the shelf, click right mouse button and select ‘ Parent

Properties’.

Metwork[Object List,Shelf] |_ (O] x|

Hame

Lescription

[Wetwork SYSTEMS LAB 1:Heta:

CTAS4C " o

K

Metwork: SYSTEMS_LAB_1:Beta:
Metwork: SYSTEMS_LAB_1:Beta:

Parent Properties. .. L\\S
CTASAC £ Chid

ACASALC
Create Server

LCreate Child Element. ..

Element Yiew

2. Select ‘Airgpan DA CT modem shelf’.

E dit Properties

Select the property to edit | k. I

Send Script File
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B 000 [0 LT Modem Shelf
Software Download Caneel |

‘ Delete 454000 [D&) CT Modem Shelf...
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".Adjust the ‘Rx Gain’ by increasing and decreasing the values using the box arrows.
(if valueis reduced power goes UP) . Adjust the ‘Rx Gain’ and select ‘OK

Note: To start with a new system, set the RX gain to around 2200. For complete process

of setting RX sensitivity see 605-0000-477 CT Installation and commissioning
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Edit AS4000 [DA] CT Shelf Properties E

Hame: |CT Shelf 1
—AC Shelf Connection

MName INI:II"IE

Mumbier I1

— Connechion

Ref. Clock Source——
Bart: IEDW I ¥ Indirect Slat IE TI
i hdaster

I j " Slave E1 I'I "’I

—RF Settings

Card Type [(303.0087-920) X1 35GHz ¥ |

F#/Tw Frequencies(kMH 2] A6 34187500 3518.7500 j

FM Eu:ude 1
T Gain IF
Bx Galn 15?5
[~ Feedback Loop
— Statistics
[ Collect
ITI Cancel Help

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING DEMAND ASSIGNMENT SUBSCRIBER
TERMINALS
STEP PROCEDURE

1. Display the Access Concentrator Shelf. To display aview see DLP-019 or GSI-017. Click
the right mouse button and select Element View from the menu.

—

HHHH- 434000 (DA) AC Rack Propeties..

Shelf Properties...

LCreate Rack
LCreate Shelf
Delete AS4000 [DA) AC Shelf..

Al Rack Element Yiew M

2. Todigplay the ST list select In the View Child window select ST List.

View Child E

Select the child type to view ITI
A54000 [DA) AC Shelf
Software Download . Cancel |

ST List

3. The ST list isdisplayed with any current subscriberslisted or blank if no subscribers have
been assigned.

i Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

Identifier| Lacation In Service | Stats § Stat Line {1-Cd 5T Clazss | Sig. Config. 5]
408 ST Rackd / 0,0 L1128 Default, Default ﬂ
409 ST Rack g 7 0,0 L1za Default, Default

4110 ST Racks 7 0,0 L1258 Default, Default
407 ST Rackd 7 0,0 L1128 Default, Default -
| o ;IJ

4. To create anew subscriber sdect Create ST from the Edit menu
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Edit “iew Toolz “indow Help
Undo Chrl+Z
Bedo Ctrl
Cut Chrl+
Copy Chrl+C
Pazte Chrl+f
AS54000 [DA) ST Properties...
Child...
Create Server
Create 5T L\\‘\_,
Delete AS4000 [DA]ST...
Receiving Attention
Connect Server
Dizconnect Server
5. TheEdit DA State window contains details of the ST configuration.
Edit DA ST E3
ST Type
Identifier I3 I:ocationl ¥ InSemvice
Clazz IDefauIt j
Linel | L
e | Line2 I - — —CTU CT Connections
. Line Statistics
Sig. Cg. IDEfauIt j ¥ Callect 1 |Metwork:5YSTEMS_LAB_1:Beta:CT Rack:CT Shelf 1 j
Sethings ... |
Service Type IDefauIt
%Skt [5 =] ™" Loophack
E1 MHumber |-| vl — Software Download Authenticate
: I Enable ¥ Serial Humber
Timeslat IE j ¥ Monitor Progress ¥ Caode Phase

Cancel

| Configurations |

6. Enter information and configuration optionsinto the fields.

ST Type

Identifier: a unique number to identify the ST thisis automatically assigned by Sitespan.
Alternatively a new number can be assigned manually.
L ocation: thelocation of the ST.
Class: sdlect thetype of ST being provided. If the type of ST isnot listed, it can be created
by clicking the Configurations button and selecting ST Classes (see DLP-115).

In Service: checking the box allows the subscriber to make and receive calls.

Linel/Line2
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Signalling Configuration (Sig Cfg): Select required configuration from the drop menu or
create a new one by clicking the configurations button and selecting ST Signalling (see
DLP115)

Service Type: Select the required Service Type from the drop menu or create a new one by
clicking the configurations button and selecting ST Service Type (see DLP115)

XTU Slot: E1 Number and Timeslot: Allocate each Subscriber linean XTU, E1 link and
timeslot to provide the backhaul to the switch. . Each subscriber line must have a unique
timeslot. If the timedlot has already been allocated the following screen is displayed.
Allocate another timeslot.

ASE100 Sitezpan

& 5T Id already uzed

CTU CT Connections: Drop the menu and select the shelf in the Central Terminal that the
ST connects to on acquisition. If the connections are not set then the following message
appears when OK isclicked.

AS58100 Sitegpan Ed

ST Must be allocated to CT before statisticz can be monitored
Dizabling Line Stat Monitoring

Softwar e Download: Checking software download makes the ST available for software
download. Progress of the download can be monitored if desired by checking the monitor
progress box. On completion of the download the boxes should be reverted to clear.

Authenticate: Checking the code phase and Serial number boxes enabl es authentication of
the subscriber. Serviceisonly provided to the subscriber if the Serial Number and Code
Phase are as set on installation of the ST

7. To change configuration click the configuration click the Configurations button.
SeeDL P115.

8. When all fields are complete click OK to add the subscriber to the ST List

9. To create a subscriber record associated with the ST go to DLP-120

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DELETING DEMAND ASSIGNMENT SUBSCRIBER
TERMINALS
Use this procedure to delete demand assignment subscribers from the A S4000.

STEP PROCEDURE

1. Display the Access Concentrator Shelf. To display a view see DLP-019 or GSI-017.

2. Click the right mouse button and select Element View from the menu.

Metwork[Object List, Shelf] M=l
Mame Igescriptinn

Metwork:AIRDD1703:Base Station 1AS4000 (DAY AC Shelf, Mumber 0, ;l

[HetworkAlRD T ~ o S ~ A Shelf Mumber 1

DR B B et PafEnt EpoEftlES...

MetworkAIRD £ o CT Shelf, Numher 1,
fhnenrke 4R T Shalf Mumher 7 2
4 Create Server 3

LCreate Child Element...
Delete AS4000 [DA) AL Shelf...

Element Yigw |:}

3. Todisplay the ST list select In the View Child window select ST List.

View Child E
Select the child bupe to view

T
EEA000 [0 AL Shel
Software Download Cancel |
ST List

4. The ST list isdisplayed with any current subscribers. Select the subscriber to be
deleted.

i Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf

|[dentifier| Lacation In Serice | Stats | Stat Line {1-0y 5T Class | Sig. Config. g
408 ST Rackd / 0,0 L1128 Default, Default ﬂ
409 ST Rack g 7 0,0 L1za Default, Default
4110 ST Racks 7 0,0 L1258 Default, Default
407 ST Rackd 7 0,0 L1128 Default, Default -
| o ;IJ
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5. Place cursor over the ST and click the right mouse button.Select Delete AS4000
DA(type)ST from the Edit menu

i Metwork-5YSTEMS_LAB_1:Beta:AC Rack:AC Shelf

Identifier| Lacation In Service | Stats O Stat Line {1-0n, ST Class | Sig.
408 ST Racky ‘/ 0o L1283 Dﬁﬂ
409 5.1.5..@'“";5 4000 (D -"-"-]IST = _ 0.0 L128 D

N Froperties. .

“ T a o

4 3
—_— [Create Parent

Create 5T

Delete AS4000 [%] ST..
i g

Element Yigw

6. Click OK on the dd ete confirmation window to initiate the deletion.

Sitespan

N '\ OKto delele D3SHO?
Cancel

7. Thesubscriber isremoved from the ST List

iy Hetwork:SYSTEMS_LAB_1:Beta:AC Rack-AC Shelf

Identifier| Lacation In Serice | Stats O Stat Line {1-0n, ST Class | Sig.
408 ST Rack4 / 0,0 L1283 D=~
410 STRack® 0,0 L128 De
p— ——— . i — oA -

] | | 3

8. Note: Any subscriber that is associated with the ST is not deleted at the same time.
The subscriber record still exists but is not associated with any ST. To delete the

subscriber record go to DLP-121

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SUBSCRIBER TERMINAL VIEWSDEMAND
ASSIGNMENT

This procedure describes Subscriber Terminal Views for Demand Assignment.

STEP

PROCEDURE

1. Display the Modem Shelf. To display a view, see DLP-019 or GSI-017.

2. Click the right mouse button and select Element View from the menu.

Metwork[Dbject List.Shelf] [_ O]
Mame Igescriptinn
Metwork:AIRDD1703:Base Station 1AS4000 (DAY AC Shelf, Mumber 0, ;l

[HetworkAlRD T ~ L T T T AL Bhelf, Mumber 1
DR B B et PafEnt EfDI:IEftlES...

MetworkAIRD £ o CT Shelf, Numher 1,

fhnenrke 4R
4

T Shalf Mumher 7 2

Create Server 3

LCreate Child Element...
Delete AS4000 [DA) AL Shelf...

Element Yigw |:}

3. Todisplay the ST list select In the View Child window select ST List.

Page 281 of 1
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4. From the ST list select the ST to be viewed and either double click theitem or sdlect

Element View from the menu.

i Metwork - 5YSTEMS_LAB_1:Beta:AC Rack:AC Shelf

|

Create Parent

Identifier| Lacation In Semice | Statz O Stat Line {1-0n, M ST Class | Sig.!

408 ST Rack4 / oo L128 Diﬂ

409 ST Rack 4 L nn L1128 D=
AS4000 [DA] ST Properties. .

410 ST Racky Edit Child !_128 DEv

s

Create 5T
Delete 454000 [DA) 5T. .

Element Wiew [

5. The ST View displays the following information:
ST Identifier.
Location of ST
Class: thetype of ST that is deployed. E.g. ST-R1
Serial Number
Service State

Inventory Information. The inventory shows both the Current and Other Firmware

versions being used. See DLP-019 for other inventory details.
A Sdf Test button. For details of use see DLP-016.

Reset button to reset the card.

A Net Enter Button.

Alarms. For interpretation of alarms see Operations and Maintenance Guide

@ =7 Link Faiure

. Serial Mumber Changed
. Code Phaze Chanoed
@ rsu Mains Failed

@ rsuBsttery Low

. P=U Tamper

@ r=u comms Failed

@ iractive DTE

@ =00 terminal sbsent
@ rosP taiure

. Ringer Fault
@ nactive DTE 2
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7= Metwork:5YSTEMS_LAB_1:Beta:AC Rack:AC Shelf:5T Contai... M= E3

—=T Type — AlErms
idertifier {1402 @ =1Lk Faire i|
Location | =T Rack S @ Serial Mumber Changed
Clasz L1285 @ Code Phaze Changed
() PSU Mains Failed =
— =T Inventory Information
— Davwenilink
Setial Mumker |F|:u:u:u:|5=392T99243 fels 1123 Yolts
Firtmyware Code |4.IIIIII Powver Ctrl 1472 Waolts
Cther Yersion |4.|:u:| Afc 2652 Yolts
State ||s Code Phase  [2675 chips
it Tt | Signal Strength |-92.01 dBm
rr Soft Errors o per sec
[ fctivated —Uplink e
= | Reset wil Switeh Transmit Level |-11.23 oBm
Soft Errars L per sec

Reset | Met Erter |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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CREATING DEMAND ASSIGNMENT SUBSCRIBERS

This procedure adds subscriber details to subscriber terminals created in DLP-117

STEP PROCEDURE

1. Click the|ﬂ on the Toolbar .

2. The Network Subscriber object list is displayed. Any existing subscribers are displayed in
the list, otherwise it is empty.

3. Click the Ll on the Toolbar . Select the ASA000 (DA) subscriber option.

Select Subscnber Type Ed

AS4000 [Fa)
A54000 [Da)

Cancel

4. Enter the customer information into the fields: Name, Address, Telephone number and
select Tariff

E dit Subscriber Ed
—Customer Information —————  —Hardware Configuration
Ohject
Rlame: =l =T Container ;I
A n. Other E‘
Address
33 Any Rd e DaSH 010
-- DSt 011
-- DaSH 012
-- DaSH 013
-- DaSt014 |
-- DaSh 2
-- DaSt 3
Telephone Mumber B Dasts
=T b Dasta1 3
-- DaSt214
Tariff E-DaSt230
— - Dast407
IEIusmess j - DaSt408 ;I
[8]34 Cancel | Edit Ohject |
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5. The STsalready created are shown in the hardware configuration box. Select the ST
associated with the subscriber and click left mouse button, this reveals the lines created
on the ST, click left mouse button on a line to associate the subscriber with the ST. Until
thisis done the OK and Edit Object Buttons are unavailable. If the object isto be edited
click left mouse button on the Edit Object button and follow the instructionsin DLP-117.

6. Click OK to create the subscriber.

The Network Subscriber object list is displayed. The new subscriber is displayed in thelist.

& Network[Subzcribers] M= E
HName =Phaone Mumhber Active | Address Tariff i Intr Moderm Shel
. 1 Other 456654 /| 33AnyRoad Business Network 5=

STOP. THISPROCEDURE HASBEEN COMPLETED.
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DELETING DEMAND ASSIGNMENT SUBSCRIBERS

This procedure deletes details to subscribers created in DLP-117

STEP PROCEDURE

1. Click the|ﬂ on the Toolbar .

2. The Network Subscriber object list is displayed. Existing subscribers are displayed in
thelist.

3. Sdect the subscriber to be deleted. Click the right mouse button and select Delete
Subscriber.

& Metwork[Subscribers] _ (O] %]
Bhone Mumber Active | Address Tariff hci Intr Moderm Shelf
Iflaam Wl cubseriber Properties. . HSINESS Newurk:BYST_Elrj
A & Edit Child :
Create Parent

LCreate Subzcriber
Delete Subzcriber...

Line Tezt Wiew

4. Click left mouse button on OK in the confirmation window.

AS8100 Sitezpan Ed

& 0K to delete 4. N Other?
Eancell

5. The Network Subscriber object list is displayed. The deleted subscriber is removed.

& Network[Subscribers] M=l E3
kame =Phaone Rumber Active | Address Tariff hdci Intr Moderm Shel
=l

i o

STOP. THISPROCEDURE HASBEEN COMPLETED.
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SUBSCRIBER LINE TESTS
Use this procedure to test DA subscriber lines

STEP PROCEDURE

1. Click the|ﬂ on the Toolbar .

2. The Network Subscriber object list is displayed. Existing subscribers are displayed
inthelist.

3. The Network Subscriber object list is displayed. Select the subscriber to be tested
and Click the right mouse button and select Line Test View.

&= Metwork[Subscribers] H=l E3

Phaone Mumber Active | Address Tariff Mci Intr Moderm Shelf
d5HES4 ,{I 33 Ay Roe : S NEMDFHZEYETEH
4 _I : Subzcnber Properties. .. LI—I
E dit Child
Create Parent

Create Subscriber
Delete Subzcriber...

Line Teszt Miew s

4. Thewidow displayed shows the ST that is selected for testing and the current
reservation status.

5. Sdlect thereservation option
For ce reserves the line busy or not.
Camp waits until lineis free before busying the line
Abort on Busy only reservesthelineif it is free otherwise the line is not reserved.
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6. Click left mouse button on the Reserve button to initiate reservation.

—Lire Heservatinn-lgt [d:1. Lire:1

i~ Faorce Currently: Free

" Camp —— |

& fbort If Busy Ii..ﬁ.‘?.??.’.‘:’.‘?...é Eree |
—Line Tests katy

Type | state | Resul |

Line [dle

Hazardous Voltage  |dle

Ring Trip [dle

Dial Tone Idle

B St
Dialled Digits |

7. When the line has been reserved the current status is updated. Select the tests
reguired and click left mouse button on the Run button.

Line Feservation |St [d:7. Lire:1

* Force Currently: Rezerved

" Camp

" Ahart |f Busy ] A |
Line Testz

Tupe State | Result |
Line |dle Pazs

Hazardouz Woltage  Running

Ring Trip Pending

Dial Tone Idle

Ahbart

Dialled Diigits [123456

8. Theprogress of thetest isdisplayed in the line test box. The results are displayed
as Pass, Fail or Inconclusive. Digits dialled by the customer are displayed in the
dialled Digits BoxTo stop testing at any stage click left mouse button on the Abort

button

9. On the completion of tests click left mouse button on the Free button to release

theline
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Line Reservation |St ld:1. Line:1

&+ Force Currently: Freeing

" Camp

" Abork IF Busy | |
Line Tests

Tppe | State | Result |

Line Idle Paz=s

Hazardous Yoltage  |dle Pazs

Ring Trip ldle  Pass

Dial Tone Idle
Dialled Digits |

STOP. THISPROCEDURE HASBEEN COMPLETED.
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MONITORING DA PERFORMANCE STATISTICS

This procedure outlines the process for collecting DA Performance Statistics
AS8100 Sitespan is able to monitor

RF related statistics— per CT shelf.

Call traffic statistics— per CT shelf.

Call traffic statistics— per ST Line.

STEP PROCEDURE

Coallect Central Terminal Shelf RF and Call Statistics

1. Either select the shelf from Site View or select the shelf on an Object List. Click theright
mouse button and select Shelf Properties.

Site Properties. ..

Shelf Properties... L\\S

Create Rack

Delete Airzpan DA CT Modem Shelf...

Element Wiew

2. Select Airspan DA CT Modem Shelf and click OK.

Edit Properties

Select the property ta edit k. I
A54000 [D4] CT Modem Shelf Cancel |
Saftware Download

Send Script File

3. IntheAirspan DA CT Shelf Properties window click the mouse on the Statistics check
box. The Statistics parameters are displayed

specify the poll period; default 15 minutes, minimum 15 minutes, maximum 1440
minutes).

Page 293 of 1 © 2000 Airgpan Communications Ltd



AS8100 Sitespan User Guide Version 3.7

605-0000-426 DLP 123

Draft Issue 6.0 Date 4/4/00

specify the total duration of interest (collection period); default 1 day, minimum 1 day,
maximum 32000 days).

— Statistics
" ED”ECE Ewery I'I i rnirute(z). far I? day(z]
™ Lag

Last Callection Started At IMDn kar 27 17:02:43 2000

“Warhing: Changing Pall Interval anddar Caollection Period
il rezet the curently logging ztat file

4. Click the mouse on the Log check box. The directory for thefileis displayed. Each CT
shelf statistical data will be logged and stored in C:\Stespan\Statistics\ctstats directory.
The maximum number of entriesin afile will be 32000 records, with wraparound; the
actual file size may be less than this. The number of recordsis based on the combination
of polling duration and retrieval period. Each time statistics are enabled, thesefiles are
recreated, and any data that has been logged by a previous statistics enable is lost.

— Statizticz

¥ Collect Ever_l,ll15 minute(z), for |7 daylz]

¥ Log File ... | IE:'\Sitespan'&statistics'&Lngs"-.u:tstat
Last Collection Started At IMDH Apr 10 05:38:05 2000

wharning: Changing Pall Interval anddar Callection Period
will rezet the currently logging stat file

5. Togenerate ahistorical log of the statistics per report type that does not wrap around click
thefile option. In the file save window create the directory and file name for thislog. The
user will be prompted for the filename (40 chars maximum, including the path). Thisfile
is atext-based, and the format of each record will be tab-separated values, to allow easy
import to other programs (e.g. MS Excel). Unlike the internal Sitespan statistics data files,
theselog filesare NOT reset each time statistics are enabled. Thisfile will continueto
grow without limit. If thisoption is selected, it isthe user’s responsibility to arrange
archiving / removal of thisfile at periodic intervals.When the log fileis removed, the next
received statistical datawill result in anew log file being created automatically (provided
the logging option is enabled).

Collect Subscriber Terminal Call Statistics

1. Select the ST from the ST Object List. Click the right mouse button and select AS4000 ST
Properties.
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Network[Object List.AS4000 [DA] 5T]

Hame Igescriptinn |

_ _ AS4000 [DA) ST Properties... _I
Metwork SYSTEMS_LAB_1AS40 ¢ [
Metwark SYSTEMS_LAB_1AS40
Metwark SYSTEMS,_LAB 1 AS4n oA Semver 3

Create Child Element. ..
Metwork SYSTEMS_LAB_1AS40

Delete A54000 [DA] ST... _ILI
4 I I 4

Element Wigw

2. Click the mouse on the Collect check box.

. — CTU CT Connections
Line Statizticz

v i 1 [Metwork:AIROD1703:Base Station 1:Rack2Shefl ¥ ]

e coreerene

Settings ... |

3. IfaCTU CT connection has not been allocated the following message is displayed

AS8100 Sitespan |

& ST Must be allocated ta CT far monitaring statistics

4. Inthe Airspan DA AC Shelf Properties the Statistics parameters are displayed

specify the poll period; default 15 minutes, minimum 15 minutes, maximum 1440

minutes).

specify the total duration of interest (collection period); default 1 day, minimum 1 day,

maximum 32000 days).

Click the mouse on the Log check box. The directory for the fileis displayed. Each ST
shelf statistical data will be logged and stored in C:\Stespan\Statistics\Sstats
directory. The maximum number of entriesin afilewill be 32000 records, with
wraparound; the actual file size may be less than this. The number of recordsis based
on the combination of polling duration and retrieval period. Each time statistics are
enabled, thesefiles are recreated, and any data that has been logged by a previous
statistics enableislost. A maximum of 50 ST’ s may be monitored at any one time.

ST Line Statiztic: Pararneters
Fall Interal I'I 5 binutes  Collection F'eriu:u:ll? Crayz]

YW arning: Changing Pall Interval and/or Callection Penod will rezet all curently logging line stat files
¥ Log Eile ... | IE:'\Sitespan"\statisticshLagsthstats.t:-:t

Page 295 of 305




AS8100 Sitespan User Guide Version 3.7

605-0000-426

DLP 123

Draft Issue 6.0 Date 4/4/00

5. Togenerate ahistorical log of the statistics per report type that does not wrap around click
thefile option. In the file save window create the directory and file name for thislog. The
user will be prompted for the filename (40 chars maximum, including the path). Thisfile
is atext-based, and the format of each record will be tab-separated values, to allow easy
import to other programs (e.g. MS Excel). Unlike the internal Sitespan statistics data files,
theselog filesare NOT reset each time statistics are enabled. Thisfile will continueto
grow without limit. If thisoption is selected, it isthe user’s responsibility to arrange
archiving / removal of thisfile at periodic intervals. When the log file is removed, the next
received statistical datawill result in anew log file being created automatically (provided

the logging option is enabled).
Displaying RF statisticsfiles

1. Either select the shelf from Site View or select the shelf on an Object List. Click theright

mouse button and select Element View.

AS4000 [DA] CT Rack Properties. ..

Shelf Properties. ..
Create Rack
Create Shelf
Delete ASA000 [DA) CT Madem Shelf...
Element Yiew [
2. Select RF Satigticsand click OK.

View Child

|
Select the child tupe ta view k. I

A54000 (DA CT Modem Shelf
Saoftware Download

Call Statistics

RHF Statizhcs

Cancel

i HNetwork:SYSTEMS_LAB_1:Beta:CT Rack:CT Shelf 1

Tirme % Min Radio] % wax Radid % Avg. Radig Uplink Afteap @1 60K

Mon Mar 27 11:17:44 2000 0 a8 24 4

Mon Mar 27 11:32:44 2000 0 aa a4 1]
Mon Mar 27 11:47:44 2000 0 a8 a4 1]
Man hdar 27 4770744 2000 n oo 04 n
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The following RF Statistics are displayed:

Statistic
Description
Radio usage
%Average radio usage Average usage of the total radio traffic bandwidth.

(100% usage occurs when all 13 traffic RWs are

fully utilised.)

% Minimum radio usage

Minimum usage of the total radio traffic bandwidth.

%Maximum radio usage

Maximum usage of the total radio traffic bandwidth.

Call Collisions

Uplink Attempts by ST at 160K

Total number of radio acquisition attempts at 160K

Uplink Fail at 160K

Total number of call collisions at 160K

Uplink Attempts by ST at 80K

Total number of radio acquisition attempts at 80K

Uplink Fail at 80K

Total number of collisions at 8OK

Uplink Attempts by ST at 40K

Total number of radio acquisition attempts at 40K

Uplink Fail at 40K

Total number of collisions at 40K

Note: The radio usage figures give an indication of the overall usage of the system.

Note: A call collision occursif two STs simultaneoudly attempt to acquire the same RW
segment. This can happen when both STs are making outgoing calls, or one ST is making an
outgoing call and the other isinvited to receive an incoming call. If excessive collisions
appear at a particular bandwidth, it suggests that the freelist at that bandwidth on the CT is

mi sconfigured.

Displaying CT Call datisticsfiles

1. Either select the shelf from Site View or select the shelf on an Object List. Click theright
mouse button and select Element View.

o+

Ll
AS4000 [DA] CT Rack Properties. ..
Shelf Properties. ..

[+
[
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2. Sdect Call Satistics and click OK.
View Child

Select the child bupe to view

OF.

A54000 [DA) CT Modem Shelf
Software Download
Call Statiztics

RF Statizhics

Cancel

i

i Hetwork:SYSTEMS_LAB 1:Beta:CT Rack:CT Shelf 1

Mup hfar 28 NA14°009 7
4' I
|

Time Inc. Attempts] Inc Fail (WEMRCWOH) | Inc. Success | =00t Attempts | Out. F:
Thu Mar 30 11:20:44 © 1] g1 or ] 1] 1] ;l
Fri Mar 31 07:05:95 20 1] 11 or ] 1] 1] J
Thu Mar 3012:20045 1 1] 0l or ] 1] 1]

n i ni n n n

The following Call statistics are displayed:

Statistic
Description

Inc. Attempts Total Number of incoming call attempts. (Collisions are not
included in thisfigure).

Inc. Fail (N/R) Number of incoming calls that fail to acquire radio (after
retries).

Inc. Fail (R/D) Number of incoming calls that fail due to radio drop.

Inc. Fail (Other) Number of incoming calls that fail due to other reasons.

Inc. Success Number of incoming calls the reached the “connected state”

and were cleared down normally.

Out. Attempts

included in thisfigure).

Total Number of outgoing call attempts. (Collisions are not

out. Fail (N/R)

Number of outgoing calls that fail to acquire radio (after

retries).
Out. Fail (R/D) Number of outgoing calls that fail due to radio drop.
Out. Fail (Other) Number of outgoing calls that fail dueto other reasons.
Out. Success. Number of outgoing calls that reached the “connected state”
and were cleared down normally.
Call Hold (Secs). This represents the call hold duration in seconds.
Bumped This represents the number of callsthat werein the

“connected” state and then were cleared by the system (not
the users) because an RW was taken out of service.
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Displaying ST Call statisticsfiles

1. Either select the shelf from Site View or select the shelf on an Object List. Click theright
mouse button and select Element View.

Metwork[Obiject List AS4000 (DA) ST]

Hame Igescriptinn |

Metwork: SYSTEMS_ £ i hid [ |

Metwork: SYSTEMES_

Network SYSTEMS, | Soae Sorvel 13285788403
EhOIE. — | Create Child Element...

Metwork: SYSTEMES_ Drelete A5 4000 [[4] 57... |:||:|35|:|T9941i|;|

4 I I »

i Element Yiew

3. Sdect ST Call Satistics and click OK.

View Child |

Select the child tupe ta wiew | I\QK I

A54000 DA ST
ST Lall Stabishics

Cancel |

iy Hetwork:SYSTEMS_LAB_1:Beta:AC Rack:AC Shelf:5T Container:DaSt407 M= E3

ITime |In|:. Aﬁemptsl Ing Fail {mIRMRIDOth) I Inc. Success |Out. Aﬂemptsl it

Blon Apr 10 12:43:02 ° 0 or oy 1] 1] 1] ;I

g o
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Thefollowing Call statistics are displayed:

Statistic
Description

Inc. Attempts Total Number of incoming call attempts. (Collisions are not
included in thisfigure).

Inc. Fail (N/R) Number of incoming calls that fail to acquire radio (after
retries).

Inc. Fail (R/D) Number of incoming calls that fail due to radio drop.

Inc. Fail (Other) Number of incoming calls that fail due to other reasons.

Inc. Success Number of incoming calls the reached the “connected state”

and were cleared down normally.

Out. Attempts

Total Number of outgoing call attempts. (Collisions are not
included in thisfigure).

Out. Fail (N/R)

Number of outgoing calls that fail to acquire radio (after
retries).

Out. Fail (R/D) Number of outgoing calls that fail due to radio drop.

Out. Fail (Other) Number of outgoing calls that fail due to other reasons.

Out. Success. Number of outgoing calls that reached the “connected state”
and were cleared down normally.

Call Hold (Secs). This represents the call hold duration in seconds.

Bumped This represents the number of callsthat werein the

“connected” state and then were cleared by the system (not
the users) because an RW was taken out of service.

Importing Statistics Data into a Database or Spreadsheet

1. Toview statistical recordsin a database or spreadshest, first locate the statisticsfilein
C:\Sitespan\Statistics\... or in the location defined when the log was set-up. Thefileisa
xt file and the records are Tab delimited. . The import wizard on the spreadsheet or
database sets the records into the appropriate fields.

Printing Statistics

1. Display the Statisticslist as described above

2. From the file menu select print. Set parametersin the print window and click OK.
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User Response Form

Mail: Airgpan Communications Limited Fax: (44) 01895 467182

Cambridge House

Oxford Road

Uxbridge

Middlesex

UB8 1UN
Document Rating Excellent Good Average Below Average  Poor
Accuracy / Completeness Q Q Q |
Clarity / Organisation Q Q Q | |
Figures Q Q Q | |
Table of Contents/Index Q Q Q Q
The nature of this responseis Addition (d Deletion d Correction

Please enter details of response below (include precise reference to Section, Page,
Paragraph)

Please complete the following for acknowl edgement/response:

Name Address
COMPANY o e
JODTIIE s e ——————————
Department . s
TEEPNONE s e
Thank you for your co-operation and assistance.
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